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This dissertation is split into two Volumes.

Volume One is a collaborated authorship between three Master of Architecture 
students within the Unit for Urban Citizenship: Lauren Konstantinou, Purll Naidoo 
and Kelsey Smith. We all share the same passion for participatory research and 

creating architecture beyond just the building. 

This chapter consists of a background of us as students, the Educational 
Ecosystem, Mamelodi East and Tsako Thabo Secondary School, the Unit for Urban 
Citizenship, research methodology, and our involvement in the NRF STINT project, 

Stitching the City.  

We have each written our own version of Volume Two wherein we investigate 
different layers uncovered in Volume One and their relations to architecture. This 
Volume, The Music Maker, looks through a lens of music and performance as a 

positive platform for expression. 
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GLOSSARY
●	 MCLC: (Mamelodi Community of Learning Collaborative) Through the University of Pretoria 

(UP) Mamelodi Campus, the university has engaged with multiple community upliftment 
projects. The MCLC is funded by the Kresge Foundation. 

●	 Educational Ecosystem: a concept through which there is a large focus on the educational 
sector of a community, identifying and understanding the interrelationships between 
stakeholders and how these can be enhanced in order to uplift the educational quality of 
the community as a whole. 

●	 UUC: (Unit for Urban Citizenship) Within the Department of Architecture, this unit involves 
agents of change, engaging deeply with underserved communities through participatory-
based projects. 

●	 Tsako Thabo Secondary School: Part of the MCLC’s effort to uplift the educational ecosystem 
within Mamelodi East. The principal is Mr Clement Gama who has worked closely with us 
during the participatory process of both 2019 and 2020. 

●	 JCP: Community engagement course that makes provision for university funded community 
service projects to be completed by undergraduate students in the EBIT faculty during their 
second year of study.

●	 STINT: National Research Foundation project titled, Stitching the city: From micro-data to 
macro-views (STINT), aimed at establishing a “transdisciplinary collaboration” to develop a 
methodology for collecting and sharing non-traditional types of information, on a digitized 
platform.

●	 STEM & STEAM: approach to learning and development that integrates the areas of Science, 
Technology, Engineering and Mathematics. STEAM was recently created to incorporate the 
Arts as well, to ensure an all-rounded and inclusive educational system. 

●	 PAR: (Participatory Action Research) An approach to investigation that involves participants 
and researchers working together in order to uncover issues and solutions within a community 
or topic. 

●	 ukuDoba Method: A methodological framework that has been developed for the collection 
and sharing of non-traditional types of spatial and socioeconomic data at a street and 
precinct level in an online platform. All three researchers were actively involved in the 
creation of this method. 
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01_INTRODUCTION
This document is inclusive in three mini-
dissertations in the professional Master of 
Architecture degree in the Department of 
Architecture at the University of Pretoria: Lauren 
Konstantinou, Purll Naidoo and Kelsey Smith. We 
have collectively been a part of the University 
of Pretoria’s (UP) Unit for Urban Citizenship, in the 
Department of Architecture, since our Honours 
year in 2019. As part of our involvement, we 
have engaged with the topic of investigating 
the spatial consequences of the architectural 
discipline on the educational ecosystem, 
through the approach of the Unit for Urban 
Citizenship. This engagement began in 2019 and 
occurred over the year within Mamelodi East, as 
a collaboration with the Mamelodi Community 
of Learning Collaborative (MCLC). This resulted 
in a focused study of Tsako Thabo Secondary 
School and a continued collaboration into the 
2020 Master’s year. 

The 2019 experience highlighted the power 
of alternative architectural processes and the 
depth that can be added to a project when 
engaging in participatory design methods.  
There is a desire and need, within us, to 
challenge conventional architectural processes 
by focusing on the end-users as knowledgeable 
and tangible assets to design projects. We were 
all captivated by our experience during the 
2019 Honours year and sought to continue our 
engagement in the Master’s year, 2020. Due 

to our common foundation and architectural 
approach, we have closely collaborated 
during the Master’s year. As an outline, each 
researcher’s dissertation is made up of two 
parts (Fig. 01): Volume One being the co-
authored chapters and Volume Two outlining 
our individually authored chapters. Volume 
One of this dissertation document engages in 
our collective experience and foundation that 
contributed to our individually focused chapters 
in Volume Two. 

Our research methods and architectural 
approach	to	the	dissertation	are	influenced	by	
our involvement in the Unit for Urban Citizenship 
(UUC). The UUC is a collaboration within the 
Department of Architecture and is currently 
headed by Dr. Carin Combrinck. Both students 
and staff from the department form part of the 
UUC,	as	well	as	identified	community	members	
who are integral to the success of the unit. 

The unit is intended to be used as a platform for civic 
engagement and participatory development 
within disadvantaged communities. This is done 
in an effort to gain real-world understanding 
and result in community upliftment (Kilfoil 
2019). The particular research method, carried 
out in each dissertation, is the outcome of 
the unit’s involvement in a National Research 
Foundation (NRF) project, titled ‘Stitching the 
City” (STINT). This project is a joint effort between 

the University of Pretoria in South Africa and 
Chalmers University in Gothenburg, Sweden. All 
three researchers were integral to the research 
project from 2019 to 2020 (see Appendix A) 
and contributed towards the development 
of the ukuDoba Method (see Appendix B), a 
methodology for both data collection and 
sharing on an easily accessible digital platform. 
Together with the ukuDoba research method, 
participatory design processes are integral to 
the approach of the unit, therefore all three 
dissertations place particular emphasis on this in 
the design process. 

From the start, we set out to change the way we 
tackle the architectural discourse at UP from a 
Master’s point of view. We intended to actively 
engage with our participants, site, community 
members, architectural professionals and peers 
as well as to be part of a movement of students 
who actively challenge the standardized 
process of a Master of Architecture (Professional) 
degree. We started the year with the intention 
of adapting the prescribed design format of the 
Master’s year-end exam. This included hosting a 
winter studio in July that would involve a live-build 
in partnership with the community and other 
active participants in our respective projects. 
The winter studio was to be implemented so that 
a part of our designs could be physically built 
and form part of our technical resolution and 
design outcome for our dissertations. This was to 

extend and consciously involve ourselves in the 
participatory design process. Due to the nature 
of the COVID-19 pandemic and lockdown 
restrictions within the country, the possibility of 
a live-build was short-lived. Our shift in thinking 
happened immediately concerning producing 
a piece of work that could still possibly be 
executed in smaller increments and thus 
contribute to potential future implementation. 

The end goal remains for us to be proactive in 
developing platforms and ways of engaging 
the end-user under any given circumstance. 
COVID-19 has posed its set of challenges 
regarding interaction and design development 
regarding participatory design processes. The 
impact of the circumstances surrounding this 
pandemic has been inevitably consequential to 
our design process. However, it has encouraged 
us to think out of the box while remaining in the 
box more so than ever. Most importantly it has 
challenged us, as researchers and designers, to 
become resilient in our architectural approach. 
To ensure that, even when obstacles present 
themselves, we are still able to adapt and 
ground ourselves in our approach, instead 
of accepting the traditional approach to 
architecture. The pandemic has also shed light 
and	caused	 reflection	on	 the	outcome	of	our	
designs and the role we play as designers going 
forward into our careers as young architects. 

Collectively we adjusted to online engagement 
to continue our paths and include participants in 
the design development process. Our resilience 
as researchers and designers has remained 
intact throughout our journey to obtain our 
Master of Architecture (Professional) degree 
and we have continued and will continue to 
learn and adapt along the way.

The following information provides the 
foundation for our three dissertation topics. 
Lauren Konstantinou’s study has a focus on the 
spatial decentralization of music-making as a 
platform for positive self-expression to enhance 
collective community identities. Purll Naidoo 
considers	 the	 redefinition	 of	 South	 African	
government school typologies to encourage 
lifelong learning potential and Kelsey Smith 
explores the role of architecture and its 
intersection with food sovereignty in an attempt 
to rehabilitate secondary school feeding 
schemes within South Africa. Overall, we hope 
that Volume One of this dissertation document 
will provide a deeper understanding of the 
context we are engaging with, our approach 
to architecture and rationale for our individual 
dissertations. 

Fig. 01: Dissertation Structure Division (Authors 
2020)
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02_BACKGROUND

Educational Ecosystem
It was Nelson Mandela who declared that “Education is the most powerful 
weapon which you can use to change the world” (Mandela 2003). To 
equip children with an engine for development (Mandela 2007) is to equip 
them with the knowledge and practical learning to maintain a sustainable 
life.

The educational ecosystem (Fig. 02) is a concept in which there is a 
large focus on the education sector of a community (Kurshan 2015).  
“Ecosystems	are	defined	by	the	network	of	interactions	among	organisms,	
and between organisms and their environment” (Mueller & Toutain 2015: 
6), therefore when looking at the educational ecosystem it becomes 
important to understand the interrelationships within that environment. 
There has been a focus on education as a means to direct a cultural 
shift, where the school is seen as the medium for moulding the society we 
envision. It is recognised that an effective educational ecosystem is seen 
as a nodal point to connect people and to address societal challenges. 
However, even though it is recognised that our educational ecosystem 
has the largest impact on society, it, unfortunately, remains the most 
fragmented (Luksha et al. 2018). Real-world case studies, stakeholders and 
implementations are used to see how relationships between educational 
facilities	 can	 benefit	 “urban	 education	 environments”	 (Kurshan	 2015).	
Within a well-functioning ecosystem, educational institutions have the 
opportunity to work together to improve the current curriculum, equip 
staff and teachers with more knowledge and skills, and create a more 
enhanced and engaging learning environment (Kilfoil 2019). Referring to 
the educational environment as an ecosystem is to understand the impact 
of educational institutions as nuclear agents. They have the capabilities of 
reinforcing existing and creating durable connections within networks in 
their context. For this reason, it becomes increasingly important to address 

Fig. 02: Educational Ecosystem (Authors 2020)

the role of education within an ecosystemic context. 

As part of the United Nations (UN) Sustainable Development Goals (SDG), 
education is seen as a priority (Fig. 03). The vision of quality education for 
all is stressed as an important aspect in the development of better lives 
and social sustainability, by the year 2030 (United Nations 2016). Education 
is a primary focus of the UN as it is essential to achieving numerous goals 
on the SDG list. Importantly, education is seen as the key to addressing 
the world’s poverty cycle. In the same light that education is seen as a 
determining factor in achieving multiple SDG’s, it also functions widely 
within poverty-stricken areas. Schools serve, not only as a medium for 
knowledge transfer but are integral in the support they provide to learners 
and communities, such as the provision of a learners’ daily meal source 
(Peterson 2020). 

In 2020, the COVID-19 pandemic resulted in the temporary closure of 
schools across the majority of the world’s countries (United Nations 2020). 
Specifically,	within	underprivileged	and	marginalized	areas,	the	underlying	
issues of the current education system were suddenly exposed, both 
globally and locally (Carte Blanche 2020; United Nations 2020). As stated 
by Basil Manuel from the National Professional Teachers’ Organisation 
of South Africa (NAPTOSA), in South Africa the nation-wide lockdown 
exposed and exaggerated the inequalities of the education system 
almost overnight. The issues discussed are particularly related to inclusivity, 
participation, equality and transformation (Peterson 2020). These issues 
proved that middle to upper-class learners were able to continue their 
education	 through	online	platforms.	However,	 those	who	are	financially	
disadvantaged, could not. This stems from a general lack of technological 
knowledge	and	skills	to	the	lack	of	finances	to	buy	internet	data	or	even	

Fig. 03: Sustainable Development Goals (United Nations 2016)

Fig. 09: Tsako Thabo (Naidoo 2019)
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print notes (Carte Blanche 2020; Peterson 2020). Parents are also often 
unable to help their children learn from home as in most households, their 
child	 is	 the	 first	 to	 go	 to	 school,	 leaving	 the	 rest	 of	 the	 family	 illiterate	
(Peterson 2020). As the schools have closed, many are left without a 
safe learning environment to attend daily, resulting in increased stress 
and anxiety for both learners and parents (Peterson 2020). Exposing this 
significant	gap	in	both	the	economy	and	the	knowledge	of	these	citizens	
truly highlights the importance of the evolution of the current education 
system. 

When engaging with the educational ecosystem it is important to be 
aware	of	the	influence	of	STEM	(Science,	Technology,	Engineering	and	
Mathematics). Both globally and locally, the focus on STEM has a major 
influence	on	 the	educational	 ecosystem,	 in	 terms	of	 curriculum.	 Since	
2009, in South Africa, the subjects Mathematics and Science were seen 
to result in public schools being in a state of “national crisis” (Pols 2019). 
This affected the qualitative outcomes of scientists, engineers and health 
practitioners in the workforce. The concept of STEM was introduced into 
schools as a way to increase the critical thinking capacity of current school 
generations (White 2014), ultimately leading to a stronger workforce that 
is more employable, setting up South Africa’s society for success (World 
Economic Forum 2017). This would contribute to breaking the poverty, 
crime and unemployment cycle of underprivileged communities within 
the country (Pols 2019). 

However, there have been numerous debates and much research 
conducted regarding the addition of the arts into STEM to expand 
scientists’ knowledge from critical to humanitarian and empathetic 
(Lachman 2018). STEAM (Science, Technology, Engineering, Arts and 
Mathematics) education allows for learners to be critical and analytical 
while recognizing the personal, social and cultural potentials of what they 
are doing (Pienaar 2017) (Fig. 04). Such pedagogical methods align and 
challenge school curricular reform to challenge the current education 
model. 

Psychologically, this educational concept teaches learners self-
expression, wider forms of criticism and ultimately helps to develop them 
for the working world where they would be more susceptible to taking 
risks and developing new ideas (Lachman 2018; Pienaar 2017). Initiatives 
such as Leap Science and Maths schools are a chain of non-fee paying 
schools that aim at offering quality education to underprivileged, low-
income communities. Sustainable models like these are imperative to 
empowering people as they focus on the fostering of learners’ cultural 

and communal identity while ultimately creating 
a pathway to future employment (LEAP 2017). 
Robinson (2010) emphasizes that schools are 
currently failing to acknowledge and encourage 
multiple types of intelligence. He states that the 
traditional standardization of education needs 
to be revised to develop the youth’s ability for 
creative and practical thinking. This type of 
curriculum change impacts the educational 
ecosystem by allowing more opportunities for 
the inclusivity of all students, not only those that 
fit	 the	critical-thinkers	mould.	As	designers	and	
researchers, this is the standpoint from which 
we approached the educational ecosystem. 
Robinson (2010) highlights that the future of our 
economy is dependent on innovation and a 
person’s ability to anticipate future concerns 
and have the skills and capability to implement 
solutions. This way of learning encourages 
students to engage realistically with skills that will 
help them sustain their lives in the future (Carson 
2016). 

Within the educational ecosystem, it is crucial 
to understand the relationship between 
people and their environments and to engage 
in how/why these relationships are created 
and exist (Mueller & Toutain 2015: 8) (Fig. 05). 
An understanding of these relationships is 
crucial to inform our approach as designers. 
As designers and researchers with a major 
interest in developing social cohesion within 
communities, the educational ecosystem 
becomes	 a	 significant	 influence	 on	 design	
considerations. This is due to thinking beyond the 
case of standard systems within a community, 
but rather considering a number of deeper and 
interconnected themes that accumulate and 
influence	the	way	communities	work.	It	is	about	
looking beyond surface observations and 
engaging in uncovering the social interrelations 
making up a community. 

Fig. 10: Tsako Thabo (Naidoo 2019) 

Fig. 04: STEM vs. STEAM (Authors 2020)

Fig. 05: Interrelation Between People and their 
Environments (Authors 2020)
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Relation to Architecture

The importance of addressing the educational 
ecosystem has already been established across 
various disciplines. However, as designers and 
researchers within the architectural discipline, 
we must ask ourselves how we can contribute 
to educational ecosystem discourse. The 
educational ecosystem has largely been 
discussed from a non-spatial point of view, 
however, the role that architecture plays 
within that discussion is limited in comparison 
(Cleveland & Fisher 2013:1) (Fig. 07). The spatial 
constructs of the educational ecosystem 
affect a child’s ability to learn, however, the 
design consideration given to these learning 
environments	 is	 significantly	 under-developed	
(Higgins et al 2005). Our project motives align 
with the Action Plan towards schooling 2025 
released by the Department of Basic Education 
(DBE) which focuses on giving priority to the 
wellbeing of the learner. Goal 24 emphasizes the 
need to “ensure that the physical infrastructure 
and environment of every school inspires 
learners to want to come to school and learn, 
and teachers to teach “(DBE 2014).

One of the biggest challenges facing South 
Africa is the development and improvement of 
the knowledge and skills of its learners, primarily 
amongst disadvantaged and low-income 
sectors of the population (Albertyn 2015).
Although access to education has improved 
significantly	since	the	educational	reform	in	1994,	
the equality of access does not yet translate to 
opportunity. According to Dr. Jonathon Clark, 
director of the Schools Development Unit and 
Schools Improvement Initiative at the University 
of Cape Town, the quality of learning outcomes 
has not escalated in parallel (Albertyn 2015). 
Clark states the importance of building a 
network of innovators and educators who are 
“like-minded change-makers”, who are actively 

willing to transform the educational ecosystem in South Africa to improve 
the quality of education. We see our dissertation proposals not only 
contributing to this network but also stretching its outlook to understand 
the impact of this type of architecture.

An ecosystem, in an academic environment, constructively frames the 
need for interdependency and sustainability. A schools’ functioning 
through a facility and built environment point of view, is a result of its 
infrastructure and resource management (NEIMS, 2014). The control and 
implementation of these elements allow for the creation of a safe and 
enabling learning environment. Networks are catalysts used to enhance 
knowledge as well as provide support for innovators. A shift in paradigm 
that fosters an educational ecosystem is necessary to advocate for 
education that is facilitated by a network of teachers. Educators are 
lifelong learners, so to improve learning, the commitment to educator 
development is crucial. Our research and dissertations unpack key 
educators and knowledge innovators in the community that form part of 
a larger educational ecosystem used as part of lifelong learning within the 
schools, as well as the surrounding communities (Albertyn 2015) (Fig. 08).

Through investigating the relationship between architecture and education 
with	specific	relation	to	our	case	study,	Tsako	Thabo,	we	found	a	need	to	
go	further	into	exploration	and	design,	to	create	a	significant	change	in	
the education environment. This can often be perceived as a place that is 
confining	and	static.	Herman	Hertzberger	(2008:169)	unpacks	this	concept	
further when he discusses the culmination of multiple schools within a 
neighborhood	mutually	 benefiting	 from	 their	 shared	 resources.	 Bringing	
together multiple schools, all of which have different aspects to add to the 
success	of	the	ecosystem,	results	in	flexibility,	social	cohesion	and	saving	of	
funds (Hertzberger 2008). The learning between the schools becomes far 
more inclusive for all. Through an architectural lens, to contribute towards 
a well-functioning educational ecosystem, “new, more stimulating spatial 
conditions and forms” need to be considered (Hertzberger 2008: 57). Our 
dissertations serve to contribute to that discussion and engage in the 
impact of architecture on the educational ecosystem. 

Fig. 06: Relation to Architecture (Authors 
2020)

Fig. 07: Non-Spatial and Spatial Contribution 
(Authors 2020)

Fig. 08: Educational Ecosystem Collaborators (Authors 2020)

Top: Fig. 11: Tsako Thabo (Naidoo 2019)
Bottom: Fig. 12: Mamelodi (Naidoo 2019)
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03_CONTEXT

Mamelodi Community of Learning Collaborative
The following chapter provides the foundation for the 
contextual understanding of the dissertations. Our dissertations 
are based within the context of Mamelodi East, where the 
University of Pretoria’s Mamelodi Campus serves as an anchor 
institution. As such, the Campus has increased its awareness 
of the role it plays within its context by contributing to overall 
community upliftment and individual student success within 
schools (Kilfoil 2019). The Campus has engaged in multiple 
community projects within Mamelodi since 2008 (Ogude 
2019). These projects are conducted in an effort to uplift the 
community as a whole and to socially, academically and 
economically impact the larger society of South Africa. 

A relationship was established between the UP Mamelodi 
Campus and Rutgers University in Newark, United States, when 
the universities recognised that their ambitions, as anchor 
institutions within their contexts, aligned. An outcome of this 
relationship is the Collaborative of Learning Community (CLC), 
funded through the support of the Kresge Foundation. In 2017, 
the	 initiatives	were	officially	founded	in	both	Newark	(NCLC)	
and Mamelodi (MCLC) (Ogude 2019). The involvement of 
the	 MCLC	 is	 influential	 within	 the	 dissertations.	 The	MCLC	 is	
composed of numerous faculties within UP, each investigating 
the educational ecosystem from the perspective of their 
discipline.	The	collaborative	has	identified	key	partners	within	
the Mamelodi educational ecosystem to engage with, 
including Early Childhood Development centres (ECDs), 
Primary and Secondary schools as well as the local and 
provincial departments of Basic Education. Tsako Thabo 
Secondary stood out within this selection of partners due to 
the growing relationship the university has with its principal 
and MCLC member, Mr. Clement Gama. The school has been 
open to engaging with the university and its students and is, 
therefore,	a	significant	collaborating	partner.	

The Department of Architecture, within the Engineering, 
Built Environment and Information Technology (EBIT) Faculty 
is represented in the MCLC through the Unit for Urban 

Citizenship (UUC). The Unit’s contribution to the collaborative 
is to investigate the educational ecosystem within Mamelodi 
from the perspective of the architectural discipline. Numerous 
projects undertaken within the Unit have contributed to our 
spatial knowledge database of Mamelodi’s educational 
ecosystem. Throughout the Unit’s investigations, smaller nodes 
of activity are recognized as active educational nodes that 
could potentially contribute to a lifelong learning process 
within the community.

The MCLC actively intends to contribute to its hyper-local 
context. As part of its initiative, the collaborative is also involved 
in the Joint Community Project module (JCP), situated within 
the EBIT Faculty. This course makes provision for University-
funded community service projects to be completed by 
undergraduate students in the EBIT faculty during their second 
year of study. The volume of these students makes this course 
a powerful tool within community action initiatives. Many 
schools in the Mamelodi East community have collaborated 
with students from the JCP course. Tsako Thabo is amongst 
the schools to have received support from these projects, in 
the form of personal protective equipment (PPE) to maintain 
health standards for the reopening post-2020 COVID-19 
lockdown. Due to our long involvement in Mamelodi, we have 
become acquainted with pressing areas of concern that have 
the potential to be addressed through the JCP course. Using 
this knowledge, we intend to produce directed JCP project 
briefs for students to undertake at Tsako Thabo. 

Context

MCLC 
MAMELODI COMMUNITY 

OF LEARNING 
COLLABORATIVE 

UNIVERSITY OF 
PRETORIA 

BOUKUNDE: DEPT. 
OF ARCHITECTURE

(Honours  2019; Konstantinou 2020)

Fig. 13: MCLC Diagram (Authors 2020)
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Mamelodi East

The MCLC provided the direction towards the township of 
Mamelodi East in the City of Tshwane as our context for the 
investigation. This township was formed during the Apartheid 
regime for the African population in 1945 (van der Waal 2000). 
Like most disadvantaged communities in South Africa, this 
settlement has a history of government neglect and social 
struggle. The oldest part of Mamelodi runs along Tsamaya 
Road and the Moretele River (van der Waal 2000), including 
the area surrounding the case study school. 

The UUC has been actively involved in investigating the 
spatial qualities of the educational ecosystem in Mamelodi 
East since 2017. Our engagement began in February 2019. 
The following timeline sets out our period of involvement.  

In 2019, the following themes were uncovered through the 
participatory process of mapping conducted by the UUC 
Bachelor of Architecture Honours group:

•	 Routes: pedestrian access and movement in 
terms of safety and trade (Du Bois and Mulder 
2019) (Fig. 18, 19 & 20)

•	 Recreation: sports as a platform for social 
cohesion and ownership (Ras 2019) (Fig. 21)

•	 Social capital: relationships and networking 
that strengthen the community (vd Hoven 
2019) 

•	 Food culture: informal and formal distribution 
of food (Smith 2019) (Fig. 22 & 23)

•	 Informal Economy: the value of trade and 
trends of income (Mlambo 2019)

•	 Education typologies: quality of school 
typologies and the impact on education (Achi 
2019)  (Fig. 24 & 25)

•	 Cultural aspects: social cohesion through 
music, dance and the arts (Konstantinou 2019) 
(Fig. 26 & 27)

•	 Sacred space: understanding ownership and 
the role sacred space has within the community 
(Motshabi & Naidoo 2019) (Fig. 28)

These themes were all thoroughly unpacked 
through mapping, unstructured interviews, 
community action planning and participatory 
sessions. This information moved beyond the 
surface of simple observation and assisted in our 
directed understanding of the context we are 
dealing with. 

All data accumulated over the period, as 
indicated in the timeline above, has formed a 
database of information for our dissertations. 
The type of information mapped and recorded 
includes patterns of movement, the evolution of 
the space over the years, activity and program 
mapping as well as public and private space 
indicators. 

To better understand architecture and the story 
we are trying to tell, we have to contextualize 
the environment, the people and the process. 
These elements involved in our research have 
influenced	our	 perspective	on	 the	community	
itself and provided us with insightful knowledge 
on how certain systems, groups and programs 
function. We have had the privilege to work in 
and with such a culturally rich community who’s 
potential and passions have remained the 
drivers during our process of development. 

Fig. 14: Mamelodi Context Map (Authors 2020)

Top: Fig. 15: Mamelodi Transect Walk (Honours 2019)
Middle: Fig. 16: Mamelodi Context (Honours 2019)
Bottom: Fig. 17: Mamelodi Context (Honours 2019)
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2322 Fig. 20: Safety Mapping (Authors 2020) Fig. 21: Recreational Mapping (Authors 2020)



2524 Fig. 22: Food Culture Khalambazo Mapping (Authors 2020) Fig. 23: Food Culture Tsako Thabo Mapping (Authors 2020)



2726 Fig. 24: School Typologies Mapping (Authors 2020) Fig. 25: Classroom Typologies Mapping (Authors 2020)



2928 Fig. 26: Cultural Aspects Mamelodi Mapping (Authors 2020) Fig. 27: Cultural Aspects Tsako Thabo Mapping (Authors 2020)



3130 Fig. 28: Sacred Space Mapping (Authors 2020)

Tsako Thabo as a Case Study

Due to the relationship with the MCLC and 
the open engagement with UP, Tsako Thabo 
Secondary	School	was	identified	as	a	base	case	
study for our dissertations. The intensive mapping 
conducted within Mamelodi East provided us 
with contextual grounding for our investigation 
into the school. Thereafter, the school provided 
a platform to observe, investigate and 
explore the current educational ecosystem 
within Mamelodi East. It was the foundation 
for identifying opportunities for an expansive 
educational network that could empower and 
contribute to the community.

At a postgraduate level, UUC architecture 
students have worked closely with Tsako Thabo 
Secondary School, since 2019 (Kilfoil 2019). The 
school is currently used as the anchor node for 
postgraduate architecture studies within the 
UUC. These students actively engaged within 
the school and the surrounding community, 
where school learners and community members 
participated in intensive mapping and 
participatory research. This methodology was a 
part of the process that resulted in community 
action planning strategies, urban visions and 
responsive architectural interventions (Kilfoil 
2019). 

Our personal involvement with the school began 
with our introduction to Mamelodi East, in 2019. 
From an introduction session with the current 
principal, Mr. Clement Gama, a brief overview 
of the school was conducted: 

“The aim of the school is to be all-inclusive, 
however,	 it	 is	 difficult	 as	 the	 staff	 is	 not	
equipped or trained to do so. [...] They 
have the number one volleyball team in 
Tshwane but use the community hall to 
practice (not the school). Their goal is to 

have a proper art studio. [...] [The school] 
was built in 1981 in a train layout. Now it 
looks more like a jail because it has been 
fortified	 [due	 to	 the	 many	 break	 ins].	
People steal metal (cooking pots, chairs, 
etc.), electronics and food. [...] There 
are eight or nine unused classrooms that 
could be used for other [community] 
activities. This is a good idea as community 
centres are far from this area. [...] There is 
a direct correlation between doing well 
in	school	and	attendance	(influenced	by	
the parent’s input). Parents try to live their 
dreams through their children and give 
pressure in the wrong areas (therefore 
kids don’t enjoy school). However, most 
parents of the school are not involved 
(e.g. parent’s associations)” (Personal 
notes during 2019 introduction by L. 
Konstantinou).

Thereafter, we carried out intensive participatory 
research at the school. Previous engagements 
with students in the school ranged across a 
wide variety of themes. 

Focusing on sport and the current 
facilities, ”Students of the volleyball 
team, in particular, are extremely proud 
and their involvement in the sport is 
a constant grounding and motivator 
to them” (Personal notes during 2019 
introduction by R. Ras). Music focused 
workshops also took place within the 
corridors of the school, “the melodies 
generated from these participants 
were so evident of their passion and 
zest for life and clearly illustrates the 
power music instils for social inclusion” 
(Personal notes during 2019 introduction 
by L. Konstantinou). Food Sovereignty 
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was unpacked through design activities 
involving the students interacting in 
games that illustrated what food types 
and proportions are consumed daily [...] 
“ Entrepreneurial activities of food selling 
ignited negotiators and good sales 
people within the participant group” and 
kitchen conversations were welcomed 
by the kitchen staff as they prepared 
lunch daily (Personal notes during 2019 
introduction by K. Smith). Transect walks 
in and around the school led by the 
students provided a perspective of the 
unseen activity that exists between 
transition times within the school…...
(Personal notes during 2019 introduction 
by P. Naidoo).

The Mamelodi East mapping as well as the 
collected sources of information from the above 
formed the basis for our dissertations. With this 
information	we	hoped	 to	 layer	on	our	 specific	
dissertation focus through our 2020 participatory 
action research (discussed in volume 2 of our 
individual dissertations), to inform our design 
interventions that are rooted in the school’s 
ethos and are catalytic contributors to the 
school and surrounding community. 

As a primary participant target group, the 
dissertations focused on high school learners, 
between the ages of 13 and 20, that attend 
Tsako Thabo Secondary School.  Each of the 
student	 participants	 was	 specifically	 identified	
through the Honours mapping of 2019, through 
unstructured interviews and word of mouth 
through social groups within the school. 
Within our individual dissertations, we have 
expanded on this focused target group to 
include	participants	 related	 specifically	 to	 our	
dissertation topics. It is important to note that 
due	 to	 each	 researchers’	 specific	 topic	 and	
the COVID-19 nation-wide lockdown of 2020, 

additional participants from other schools and 
elsewhere,	were	identified	to	partake	in	certain	
stages of the research and design. 

From observations, mappings and analysis done 
over the last few years within Mamelodi East, a 
common spatial language was found between 
most schools in the area (Achi & Venter 2019). This 
is	specifically	related	to	their	social	context	and	
built form. Although our dissertations are based 
at Tsako Thabo, it is important to note that we 
intend to not spatially resolve surfaced issues at 
a single school. Tsako Thabo Secondary School 
has been used as a case study to represent 
other schools in Mamelodi East. Although each 
school still has its unique characteristics, issues 
and opportunities, Tsako Thabo has been 
used as a basis to understand and test the 
researchers’ solutions through proposed design 
interventions. These proposals are then not 
limited to the school and can be proposed for 
other schools across the area, addressing similar 
social issues. We intend that the lessons learned, 
information captured and designs developed, 
through our dissertations, will contribute to the 
knowledge base for addressing similar issues 
existing within our country and even globally. 

Fig. 29: Tsako Thabo as a Case Study (Honours 2019)
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04_ARCHITECTURAL APPROACH

Unit for Urban Citizenship
The Unit for Urban Citizenship (UUC) has provided a much-needed 
platform, within the University of Pretoria’s (UP) Department of Architecture, 
to challenge conventional architectural discourse. It was once run as a 
studio within our Honours year in 2019 (Fig. 30) but has grown in recognition 
within the Department, in 2020. Urban Citizenship is now one of the three 
research	fields	in	the	department	(Fig.	31),	along	with	Heritage	and	Cultural	
Landscapes and Environmental Potential. During the Unit’s introduction 
session, a question was posed to the staff and students of the department 
to construct a collaborative description of what it meant to be an “Urban 
Citizen”. Collectively the “Urban Citizen” was described to be an agent of 
change, who strives to create sustainable relationships and maintain unity 
through diversity and social inclusion. The studio is run by urban citizenship 
enthusiast Dr. Carin Combrinck, who currently oversees both the Honours 
and Master’s Programmes in Architecture at UP. Dr. Combrinck’s active 
involvement in community-driven projects, engagement in the MCLC and 
passion for urban citizenship contributed to the foundation of the unit. 
The impact of the UUC is not isolated to postgraduate approaches to 
architecture.	It	has	influenced	all	years	within	the	architecture	department,	
from small scale modules in undergraduate years to full-scale studios at a 
postgraduate level. UUC has been the driving force for our dissertations 
and has provided the foundation for our research and architectural 
approach. Urban Citizenship values the diversity of people, cultures and 
environments and aims at encouraging citizen participation throughout 
the design process to establish a framework for architecture that is inclusive 
and empowering to the user. 

Fig. 30: Qualitative Research at Tsako 
Thabo (Konstantinou 2019)

Fig. 31: UUC Programme Development (Authors 2020)

Research Approach

Due to the nature of the UUC, the approach 
to our research was through the interpretive 
paradigm by collecting and analyzing 
qualitative data of the real-world context 
of Mamelodi East. Our particular focus was 
on participatory action research (PAR) to 
expand the discourse of architecture. PAR 
allowed for the process of analysis and critical 
reflection	to	happen	simultaneously	at	intervals	
throughout the design and engagement 
phase. The research approach values diversity 
and is focused on positive social change as 
an outcome (Macbeth 2020). It constantly 
kept us grounded on the basis to create 
greater awareness for citizen participation to 
address issues with a greater sense of agency 
(Awan	et	al.	2011).	The	spatial	agency	defines	
the process as working at the intersections 
between the individual and the collective, the 
virtual and reality realm (Awan et al. 2011). 
Qualitative data collection has been integral to 
our PAR approach. Collecting qualitative data 
allowed us to study end-users’ lives from a direct 
and engaged perspective within their own 
environments, resulting in contextually relevant 
data sets. This represented the real-life views 
of the people who would directly be affected 
by the research conducted (Merriam 2009, 
Yin 2011) and the potential outcomes that the 
dissertations posed. This method is supported 
by professionals, researchers and creatives 
that use collaborative design strategies from a 
conceptual approach to the tangible outcome 
phase.  

Mapping and unpacking qualitative data 
allow researchers to contribute to existing and 
current emerging ideas within the human social 
environment. This allows for trends to be noticed 
and certain events to be explained through 
existing social concepts (Yin 2011). 

It is vital for researchers to be completely 
transparent with their methodologies when 
taking a qualitative approach. This is necessary 
for future researchers to contribute to the 
data or test the mapped trends for credibility 
(Merriam 2009, Yin 2011). To do this, analysis of 
data must be taken from a grounded framework 
that	allows	focused	reflection	and	removes	the	
researcher’s personal bias (Merriam 2009, Yin 
2011).	 Describing	 fieldwork	 should	 also	 show	
that the researcher was “really and fully present 
- physically, cognitively and emotionally” 
(Yin 2011: 574). Using the actual language 
quoted in interviews and collecting data from 
multiple	 sources	 aids	 in	 finding	 patterns	 and	
contradictions which ultimately strengthen the 
credibility and value of qualitative research (Yin 
2011).

Through our engagement in the context of 
Mamelodi East over the two years, qualitative 
research	 was	 conducted	 through	 fieldwork	
observations, interviews and engaging 
conversations (Yin 2011). Our process was 
incremental and built up our qualitative data sets 
through a series of interactions with the context. 
Firstly,	 we	 documented	 our	 first	 impressions	
through our observations of the site. This set 
up our biased opinion which was important 
to	 reflect	 upon	 once	 we	 accumulated	 richer	
information. Thereafter, we conducted transect 
walks with community members to gather an 
educated outlook on the context and to assist us 
in	organising	our	first	impressions	of	the	site.	Once	
this was done, we moved onto semi-structured 
and formal interviews for more background 
information on our observations, as well as 
the intangible information we missed (Hamdi 
2010:69). This type of data collection involved 
asking, watching and reviewing (Wolcott 
1992).	Data	that	was	collected	in	the	field	was	

run in parallel with desktop data collection of 
literature and case studies (Merriam 2009). All 
of these data sets helped develop a deeper 
understanding and discover insights relevant to 
our research problem. 

The collective processes and data resulted in 
the development of the Ukudoba Method, 
further described in chapter 5, which serves as 
our research methodology for our dissertations.

It is important to acknowledge that this type of 
research is only based on a sample of people 
within the area the researcher is investigating. 
It does not represent all extents of the issue 
uncovered but allows for future addition and 
comparison of research and trends (Yin 2011). 
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Design Approach 

As architects, we use design to unpack, 
understand, translate and address issues and 
opportunities. However, this process is usually 
biased to the individual outlook of the design 
practitioner. The process of design starts to 
evolve when the emphasis is placed on certain 
characteristics of design thinking methods and 
tools. Our particular focus on design was through 
the processes of co-design. Co-design explores a 
parallel narrative that emphasizes engagement 
and collaboration. Within the design thinking 
process, this method of engagement favours 
participatory involvement throughout the 
design process, from the discovery of the project 
to the delivery of a solution (Muller 2002, Steen 
et. al 2007). This collective nature often includes 
a variety of stakeholders and participants 
involved in the design process, from design 
practitioners to end-users (Zamenopoulos et 

al. 2018). Involving the end-user in the design 
process is an integral part of effective and 
efficient	design	decision-making	(Hamdi	2010).	
Co-design encourages user participation and 
aids in transferring the power of decision making 
from design practitioners, who traditionally 
have it, to the affected marginalized target 
group within society. It is acknowledged that 
every participant around the co-design table 
holds tacit knowledge, integral to the success 
of the project. Vital contributions from the 
marginalized group result in higher quality 
outputs (Ehn 1993, Schuler et. al 1993, Spinuzzi 
2005) that are socially inclusive and able to live 
beyond the years of the project development. 

Co-design contributes to the design process 
as well as the lives of the participants involved. 
The	methods	 are	 aimed	at	 a	 specific	 context	

and require the input of spatial agents through 
citizen participation. It uses participatory action 
research to mediate and facilitate the process of 
engagement, knowledge sharing and problem-
solving. The hope is to create a collaborative 
approach that democratizes societies and 
allows citizens to take ownership and control of 
their environment (Zamenopoulos et al. 2018). 
Participants	benefit	from	this	approach	through	
social interaction and developing a sense of 
community, through shared values and interests 
(King 1983). It provides citizen attachment to 
the particular site of investigation within the 
community, inspiring action and motivation 
to protect and improve the location at an 
individual and community scale (Sanoff 2011). 

Professor Nabeel Hamdi, along with other key 
theorists advocating for co-design processes, 

Opposite page
Top Left: Fig. 32: Qualitative Research at Tsako 
Thabo (du Bois 2019)
Top Right: Fig. 33: Qualitative Research at Tsako 
Thabo (Greyling 2019)
Bottom left: Fig. 34: Qualitative Research at 
Tsako Thabo (du Bois 2019)
Bottom Right: Fig. 35: Qualitative Research in 
Mamelodi (Combrinck 2020)

Right: Fig. 36: UUC Studio (Authors 2019)
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relationships with one another (Kensing 2003, 
King 1983, Simonsen and Robertson 2013), that 
allows for mutual understanding and respect to 
create an open and supportive environment 
amongst the group (Markus and Mao 2000). 
As participatory researchers, we aimed to 
have multiple face-to-face participatory and 
co-design sessions. This would add to our co-
design workshops that were conducted in 
our 2019 Honours year. However, due to the 
COVID-19 pandemic, our co-design methods 
were adjusted (Fig. 37). The circumstances 
of the pandemic, and the resulting country-
wide lockdown, pushed the need for digital 
engagement to interact with participants and 
collaborate on the design development of 
our projects. These platforms and methods of 
engagement included websites, participatory 
games, conversational platforms and social 
media platforms to maintain our ability to co-
design through social distancing restrictions. 
Having to adapt to changing circumstances 
widened our spectrum of co-design experience. 
Our varied engagement spoke to the resilience 
of co-design discourse, as we were able to 
adapt our process along the way, without losing 
sight of the importance of collaboration. 

This method of collaborative design thinking 
challenges architectural discourse, particularly 
within our department. Co-design encourages 
the design practitioner to act as a spatial 
agent and to look beyond familiar contexts. 
It focuses on marginalized communities that 

has impacted our positioning as researchers. 
These theorists move away from the traditional 
approach to design and suggest “other ways 
of doing architecture” (Awan et. al 2011). 
Co-design moves towards socially engaging 
architecture. This alternative approach aims to 
use architecture to uncover existing potentials 
within communities that can be harnessed 
for upliftment overall and act as mediators 
to improve the conditions, wellbeing and 
functioning of societies. Architecture becomes 
more about spatial agency and collaboration, 
focusing on the social implications of the built 
environment rather than the typical aesthetic 
and monetary value. Each individual’s 
interpretation of architecture is challenged and 
criticism is invited into the practitioner’s design 
process, resulting in constant iteration and 
reflection	 on	 the	 value	 of	 social	 architectural	
work (Spatial Agency Online n.d.). Hamdi 
focuses on “small-scale change at a grass-
roots level” (Spatial Agency Online n.d.), where 
he aims to work with the given, having small 
changes over time that lead to agency and 
success in the long run, rather than a quick 
solution led from the outside. 

There are numerous methods to co-design 
engagement. Model building, sketching, writing, 
role-playing and design games are amongst 
the list of interactive and collaborative tools 
to mediate the co-design process between 
stakeholders, participants and designers. These 
are traditionally held face-to-face, to form 

are often discriminated against and deals with 
real-life issues present within less fortunate, rural 
contexts (Zamenopoulos et al. 2018). As we 
are trying to challenge the current discourse, 
it is important to point out that small steps are 
required to incur big change. According to 
Hamdi (2010:19), “Clever projects have a small 
number of meaningful indicators”. Therefore, 
throughout our dissertations, co-design has 
been used at particular stages of our design 
processes to enrich a design response that is 
true to the context and community involved. 

Fig. 37: COVID-19 Impact (Authors 2020)

Reflection

Layers of rich information were uncovered 
through our PAR approach within Mamelodi 
East, highlighting the untapped goldmine 
of opportunities for upliftment. Numerous 
qualitative data collection methods were tested 
throughout	 our	 process.	 Through	 reflection	
and iteration throughout the process, we were 
able to learn and grow in our understanding 
of	how	to	efficiently	and	effectively	approach	
participants during our limited time in the area. 

Due to the UUC’s continual engagement in 
Mamelodi East, layers of data had accumulated 
over the years (Fig. 38). Year after year students 
aimed at building on the previous years’ work 
to contribute to the existing data collected and 
to inform a richer design response. Amongst the 
data set, recurring themes and observations 
were presented, however, the storage of the 
data in unorganised folders on a Google Drive 
hindered access to the information. This made 
it	 difficult,	 during	 our	 dissertations,	 to	 collate	
the collected information and fully grasp the 
richness of the layered data. This stagnant 
method of data storage led to the need to 
change the format (later discussed in Chapter 
5) and method in which we were capturing 
this intangible qualitative data, to assist future 
researchers.

Fig. 38: Continuous Data Collection (Authors 2020)
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05_METHODOLOGY AND 
RESEARCH DESIGN

STINT Research Project 
In 2019 we were afforded the opportunity to be 
involved in a Departmental National Research 
Foundation (NRF) project. The NRF project 
titled, Stitching the City: From micro-data to 
macro-views (STINT), aimed at establishing a 
“transdisciplinary collaboration” to develop 
a “methodological framework and digital 
platform for the collection, storage, and sharing 
of spatial, socio-economic data at a street 
and	precinct-level”	(Roussou,	Brandao,	Adelfio	
& Thuvander 2019). The STINT project was a 
collaborative effort between the University 
of Pretoria (UP), South Africa (Departments 
of Architecture and GeoInformatics) and 
Chalmers University in Gothenburg, Sweden 
(Department of Architecture) from 2019 to 2020. 
In particular, the collaboration was between the 
Unit for Urban Citizenship (UUC) and the Social 
Inclusion Studio (SIS) from Chalmers University’s 
architecture department. For many years, both 
studios worked within similar contexts that were 
socially marginalised and segregated (Chalmers 
2018). The two contexts under investigation 
were Mamelodi East in the City of Tshwane, 
South Africa and Hammarkullen in Gothenburg, 
Sweden. 

Due to UP’s architecture Head of Department, 
Prof. Chrisna Du Plessis’ working relationship 
with members of SIS, this collaboration was 
born. To understand the complex layers of 
cities and communities of today, it is vital for 
multiple components of involvement, as a 
way to inform and shape the social and built 
environment	 (Roussou,	 Brandao,	 Adelfio	 &	
Thuvander 2019). University students routinely 
collected quantitative and qualitative data. 

Both studios found common ground in their 
methods of data collection. This took the form 
of	visual	and	spatial	data	 from	 immersive	field	
research sessions. Over the years, this data 
revealed	many	 significant	 trends	and	patterns	
related to the real-world context and use of 
the environments investigated. We shared in 
the issue that layers of rich data were being 
collected by students within both studios, 
critical to the holistic understanding of the 
contexts in question. However, this information 
piled up in printed notes or shared folders on 
an online server. These invaluable discoveries 
were lost due to the ad hoc storage of data 
in multiple formats. This made it increasingly 
difficult	 to	 effectively	 access,	 layer	 and	 share	
the collected data with decision-makers and 
the end-user to effect change. It became 
frustrating that the methods of data collection 
invoked static data storage methods. The STINT 
project was therefore developed in response to 
this common issue. 

The Department of GeoInformatics, at UP, 
involvement in the STINT/NRF project resulted 
in the creation of an online server (Geonode), 
to store the collected data. This platform allows 
the digitalisation of collected information and 
the database will continue to develop for future 
endeavours. The information contributes to a 
large collaborative database and forms the 
basis for many design projects and research 
initiatives. The collaboration between the 
universities, allows the developed platform 
to be tested in two areas, to compare the 
effectiveness of the platform in capturing non-
traditional data sets (Chalmers 2018). Part of our 

involvement in this process was the testing of 
this	through	field	research	for	our	dissertations.	

Collectively, we needed to change the way 
data was collected, translated, stored and 
shared within our department, to make a 
greater contribution to society and research. By 
acknowledging these shortcomings and actively 
engaging in the STINT/NRF project we collectively 
contributed to the development of a framework 
(ukuDoba Method). The framework allows non-
traditional information types to be collected 
using digital and geospatial tools, thereafter, 
stored and shared on an online platform. 
It allows for local and global collaboration 
between researchers and designers on shared 
issues and similar contexts (ukuDoba manual 
2020). The aim of collecting and sharing data of 
this nature is to allow informed and responsive 
urban and socio-economic transformation 
policies for future development (Chalmers 
2018)	and	identification	of	contextually	relevant	
development interventions. 

From top left to right
Fig. 39: Hammarkullen: First immersion walk (Konstantinou 2019)
Fig. 40: Hammarkullen: Analogue data collection from first immersion walk 
(Konstantinou 2019)
Fig. 41: Hammarkullen: Run-through of digital data collection methods 
using KoboToolboxTM   (Konstantinou 2019)
Fig. 42: Hammarkullen: Social Inclusion Studio (Unknown 2019)
Fig. 43: Pretoria: Digital Tool Analysis (Naidoo 2020)
Fig. 44: Pretoria: Testing the effectiveness of KoboToolboxTM, on site, in the 
data collection process (Brandao 2020)
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ukuDoba - The Methodological 
Framework

The ukuDoba Method was created from 
a collaboration between three Master of 
Architecture students from Chalmers University 
of Technology, Sweden (Robin Eskilsson, 
Mumtaheena Rifat and Markus Zorn) and 
three Master of Architecture students from 
the University of Pretoria, South Africa (Lauren 
Konstantinou, Purll Naidoo and Kelsey Smith). All 
authors were actively involved in the STINT/NRF 
research project and have a background in 
participatory design, social inclusion and urban 
citizenship within architecture. This background 
influenced	 the	 interest	 in	 the	 creation	 of	 the	
ukuDoba Method. In Zulu, the word ukuDoba 
means	‘fishing’.	This	methodological	framework	
aims	to	assist	users	in	‘fishing’	for	non-traditional	
types of data that can be collectively stored, 
openly shared, layered over and analysed 
qualitatively over time. The ukuDoba Method 
was developed in response to the STINT/NRF 
project, to guide researchers, from various 
fields,	 in	 the	 methods	 of	 data	 collection	 and	
translation	 to	 efficiently	 store	 and	 access	 the	
data thereafter.

ukuDoba - the methodological framework 
(See Appendix B), has been developed for 
the collection and sharing of non-traditional 
types of spatial and socioeconomic data at a 
street and precinct level in an online platform. 
Cross-disciplinary micro-data can be added 
over time and easily accessed by researchers 
from different disciplines as well as students and 
community members. This makes it susceptible 
to comparison and trend studies, as well as 
documenting the rich histories of communities. 

The developed methodology can eventually 
replace hard-copy storage that is limited in 
accessibility and fragmented in data. 

The UkuDoba method was developed through 
multiple trials and tests during the process of 
collaboration between the two universities 
(See Appendix A). For the duration of the 
research project, two exchange trips were 
planned between the two contexts, to test 
the	effectiveness	 of	 a	digital	method.	 The	 first	
exchange trip was hosted by the Social Inclusion 
Studio from Chalmers University in September 
2019. The UP Masters students (Lauren 
Konstantinou, Purll Naidoo and Kelsey Smith) 
and supervisor (Dr. Carin Combrinck), involved 
in the project, travelled to Sweden intending 
to test the developed data storage platform 
(GeonodeTM) in Hammarkullen, Gothenburg. 
The	 platform	 was	 first	 tested	 according	 to	 its	
ability to capture traditional analogue methods 
of data collection. Thereafter, it was tested 
against its compatibility with various digital 
data collection tools. The information and 
feedback gathered from these sessions were 
used for further development of the GeonodeTM 
platform. This part of the project was developed 
further for the remainder of 2019. In January 2020, 
the continuation of the STINT/NRF investigation 
was given a trial in the City of Tshwane, South 
Africa. The team from SIS joined the UUC’s STINT/
NRF team in South Africa. The main aim of the 
exchange in South Africa was to build on the 
testing of the various tools for data collection 
and the effectiveness of the storage platform. 
This was done within Mamelodi East. We 

intended to see if GeonodeTM was able to store 
the information collected without losing the 
richness of the data. A recurring issue was the 
understanding of these tools by the research 
team. Thereafter, it was decided that due to 
the complex nature of the process, it needed 
to be broken down into streamlined steps. This 
resulted in developing an instruction manual, 
referred to as ukuDoba - the methodological 
framework,	 dictating	 a	 simplified	 but	 guided	
process from data collection to storage. 

Multiple data collection tools were considered 
and tested, each against their accessibility 
and usability. It was important for the research 
team that the tools selected allowed for the 
inclusivity	of	researchers	from	various	fields	and	
the consideration for the use of the framework 
by the end-user. This consideration widened 
the contribution that a project of this nature 
could make. Providing allowance for wider use, 
meaning that the data collected could not only 
be layered by time, but also by discipline and 
community perspective. 

The ukuDoba method makes use of three 
platforms and functions in a three-step 
systematic process, to make the data capturing 
and sharing process seamless and productive. 
Firstly, Kobo ToolboxTM (Data collection tool) 
was used as a digital platform to geospatially 
capture information, such as interviews, surveys 
and conversations.  Secondly, QQISTM (Data 
translation tool) was used as a “middle-man” 
to translate collected data into an appropriate 
format to be imported into the third platform, 

GeonodeTM (Data Storage Platform). This 
platform was used to document all the 
geospatially collected data. Having GeonodeTM 
as the single platform for data storage allows 
for the layering of data year after year by 
researchers	from	various	fields	of	research.	

As part of the Participatory Action Research 
(PAR) approach of the UUC, the ukuDoba 
method, allows researchers to do justice to 
the rich information collected.  Using this 
methodology also provides the opportunity 
for community members to collect real-time 
information within their communities and this 
contributes to their social empowerment, 
providing them with opportunities to uplift their 
own surroundings. 

The developed framework has been 
workshopped by postgraduate students, 
within the UUC, by the student research team. 
Feedback	from	these	workshops	influenced	the	
refinement	of	 the	manual,	which	 later	 guided	
the beginnings of our PAR approach within our 
mini dissertations, in 2020. This method was used 
for mapping and analysis of existing social trends 
in Mamelodi East as a way to gain a hands-on 
understanding of the area and its community. As 
this method is an iterative process over months 
and	years,	it	is	important	for	us	to	reflect	on	our	
process and experience with the application 
of the framework to continuously update the 
methodology to the current research conditions 
and development in technology. As Master’s 
students, we have constantly engaged with the 
method alongside our peers and colleagues. 

The framework has encouraged this interaction 
of	fieldwork.	We	hope	 to	 influence	other	fields	
within the department to take to the method 
to create opportunities for collaborative data 
collection and sharing.

Being part of this collaborative process during 
the development and application phases 
has been crucial to our understanding of the 
importance	of	 the	data	collected	 in	 the	 field.	
The information, often personal and engaged, 
allows for a greater perspective of the user and 
the people in a community and is vital in the 
field	of	Urban	Citizenship.	Collectively,	during	our	
Honours year in 2019, we had to recapture data 
and mapping that was conducted previously, 
rather than build on it. The STINT/NRF project 
gave us an opportunity to be part of creating a 
framework	that	would	not	only	benefit	ourselves	
but also contribute to the discourse of Urban 
Citizenship within architecture. Locally and 
globally we share similar contexts and issues. 
This project allowed us to collaborate, discuss 
and have a broader understanding of the issues 
and possible resolutions. 

Opposite page from Top to Bottom
Fig. 45: Pretoria: Composing Draft 1.0 of the 
ukuDoba Framework Booklet (Naidoo 2020)
Fig. 46: Pretoria: Presenting ukuDoba Framework 
Draft 1.0 to the Honours Urban Citizen studio 
(Naidoo 2020)
Fig. 47: Pretoria: Presenting ukuDoba Framework 
Draft 1.0 to the Masters Urban Citizen studio 
(Naidoo 2020)
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06_RESEARCHERS’ INTENTIONS 
As active participants in the Unit for Urban 
Citizenship, we consider ourselves to be Urban 
Citizens. The Urban Citizen is proactive for 
change; they challenge rules and constraints 
and are intentional about their involvement. 
We strive to be agents of change and to not 
fall victim to the star architect mindset, but to 
be receptive to the knowledge that exists within 
others (Awan et al 2011). It is important for us 
that we continue to rewrite our own professional 
code of conduct as we are exposed to the 
values attached to participatory action 
methods.

Including participatory action methods in 
the architectural design process needs to be 
distinguished from a community outreach 
project. Participation of all stakeholders is 
integral,	adding	to	the	efficiency	and	resulting	in	
the effectiveness of the overall project (Hamdi 
2010). Architects and other built environment 
practitioners have loosely implemented 
community projects over the years. However, 
these projects deal with surface-level issues 
due to their lack of engagement with the end-
user. Therefore, the intervention is a product of 
the ‘outsiders’ interpretation of the community 
needs. Often these interventions fail due to the 
lack of ownership and pride by the targeted 
community. Challenging the conventional 
methodologies of architecture can be highly 
influential	 in	 the	 creation	 of	 higher-performing	

interventions that address multi-issued layers 
(Awan et al 2011, Hamdi 2010, Sanoff 2011).

Ultimately, the dissertations following this 
Volume One, unpack alternate ways of 
‘doing architecture’ that result in an increased 
social responsibility within communities, 
causing upliftment and a stronger sense of 
belonging for community members (Sanoff 
2011). Unfortunately, within the Department 
of Architecture at the University of Pretoria, 
there is no precedent for this approach being 
undertaken by a Master of Architecture 
(Professional) student. We hope that the 
participatory design process that we have 
undertaken in our dissertations opens the 
conversation within our discipline (Fig. 51). 

Our contribution to the establishment of the 
Unit for Urban Citizenship is the hope that we 
have helped create a foundation for future like-
minded students to collectively participate and 
take on real projects that impact communities 
in need. The Unit has encouraged us to 
challenge the authorship of architecture in the 
design process (Hamdi 2010) and prioritize the 
participatory action research approach. Our 
ambition is to encourage others to start thinking 
and designing by acting as spatial agents who 

effect change through the empowerment 
of others (Awan et al 2011). Our research 
collectively aims at emphasizing architectures’ 
role and capacity in contributing to social 
inclusion and transformative action (Awan et al 
2011:33).

Ultimately we aspire to widen and embrace 
young, innovative designers’ perspectives on 
the	 true	definition	of	community	engagement	
in architecture and the opportunity for 
architecture to be socially inclusive. Our 
dissertation outcomes intend to pave the way 
for projects of this nature in the future. Projects 
that combine elements of interdisciplinary 
discourse to actively make a change to the 
community, as well as to contribute to the 
research development of spatial design within 
the co-design context locally and globally.

Fig. 51: Recognition of the PAR approach (Authors 2020) 

Opposite page from Left to Right
Fig. 49: Researchers collaboration (Smith 2019)
Fig. 50: The team (Unknown 2019)
Fig. 52: Dr Carin Combrinck, our supervisor, in 
the field (Zorn 2020)
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PROJECT SUMMARY
ADDRESS:

Tsako Thabo Secondary School, Tsomo Street, 
Mamelodi East, Pretoria, South Africa

COORDINATES:
25°42’34.3”S 28°22’17.8”E

MACRO SCALE:
Music Network as a part of the Mamelodi Heritage Route, 

Mamelodi Community of Learning Collaborative and 
UNESCO’s Creative Cities of Music

MICRO SCALE: 
Performance Centre at Tsako Thabo Secondary School

Tsako Thabo 
Secondary School

PRETORIA, SOUTH AFRICA

Pretoria CBD

University of 
Pretoria

Mamelodi East

Tsomo St

Tsa
maya Ave

Siband
e A

ve

Hinterland Ave

Fig. 02: Site Location (Konstantinou, Naidoo & Smith 2020 edited by Author 2020)
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ABSTRACT
This dissertation explores the impact of providing platforms 
for school learners to positively express themselves through 
multiple educational activities, in turn, developing a 
collective identity through performance. The existing 
school typologies in Mamelodi East, Pretoria, are found to 
hinder such explorative and all-round inclusive activities, 
resulting in the exclusion of many types of learners. Through 
a filter of music-making, the architecture of Tsako Thabo 
Secondary School in Mamelodi East has been assessed 
to have inadequate spaces and cause a disconnect 
with the community. Identified through literature, there is 
an opportunity to investigate the connection between 
music-making, participation and architecture as a way of 
transforming both the social and physical aspects of the 
school and surrounding community. 

The proposed intervention networks between existing nodes 
of music-making. With a focus on the node of Tsako Thabo 
Secondary School, an expressive architectural language 
is used to provide platforms for inclusive and adaptable 
educational and social activities. This language ripples 
out through the built fabric of the community and creates 
a sense of identity through the intersection of music and 
architecture. This dissertation uses participatory research in 
order to identify real world problems and social agents of 
change within the community. Furthering participation, co-
design methods are used to influence the iterative design 
process to work beyond the single author limitations and 
remain contextually and socially relevant throughout. This 
was largely affected by the COVID-19 pandemic, proving 
resilience and adaptability for the approach, relevant for 
current research methodologies. 

    Fig. 03: Site Model photograph of existing school (Author 2020)

KEYWORDS
Performance Architecture, Participatory Research,  

Codesign,  Music-making, Positive Self-Expression, 
Platforms, Social Cohesion, Agents of Change, 

STEAM Education
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01_INTRODUCTION

Background to the study
As unpacked in the collaborative Volume One 
of this dissertation, the Unit for Urban Citizenship 
(UUC) within the Department of Architecture 
at the University of Pretoria has many projects 
active in Mamelodi East, South Africa. This is 
due to the connection with the Mamelodi 
Community of Learning Collaborative (MCLC) 
through Dr. Carin Combrinck. Through this and 
specifically within the Master’s year of 2020, 
there is a direct link with the postgraduate 
students and Tsako Thabo Secondary School. 
Through mapping and participatory workshops, 
inspired by the works of Nabeel Hamdi (2010) 
and Jeremy Till (2011), one of the major themes 
uncovered was music-making. 

Over the years of 2019 and 2020, this theme was 
thoroughly explored, critiqued and mapped 
out, resulting in the findings of established 
music schools in the area. These range from 
conventionally medium scale to much smaller 
informal learning. A crucial finding from this 
investigation was that no matter the capacity 
of the music school, nor the distance between 
such schools and other institutions where music 
was subtly evident, there was limited knowledge 
regarding these institutions to the surrounding 
community of Mamelodi East and with one 
another. This, according to Till (2011), can be 

used as an opportunity for bringing light to what 
is already there, exposing to the community 
what underlying potential it has. 

Participatory design methodology was used to 
gain a full hands-on and real-world understanding 
of the context for the design response to be 
firmly contextualized. This method was largely 
interrupted in 2020 and called for much 
adaptation to the ‘conventional’ participatory 
methods due to the COVID-19 worldwide 
pandemic. This resulted in predominantly online 
communication and workshopping as South 
Africa was placed on a nation-wide lockdown. 
Please refer to Volume One of this dissertation 
for further explanation of the methodology and 
responsive adaptations. 

Analysing the built form of each music school, it 
was found that the architecture was hindering 
the exposure of talent to the community, 
as well as the qualitative output of music-
making in both practicing and performing. For 
example, classrooms that have been designed 
and built on a minimum budget have been 
converted into the music room. However, 
lack of natural daylighting, ventilation and 
acoustic consideration immensely affects the 
quality of learning and actual sound output. 

Generally, the spaces are small, unsafe, with 
limited resources and have very little storage 
for instruments as well. The lack of architectural 
consideration impacted the learners’ abilities 
to learn and simultaneously the teachers’ 
abilities to teach. From a more psychological 
and emotional point of view, as well as being 
thoroughly discussed in the literature, a stigma 
revolving around ‘music kids’ was uncovered 
through personal interviews with school 
learners (Fig. 05). This includes bullying, lack of 
confidence, social anxiety and pressure from 
parents to rather focus on ‘real’ academic 
subjects that would create a path for learners to 
have a stable future career. Once again, these 
issues provided a positive opportunity instead 
for music to be used as a platform to develop 
an identity, social acceptance and to explore 
future impacts of music through a career-
oriented lens (Campbell et. al 2007, Firth 1987, 
Hudak 1999).
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Fig. 06
Global, Local & 
Architectural Issue
(Author 2020)

Informed by literature, case studies and previous theses done within the 
same context of Mamelodi East, the initial design response of a single, all-
encompassing, large scale music school and performance venue shifted 
concerning the existing anchor institutions obviously in need of connection 
and belonging within a larger music network. As many networking theorists 
have explored, grouping together individual elements to make up larger 
entities results in far greater successes than those of the individual parts 
(Augustyn 2018, Castells 2011, Kozikoglu & Cebi 2015, Sahyouni 2014). The 
designing of a network for inevitable change and development over time 
can enhance the eventual intervention’s overall design of this proposal. This 
responds well to the inherent dynamic form of a network (Kozikoglu & Cebi 
2015). Not only networking through communication and organizations, but the 
relationship between networking and architecture is also a natural response 
as architecture ultimately relies on the design of configurations, relations of 
forms and elements with one another and interrelated spatial units (Do & 
Gross 2001). 

Concluding the findings, the issues were summarized into the following (Fig. 
06): globally, there is a stigma and underappreciation of the inclusion of music 
in a child’s life, where the focus is usually on science and mathematics to 
provide the opportunity for a successful career. Locally, in Mamelodi East, 
there is a disconnection between the existing music schools themselves as 
well as with the surrounding community. The architectural issue present is the 
lack of resources and design considerations within these identified schools. 
These range from privacy to acoustics, ventilation to lighting, spatial layout, 
access and building identity. 

Aims and objectives
The project critiques the existing school 
typologies in Mamelodi East in terms of inclusive 
and alternative education by providing an 
example through the efforts of music-making 
and performance. Connecting schools with 
the surrounding community through a music 
network provides an international opportunity 
for collaboration and support with UNESCO’s 
Creative Cities of Music (Wall 2020). This creates 
an incentive for solidifying Mamelodi East’s 
identity through the expression of her musical 
heritage roots and a desire to maintain and 
uplift the community. 

Main Research Question
How can the decentralization of music-making 
provide a platform for positive self-expression 
for school learners, enhancing the collective 
community identity of Mamelodi East?

Secondary Research Questions
- How can the intersection of music and 

architecture fundamentally uplift the 
educational ecosystem?

- How can architecture assist the 
interrelation between music and 
education institutions with the surrounding 
community for overall empowerment?

- How can collaboration with the end 
user provide a platform for community 
development and intervention success 
overtime? 

Fig. 07: Photograph of site model of proposed 
design (Author 2020)
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(Top) Fig. 08: Transect Walk Through Mamelodi (Hendrikse 2020)
(Middle) Fig. 09: Participatory Research (Herbst 2020)
(Bottom) Fig. 10: UkuDoba Investigation (Author 2020)

Methodology
This research uses an interpretivist paradigm, collecting qualitative data 
sets. Interpretivism provides the opportunity for representation of real-world 
user views and perspectives, dealing with contextualized and local issues. 
Qualitative data sets collected contribute to the existing social ideas that 
help explain certain human events and pattern behaviours (Merriam 2009, 
Yin 2011). The data is analysed using Robert Yin’s (2011) qualitative data 
analysis methodology through a process of iterative stages to identify 
trends or contradictions that add to the value and credibility of the 
research (Yin 2011).

The following methods have been used to develop a contextually, socially 
and culturally relevant framework and design response.

• Personal investigation: The researcher undertook multiple transect 
walks (Hamdi 2010) through the community of Mamelodi East, 
observing and talking to different passers-by each time throughout 
2019 and 2020. This method set certain individual foundations and 
provided the researcher with the basic contextual lens for the 
project. 

• Participatory Research: This process actively engages with users of 
the context in the field through interviews and observations about 
Mamelodi East, with a focus on music, education and collective 
identity. This was largely done using the UkuDoba Method, 
developed through collaboration by the researcher with other like-
minded students & professors. The UkuDoba Method is outlined in 
Volume One of this dissertation. 

• Desktop Research: This research was done to provide a comparison 
for the data collected in the field. This not only includes literature, 
but quantitative and qualitative data about the specific context 
and surrounding area. 

• Co-design Workshops: As a part of participation, co-design 
workshops were done to remain relevant throughout the design 
process, removing the limitations of single authorship and 
collaborating with users and professionals across dimensions (e.g. 
programme, acoustics, social inclusion, etc.) to ensure well-rounded 
and pertinent design considerations. 

Fig. 11: Participatory Research in Mamelodi (Author 2020)

Limitations
This research-led design project is intended 
to be implemented in three stages, following 
Nabeel Hamdi’s (2010:67) concept of “now, 
soon, later”. This is done to allow small changes 
in dealing with specific issues over time. The 
now and soon stage of this project is small 
scale implementations that can be put into 
effect by the direct community members and 
stakeholders. These are seen as precedents 
for enablement and empowerment and used 
as evidence of its success when asking for 
funding and resources for the implementation 
of the later stage. The later stage is a much 
larger, more complex scale that would only 
be implemented once the need arises. It 
requires council approval and funding from 
stakeholders or outside donors. The design 
focus for this dissertation will be on this later 
stage implemented at Tsako Thabo Secondary 
School. It is important to note that the design is 
not a music school, but an inclusive celebration 
of identity, expression and performance across 
many aspects of a growing child’s life, from 
music, academics and sport, to nutrition and 
everyday life.
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Fig. 12: Desktop research during the STINT workshop (Original photo Naidoo 2020, edited by Author 2020)
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02_INFORMANTS I: THE NETWORKED NARRATIVE

Introduction
This chapter provides the background context for the dissertation. It is written 
through the personal development of the topic, summarizing each layer of 
the overall foundation from both a macro and micro scale. Ultimately, this 
chapter leads to the problem statement that addresses the research question. 

Background
The narrative begins before this 2020 year of the dissertation. In 2017, the 
collaborative effort between Rutgers University-Newark and the University 
of Pretoria was awarded an official title for their multiple anchor institution 
strategies that had been implemented over the years since 2008 (Ogude 
2019). These strategies shared common upliftment goals for disadvantaged 
communities like Newark (USA) and Mamelodi (South Africa). This initiative 
is called the Community of Learning Collaborative. A major member of the 
Mamelodi Community of Learning Collaborative is Mr. Clement Gama, the 
principal of the severely underprivileged secondary school, Tsako Thabo 
(Honours 2019). The principal joined the collaboration to help make a 
change in his community and find ways to uplift the lives of his learners. In 
2019, the Honours group of the Unit for Urban Citizenship studio qualitatively 
mapped and uncovered some significant themes in detail within Tsako Thabo 
Secondary School and its surroundings in Mamelodi East. One of these themes 
was music in education. Fig. 13: Narrative timeline (Author 2020)
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Music in Mamelodi: A History
Mamelodi itself has a long-standing history of 
music, specifically the jazz culture of the older 
generations (SA History 2019). Well known jazz 
artists, like Philip Tabane, were born and raised 
in this culturally rich community. In fact, music 
is ingrained in Mamelodi. The very name of the 
township translates to ‘Mother of Melodies’, 
stemming from two different cultural stories: 
colonialist and local (Iwan 2016, Roue 2017, 
Sosibo 2018, Interview with Alfred Lithuli 2019).

Colonialist Mamelodi: ‘Mamelodi’, a name 
given to the then current white president of 
South Africa, Paul Kruger, by the local residents 
of Vlakfontein farm. He was given this name as 
he had an innate ability to imitate and whistle a 
wide variety of bird sounds. 

Local Mamelodi: during the apartheid years, 
there was much oppression from the white 
government, causing black citizens to be fearful 
for their lives. The people living on Vlakfontein 
farm (nowadays Mamelodi) fled to the caves 
hidden in the Magaliesberg mountain range, 
surrounding the farm. As a signal for when the 
police were coming, the community members 
would make sounds with traditional instruments 
as a warning for their fellow citizens. The 
melodies created were what inspired the name 
‘Mamelodi’.

Fig. 14: View of Mamelodi East from the 
Mothong Heritage Site (Author 2020)

2019 Findings
Through engaging transect walks and fascinating conversations with some 
of the local citizens in Mamelodi East in 2019, it was uncovered that some 
musical activities occurred in the community. Please see figures 26 and 
27 in Volume One for the existing cultural aspects mapped in 2019. This 
ranged from live performances in taverns to church choirs to the largest 
annual jazz tribute concert at Moretele Park that everyone in Mamelodi 
and beyond looks forward to.

Within the school itself, there existed an after-school choir that met up to 
practise once a week. This was led by the art teacher at the time. When 
interviewing some of the learners that participated in the choir practices, it 
was found that there was a lot of stigma and bullying around the activity. 
This predominantly occurred from those who were not a part of the choir 
and ultimately caused the choristers to feel embarrassed or too shy to 
perform or sing elsewhere outside the comfort of the group choir. 

This, however, did not apply to one specific learner with a passion for 
sharing his musical abilities (Fig. 15). Thula* was first introduced to music-
making when he snuck into the worship team practice at his local church. 
The lead guitarist and singer spotted him and introduced him to the 
musical world. The worship leader taught him to play the guitar in his own 
free time, then the drums and the beginning of keys. From there, Thula 
took his guitar to school with him and practised passionately during lunch 
breaks. Other students came to watch, and he offered them lessons free 
of charge. The art teacher (and choir conductor) noticed his passion and 
ability and offered to teach him how to read and write sheet music. Thula 
started writing his own songs and taught these to his fellow school learners 
as well. His dreams were of starting his own school band, then moving on 
to studying music at university and learning all the instruments available to 
him. Thula sub-consciously became a network actor. 

The formal and informal musical activities in and around Tsako Thabo 
Secondary School and the community are seemingly disconnected 
(Author 2019), but they open up the opportunity for a potential relationship 
through music, with Tsako Thabo being the anchor institution. 

This theme connected well with the Educational Ecosystem topic, 
unpacked fully in Volume One of this dissertation, for the project as music is a 
valuable addition to a child’s life, both academically and psychologically. 
It is a positive outlet for expression and helps create a sense of belonging, 
adding confidence in a child’s identity (Eisner 2002, Campbell et. al 2007, 
Hodges and O’Connell 2013, Roue 2017).

Network Actor: as a part of the Actor Network Theory (ANT), 
an individual becomes an actant when they share an 
action with others, creating an interrelation between lives 
through shifting networks of relationships (Bencherki 2017).

Local worship team

Thula*

Fig. 15: Thula’s Story (Author 2020)

*Name changed for anonymity



7372

2020 Findings
In 2020, further mapping and exploration of 
Tsako Thabo Secondary School and surrounding 
Mamelodi were conducted as a test for the 
UkuDoba Method (see Dissertation: Volume 
One). This resulted in the uncovering of a much 
larger yet still individualized musical community 
than was initially found (Fig. 16). Within the 
community there are formalized music schools 
within a 4km travel distance from the initially 
investigated school, Tsako Thabo; one being a 
mere 800m down the road. An important and 
highly influential piece of information uncovered 
through interviews and engagement with these 
music schools is that each music school, along 
with many aspiring musicians in Mamelodi, do 
not know about each other. There is a complete 
sense of isolation, yet a great opportunity for 
networking through engagement. 

Within Tsako Thabo, musical opportunities 
seemed to have changed over the last year of 
investigation. The choir was disbanded in June 
2019 due to the performance season having 
come to an end. In February 2020, however, 
a community member from the Peaceful Boys 
Choir approached Tsako Thabo and offered 
his free services to start a choir from scratch 
(Interview with Jacob 2020). This only cements 
how flexible and adaptable townships like 
Mamelodi are: constantly changing, growing 
and shifting in relationships.

Fig. 16: Music identified in Mamelodi (Author 2020) Fig. 17: 2020 Tsako Thabo School Choir led by Jacob (Author 2020)
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Developing a Music Network
From the foreshadowing of Thula’s mini music 
network within his school, the solid and active 
nodes of the establishment of the music schools 
in the community and the already existing 
historical and cultural homage for music in 
Mamelodi, the initial concept of design needed 
to be adapted. An all-inclusive, multi-functional 
and expensive music centre on the site of 
Tsako Thabo would no longer be effective for 
connecting the school with the surrounding 
community and uplifting the school as a whole. 
The opportunity presented was far richer. 

According to Awan et. al (2011), networking, 
and especially when using networking as a 
social innovator, exposes the limitations of 
the existing individual participant’s power. 
However, linking them and merging common 
interests and goals results in a “substantial force 
that can fundamentally alter the direction of an 
event” (Awan et. al 2011:77). In Mamelodi, it was 
only a matter of uncovering what was existing 
and already working to expose the underlying 
potential to the community. 

Initially, the design intention for this project 
was a single elaborate building with a typical 
focus on the visual and temporal (Awan et. al 
2011), however, after the participatory research 
findings, it was adapted to a complex and 
contextually rich architectural network with 
music as its focus. Spanning across sites, scales 
and programmes, the proposed Mamelodi 
Music Network is designed and maintained by 
the connected community members to result in 
a more successful intervention due to a sense of 
ownership (Ehn 1993, Sanoff 2011). The network’s 
entirety will be examined for the remainder of 
this dissertation, scaling into individual nodes 
and their connections with one another.

Problem Statement
Within the disadvantaged community of 
Mamelodi East, there is a wide variety of 
potential for upliftment and formation of 
collective community identity. The potential 
focused on this research is that of music. The 
existing extra-curricular music elements in the 
community are small and isolated from both 
one another and the surrounding community 
but are in controlled and supportive settings. 
The perception of musical experiences by most 
of the community is generalised to music being 
a vehicle for negative influences on the psyche 
of young developing school learners (Honours 
2019). The music referred to here is that of parties, 
large events in the park, and the brawly life of 
music associated with alcohol consumption at 
the local shebeens and clubs. These experiences 
are closely related to substance abuse, 
crime and negative role models for children 
(Honours 2019). Exposing and emphasizing the 
positive music anchor institutions creates an 
opportunity for a better understanding of the 
positive aspects of the musical culture such as 
connection, collaboration and upliftment, a 
platform for positive self-expression. 

Fig. 18: Network peg board developed as the 
Touchstone for Milestone 1 in March intended 
to be used as an interactive way of showing 
the development and change of the proposed 
Music Network overtime (Author 2020)
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PHySICAL CONTExT

2019: Introduction to UUC
In 2019, the researcher was exposed to the Unit 
for Urban Citizenship (UUC) through the chosen 
studio project, Community Action Planning, 
running from 8 February to 3 April 2019 and led 
by Dr. Carin Combrinck. This led to working within 
the community of Mamelodi East, Pretoria, and 
the Tsako Thabo Secondary School. For more 
information about the background of the UUC 
and the type of work done through the unit, 
please refer to Volume One of this dissertation.

2019: Mapping in Mamelodi
After an introduction to Tsako Thabo and 
other schools in Mamelodi East during the 
researchers’ first immersion walk on 14 February 
2019, the cultural aspects sparked an interest. 
This resonated with the researcher who is a 
musician as well. Starting with desktop research, 
specifically focusing on the cultural aspects 
of Mamelodi, in general, it was found that 
Mamelodi had a rich musical heritage as well 
as some dance groups. However, there was not 
a significant amount of information provided 
through this initial desktop research. 

From the following transect walk on 19 February 
2019, this time experienced through a more 
focused musical lens, the researcher uncovered 
far more cultural aspects within Mamelodi 
than what was available through the desktop 
research. From annual jazz concerts in Moretele 
Park to the local shebeen to community 
member’s interests (or lack thereof) in learning 
and listening to music. There was a niche to be 
unpacked. 

2019: Tsako Thabo Mapping
Working back within Tsako Thabo Secondary 
School in Mamelodi East, the researcher 
yearned to uncover more about the existing 
music and culture beyond the surface. On 21 
February 2019, the group of Honours students 
spread out into the classrooms, courtyards 
and offices within the school, uncovering and 
diving deeper into their explorations of their 
chosen themes. From the cultural aspect, it 
was found that the high school learners loved 
the idea of entertainment far more than 
standard education. Teachers, such as Mr. 
Alfred Lithuli, tried to incorporate this into lessons 
to better engage the learners. Learners would 
experience Life Orientation lessons and History 
through dance, rhythmic clapping and song, 
all done in a group. Much to the researcher’s 
delight, there was an existing school choir. This 
was led by the art teacher at the time in after 
school sessions. Most choir members of the 
school that the researcher engaged with said 
they did enjoy singing in the choir, but not as 
much as they wanted to. This was due to the 
apparent lack of inspiration from the teacher 
and bullying from other learners who were not 
a part of the choir. Most students, unclear of 
their involvement with the choir, described how 
they love music, specifically the Deep House 
type, but mostly listened to it using their phone 
applications. 

After studio sessions, additional theoretical 
research and reflection, another visit was paid 
to Tsako Thabo Secondary School. This visit, in 
hindsight, would turn out to be the inspiration 
for this mini dissertation. On 5 March 2019, the 
Honours group once again worked within 
the school. Each researcher had identified 

their necessary theme and narrowed it down 
immensely. The cultural theme focused 
specifically on the musical activities within the 
school and its connection to similar musical 
activities in the surrounding area. It was found 
that learners who participated in the school 
choir also had experience with singing in 
their respective gospel choirs. There was also 
mention of choir competitions with other schools 
that happen at the end of the choir season. 
The researcher then met a young boy named 
Thula*. His story inspired those around him and 
the musical culture within the school, ultimately 
grounding the concept for a musical network, 
using the school as an anchor institution. This 
would later be expanded on by the researcher 
in the further exploration of the Mother of 
Melodies community in 2020. 

As a summary from the initial community 
mapping of Tsako Thabo Secondary School 
and surrounding Mamelodi East, it was clear 
that there was once a rich culture of music, but 
this was no longer as celebrated and open as it 
was in the past. 

2019: Participatory Design Workshops 
(PDW)
Following the research done in the first studio 
group, the researcher continued the project 
into the second studio of the UUC: Co-design. 
This studio was run from 8 April to 30 May 2019, 
led again by Dr. Carin Combrinck. This studio 
intended to work even closer with selected 
participants to co-design aspects or the entirety 
of Tsako Thabo school through the chosen 
theme. This studio focused a lot more on the 
process of participation than the outcome of 
the design. 

Each workshop was designed and organized 
by the researcher before it was implemented at 
the school. Necessary equipment, materials and 
ethics were all organized beforehand to ensure 
a smooth running on site. As Pirjo Friedrich (2013) 
stated, face-to-face sessions are fantastic in 
building relationships with participants, but 
limited due to time and place. In Tsako Thabo, 
the researchers could only work during the lunch 
break so as not to disrupt the learners’ education. 
This posed its own challenges as there were 
constantly many on-lookers laughing or jeering 
or wanting to participate as well, resulting in 
the session becoming quite rowdy and often 
overwhelming for the individual researcher. 

Before designing the workshops, it is necessary 
to identify what the expected outcome is 
(Simonsen & Robertson 2013). This can be 
influenced by similar precedents or theoretical 
research as well as being influenced by 
previous engagements with the participants, 
but ultimately assists in the qualitative analysis 
thereafter (Yin 2011). 

Fig. 19: Participatory Action Research in Tsako Thabo 2019 (vd Hoven 2019)
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Workshop 1: Acoustics
This workshop was designed to help the participants understand the 
idea of acoustics, volume and materiality within a space. Long term, the 
participants would remember these considerations when co-designing 
music spaces within their school. Certain spaces were selected by 
the researchers that were vastly different from one another in terms of 
materiality, openings, pedestrian traffic and overall volume (Konstantinou 
& van der Hoven 2019). These included a classroom, outdoor courtyard, 
school hall, under the trees and in a narrow corridor. The participants were 
then asked to sing the same song they all knew in each different space 
and reflect on how the space impacts their sound. Additionally, glass jars 
and wooden chopsticks were handed to some students for improvised 
music-making, which also inspired dancing, clapping and stomping in 
certain spaces.

We started in the school hall, however there were many other 
children there making a lot of noise and resulting in the students 
being very shy and concerned about being laughed at. After 
much persuasion, we moved on to the computer classroom 
which was empty except for furniture. The students ensured the 
door was kept closed but were happy to sing and even enjoyed it. 
One boy started drumming on a chair and that inspired us to pass 
around the glass jars and chopsticks. The group fell into a joyous 
rhythm and made music and song together. Moving outside to the 
courtyard, once again the participants were unhappy to express 
themselves in front of other students’ prying eyes. So instead we 
moved around the front of the school, to a quiet grassy patch 
under a tree. The music process was repeated. In reflection, the 
students decided this space was the best one as the air was fresh, 
the space was free, there was shade and no one else could see 
or hear them. The final space we moved to was within a narrow 
corridor between two classrooms. This space was covered by 
exposed corrugated roof sheeting and had a decent amount of 
staff traffic. Once again, the students were uncomfortable and 
pushed themselves up against the walls on either side. Reflecting 
on this session, the students described their sound as if they were 
singing inside the glass jars they were holding. 

(Personal notes made by the researcher 26 April 2019)

Friday
26 April 2019

Tsako Thabo 
Secondary School

AM
11h30-12h30 ± 12 participants

Acoustics, volume & materiality

ART CLASSROOM

Large open space
Other students -- noisy &  
embarrassing 
Singing: stood in a very tight 
circle so others could not 
hear or see what they were 
doing.

COMPUTER CLASSROOM

Smaller space, quieter
Door closed muted noise 
from courtyard
More furniture, curtains,  
painted walls, lower ceiling 

OUTSIDE - UNDER THE TREE

Away from other students
Open space, fresh air, quiet, 
shade
Participants sang louder and 
started dancing

CORRIDOR SPACE

Small space, open on either 
side with tall tin roof.
Uncomfortable - watchers
Sang softer and more   
reserved.
“Like singing in the glass jar”

IMPACT ON THE FOLLOWING WORKSHOP:
Initially the next workshop was going to analyse light. 
However, it was important for the researcher and 
participants to continue the impacts of space on 
acoustics and performance. These two conclusion 
were drawn: 
• Space impacts the performance
• Participants impact the space

(Top) Fig. 20: Images taken during Participatory 
Research Workshop 1 (Author 2019).
(Bottom) Fig. 21: Sketch diagrams made on site 
to note how the participants used the space 
(Author 2019).

PDW 1
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Monday
29 April 2019

Tsako Thabo 
Secondary School

AM
11h30-12h00 11 participants

Spatial layout, tangible/intangible space

PDW 2 Workshop 2: Role Play
Workshop Two was initially planned to experiment with natural lighting in 
different spaces. However, the researcher identified that the participants 
understood the concept of needing light and open space to make music 
successfully during the first workshop. Therefore, the workshop design 
was reconsidered before the second session. The aim of Workshop Two 
was to test the boundaries of intangible space. This was used to identify 
how spatially analytical the participants would be for the co-design 
session in the following weeks. The workshop was created to be a role-
play of specifically designed scenarios. Two different scenarios were 
set up, one with a tangible object around which space is focused, and 
the other in which no spatial aspects are attached to the object. Each 
participant drew characters from a hat, keeping their identity a secret 
from the onlookers and other actors within their group. Each character 
had a description of the action they were doing. No voices or sounds 
were allowed, encouraging participants to rather use their bodies and 
the space around them to express their specific character. Slowly, one 
by one each character was introduced to the scene, joining the previous 
actor “on stage”, working up to a full charades performance. The tangible 
object used was a large cardboard box. 

Scenario 1: A family watching TV, while a robber breaks 
into the house. 
The box represented the TV in this scenario and was 
introduced in the beginning of the scene. Each character 
was a different family member with different roles (e.g. 
doing homework, cleaning the house, watching the TV 
and a cat wanting to be fed). Each character tried to 
communicate with one another but ultimately ended 
up congregating around the “TV”. When the robber 
character was introduced, she could clearly identify the 
boundaries of the house through the way the previous 
characters had moved around. The whole group 
initiated small movements and stayed within a certain 
imaginary box within the overall space.

Scenario 2: A furniture shop, a villain with a bomb, a police 
officer and a superhero. 
The box represented the bomb and was only introduced 
to the scene when the villain brought it in later. It’s valuable 
to note that only the villain character knew what the box 
represented. The customer of the furniture shop defined 
the initial space by moving around and “trying out” all the 
furniture. The villain used that space and hid the “bomb” 
under a chair, then proceeded to act normal in the shop. 
The police officer tried to get the customers out of the 
shop, not knowing that one of them was the villain. The 
villain thought she was being arrested, so much chaos 
happened. Lastly, the superhero ran into the space, and 
in true hero fashion, identified the “bomb” and catapulted 
it across the entire room, breaking all intangible spatial 
boundaries. 

(Personal notes made by the researcher 29 April 2019)

SCENARIO ONE SCENARIO TWO

(Top) Fig. 22: Images taken during workshop (Author 2019)
(Middle) Fig. 23: Character profiles with brief description (Author 2019)
(Bottom) Fig. 24: Sketch diagram showing usage of space (Author 2019)
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Tuesday
30 April 2019

Tsako Thabo 
Secondary School

AM
11h30-12h30 ± 13 participants

Important qualities of a music space

PDW 3 Workshop 3: Group Sketch
The expectation for this workshop was to start co-designing on paper the 
ideas for a space specific for music-making. The concepts sketched could 
be as dream-like or outrageous as needed. To inspire the participant beyond 
simply four walls, the researcher displayed images of some precedents. 
The first being the acoustically successful Danish Music Museum by Adept 
Architects (2001) and the second being the slightly less successful local 
renovation of the Afrikaanse Hoër Seunskool Kunste Kampus (Afrikaans 
High Boys School Art Campus) done by Matthews and Associates (2015). 
This purpose was to inspire thinking amongst participants regarding what 
type of spaces are good for music and which are not. 

I worked with a much larger group this time (more than 
13 children), some who had been in all the previous 
workshops, others were new. We moved tables 
outside under the trees to a quiet place to work. We 
first discussed music spaces and related it back to the 
previous workshops. I then showed them pictures of the 
two precedents and asked for some feedback. They 
simply agreed with my description instead of providing 
their own ideas (I do not think they were very interested). 
I passed around A5 sheets of paper and ten pencils and 
explained the task. Some had to share pencils and desks, 
others leaned on their friends’ backs for a harder surface 
to draw on. Looking at the data received (sketches and 
explanations) less than half of the group understood 
the task properly, sketching their dream music spaces. 
Others simply drew what they knew (a room with four 
walls, windows and some chairs). 

(Personal notes made by the researcher 30 April 2019)

INDOORS OUTDOORS
Seating Minimum: one for 

teacher and one for 
student.

Singular (student 
seating only).

Ventilation Windows and fans: 
need for fresh air/
circulation (anticipates 
heat)

Under the trees for 
fresh air and a breeze 
(circulation).

Lighting Some artificial 
(fluorescent as in 
existing classrooms).

Natural lighting.

Space Simple box classroom. Space to self; open.
Levels Performance spaces 

stepped up (stairs – 
similar resemblance to 
existing stage in school 
hall). 

None.

Interaction 
with others

Some, but not much 
(a few spaces for 
audience members).

None (alone).

Table 1: qualitative organization of different elements shown 
within the collective group of drawings.

Analysing the drawings done by the high-school participants, there is a clear understanding 
of the spaces in terms of what each participant has experienced in their real-world life. This is 
analysed through the confidence of the lines drawn (Morra 2008). In some cases, the entire 
drawing is done with solid, confident lines. In others, most of the space depicted is confident, 
but when it comes to the instruments and the spaces directly around them, i.e. how the 
participant interprets the space to be used by the musician, the lines become shaky and 
faint, suggesting discomfort and unsure depictions of the space. 

(First column) Fig. 25: Photographs taken on site during the sketching workshop (Author 2019)
(Second & third column) Fig. 26: Original sketches done by the participants (Author 2019)
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Monday
13 May 2019

Tsako Thabo 
Secondary School

AM
11h30-12h30 ± 10 participants

Programme layout and hierarchy

PDW 4 Workshop 4: Group Model 
This workshop aimed at defining hierarchy within the school using the 
existing school programs and arrangement. The workshop was set out 
using moveable massing pieces of each existing space in the school (e.g. 
hall, classrooms, bathrooms, staff area, etc.) that were accurately scaled, 
and colour coded according to programme. The model pieces were 
laid out on the aerial view of the school printed on a flat base. Additional 
massing pieces were cut out, intended for new programmes or a variety 
of sizes for adaptation to the existing. 

Once again, I worked with about ten children. They 
were quiet and ready to work at the beginning of the 
session but got rowdier as the workshop went on. The 
participants enjoyed the massing model workshop 
and passionately deliberated amongst each other. 
There was a slight language barrier when deliberations 
occurred so I could not understand all their reasoning 
throughout. Some concerns that the children brought 
up in reflection were: noise between classrooms, smell 
from the bathrooms, big play area that can also be used 
for outdoor performances, hall at complete opposite 
end of the school (away from the road), double storey 
classrooms with ramps all grouped together and not 
separated, music spaces away from other classrooms 
and courtyards.

(Personal notes made by the researcher 13 May 2019)

PERFORMANCE

PRACTICE

EDUCATION

HIERARCHy SKETCH PROGRAMME SKETCH

(Top) Fig. 27: Sketch diagrams showing findings & analysis from workshop 4 (Author 2019)
(Bottom) Fig. 28: Photographs during the model building workshop (Author 2019)
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2019: Participatory Workshops 
Reflection
As an overall reflection on the workshops 
completed at Tsako Thabo Secondary School, 
it was found that most of the children who 
were involved with the arts, in one form or the 
other, understood certain spatial requirements 
for such activities. This assisted with their own 
reflection and provided a basis to follow when 
analysing the spaces within the existing school 
environment. This included aspects such as 
lighting, natural ventilation, materiality, volume, 
spatial layout, etc. The same participants who 
were involved with music or other cultural 
activities were also far more creative when 
using a space for different activities than its 
programme or designing their dream space. It 
was found they could think beyond the known 
and apply their own imagination in logical 
ways. Compared to the students who were not 
exposed to any form of cultural activity, they 
simply depicted what they see in their everyday 
surroundings with little to no input or critique of 
their own.

In terms of spatial hierarchy of the school and 
through the numerous conversations with the 
participants throughout the studio, the school 
hall was at the centre of the debate. It was 
seen as the most important aspect by both 
the participants with musical background and 
those without, however failing as an option in its 
current state and location. 

Summary of Participatory Findings
Through the 2019 participatory workshops, a few similarities were 
found, specifically when it came to design consideration. The 
participants had a great understanding of acoustic concerns, 
not the way spaces should be designed but more in terms of 
placement and sound as a disturbance to other programmes on 
the site. This led to the repetitive design of separating music spaces 
from classrooms, as well as moving the hall to the end of the site. 
The hall layout was also in response to hierarchical ideas as well 
as the journey of moving through the school to get to the main 
hall. Similarly, performance spaces were elevated above other 
programmes in terms of hierarchy. This ran as a common idea 
throughout all the workshops; however, the minor music spaces fell 
to the lower end of the food chain. This was due to the participants 
being immensely concerned about onlookers and bullying during 
practice sessions. Comparing this concern with the topic of 
music as a positive platform for expression, the contradiction is 
plain. Perhaps this is due to the current way music is perceived 
in the school, reflecting only on what the participants know and 
understand in their real-world, rather than what possibilities they 
could imagine. 

There was also a very intriguing result regarding spatial and social 
gatherings around tangible or intangible objects. This relays back 
to the idea of formal and informal activities, specifically with regard 
to engagement and music-making. Spaces can be appropriated 
irrelevant to their pre-existing function or quality, providing the 
opportunity for heightened use of imagination, as is typical of 
children. This was also complemented by the creative use of 
objects and spatial qualities as ways of making rhythmic sounds. 
In hindsight, this creativity was very evident through the work and 
comments produced by students that were involved in the arts, 
whether it be dance, choir or music-making when compared to 
those who weren’t. This encourages the positive influence of STEAM 
(Science Technology Engineering Arts Mathematics) education 
versus the slightly more limited STEM (Science Technology 
Engineering Mathematics) education. As unpacked thoroughly in 
Volume One of this dissertation, the advantage of STEAM education 
allows for learners to be critical and analytical, while recognizing 
the personal, social and cultural potentials of what they are doing 
(Pienaar 2017). This topic of STEAM education is taken further into 
the design of this project. 

Fig. 29: Honours co-design concept sketch (Author 2019) Fig. 30: Visual representation of participatory workshop findings (Author 2019)
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2020: Mapping in Mamelodi
The researcher continued in Mamelodi East in 
January of 2020. This was done as a part of the 
NRF/ STINT research project: Stitching the City, 
a collaborative effort between the Chalmers 
University of Technology in Gothenburg, 
Sweden, and the University of Pretoria, South 
Africa. The project was implemented in the 
field, using the developed UkuDoba Method 
to collect qualitative data samples that can 
be used to explain the emerging trends and 
patterns within the context of Mamelodi East. 
More about this project has been detailed in 
Volume One of this dissertation. 

This research continued with the UUC Honours 
Studio of 2020, formulating interviews and 
transect walks to find information about the 
musical culture in the community that could 
be added to or compared to the information 
uncovered in 2019. The research was done both 
in the surrounding community and within Tsako 
Thabo Secondary School. It was confirmed that 
the culture of music was still largely disconnected 
within the community and the school. Members 
of the community that engaged in conversation 
with the researchers expressed their love and 
appreciation for music (whether it be different 
genres, music-making or mere appreciation) 
and thought it a very useful aspect of a child’s 
academic and psychological development. 

An interesting finding through participatory 
research was that of the development of a music 
genre called AmaPiano. During a transect walk 
on the 20th of February 2020, the researcher, 
along with a group of UUC Honours students 
were attracted to a make-shift tuckshop just 
down the road from Tsako Thabo Secondary 
School. Here, a group of young adult boys 
were dancing and “vibing” (Interview with the 
tuckshop boys 2020) to a very loud, kwaito mixed 

Fig. 31: The Rise and Fall of Music Genre Popularity in Mamelodi (Author 2020)

with house music, with a slight jazz undertone, 
coming from a nearby speaker. This is known 
as AmaPiano. Originally developed in South 
African townships, this genre was quickly spread 
across the country, between townships and 
music fanatics through low quality music sharing 
phone applications and forums (Spotify 2019). 
As described by the tuckshop boys and others 
interviewed around the community and within 
Tsako Thabo School, AmaPiano is a culture of its 
own, one that takes its listeners to a memory of 
family, friends and a simple life. Young children 
in schools sometimes sit at break time or on the 
weekend with their phones developing a beat 
and writing lyrics to record. Music became both 
a place to escape to and one to inspire. 
 
Furthering the connections made in Mamelodi 
in 2020, the researcher connected more 
with the Mamelodi Community of Learning 
Collaborative (MCLC) in an effort to situate the 
research in a real-world context with the hope 
of making a lasting impact. This led to a domino 
effect of discovering musical nodes within the 
community and the founding of the Music 
Network. 

(Top & middle) Fig 32: Images taken of the 
mapping and analysis done by the 2020 UUC 
Honours studio (Author 2020, Honours 2020)

(Bottom) Fig. 33: 2020 Honours studio analyzing 
data collected by 2019 Honours studio to 
determine patterns or discrepancies (Honours 
2020). 
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   Tsako Thabo

  Moretele Park

 Mamelodi Magnet

 CAFCA Jazz

Fig. 34: Discovering music nodes in Mamelodi 
(Author 2020)

DISCOVERING NODES
The accompanying map shows the location of 
each major musical node within the proposed 
Music Network. Additionally, both primary 
and secondary schools within the area have 
also been highlighted. This provides a visual 
representation of the possibilities of growth of the 
network through incorporation of surrounding 
schools. 
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Mamelodi Magnet School
A mere 800 metres down the road from Tsako 
Thabo Secondary School is a high school 
that provides music as formalized education. 
Mamelodi Secondary School (MSS) was chosen 
to be a part of the Magnet Schools initiative, 
developed by the Gauteng Department of 
Education (Pruneau 2005). The idea behind 
this initiative was to create an opportunity 
for learners across communities to learn a 
specialized skill as an extracurricular activity, 
also known as ‘feeder schools’ (GDE 2002). 
This was started to develop the talent of South 
Africa’s youth, “the country’s future generation 
of leaders” (GDE 2016/2017:28). MSS was 
specifically chosen to offer specialized music 
tuition in 2003 and the implementation was 
called Melodi ya Mamelodi, ‘Doing Hope 
Through Music’ (Pruneau 2005, Roue 2017). 

The Magnet School was started in 2004 but 
without any facilities. The teachers would teach 
their students in any open and quiet space, from 
outside under the trees to empty classrooms in 
the high school. A few years later, the head of 
department of the time connected with the 
Spanish Embassy and secured funding to build 
an official music school building on the site of 
MSS. Although a large improvement from the 
school classrooms, this music school building 
is only partially suitable for music-making 
(Interview with Jaco van Staden 2020). 

Jaco van Staden, the current HOD of Melodi ya 
Mamelodi Music Project, is a brass teacher from 
Afrikaanse Hoër Seunskool (AHS) in Hatfield, 
Pretoria. Along with his colleagues, Jaco travels 
to Mamelodi every school day to teach music. 
They were recruited as specialized teachers at 
the beginning of the Mamelodi Magnet School 
program. Due to van Staden’s involvement with 
AHS, there is a connection between the magnet 

school and the music department of AHS in 
Pretoria. Melodi ya Mamelodi was supplied with 
violins, clarinets, trumpets, harmonicas and an 
electric piano from the GDE, but other sponsors 
like the UNISA Music Foundation, Waterkloof 
House Prep School and Polliacks supplied the 
violins, cellos and recorders (Interview with Jaco 
van Staden 2020, Pruneau 2005). The learners 
from the Melodi ya Mamelodi Music Project 
participate in concerts, exams and festivals, 
held off-site. These are often at the ZK Matthews 
Hall, UNISA or the Tshwane Music Festival (Melodi 
ya Mamelodi Music Project 2019). Additionally, 
the Magnet School is used to link communities, 
bring children and adults together to make 
music and share knowledge with others. More 
advanced students from more privileged areas 

outside of Mamelodi East are recruited to assist 
with music teaching (Pruneau 2005). 

Since 2019, Melodi ya Mamelodi has hosted an 
open day in April for primary school learners. 
Communication is sent to the surrounding 
primary schools and around 120 students attend. 
The music learners of Melodi ya Mamelodi play 
demonstrations on their instruments for the 
primary school children. Some of these children 
come back with applications to learn at the 
music school and pursue their musical dreams. 
This open day is a fantastic opportunity for 
musical exposure for the surrounding community 
and those who have had no interaction with 
music at all. 

MAGNET

AHS

GDE

MSS

Fig. 36: The network of Melodi ya 
Mamelodi (Author 2020)

DISCOVERING NODES

CAFCA Jazz School
Through the connection of the MCLC with the 
UP Mamelodi Campus, the researcher was 
introduced to Jesse Mogale, an extremely 
talented musician proficient with many 
instruments and the director of CAFCA 
(Committed Artists for Cultural Advancement) 
jazz school. Started in 1999 as a way to uplift 
the recognition and careers of musicians in the 
community (Interview with Jesse Mogale 2020), 
this school provides a safe and supportive 
environment for children to explore their musical 
talent and express their own sense of creativity 
without the fear of judgement and pressure 
(Tesnir-Smith 2019). The children can choose 
their own instrument to play from the ones 
that are available and learn in groups. “Music 
is not a competition; it is about cooperation” 
(Interview with Jesse Mogale 2020). Jesse went 
on to express how music and social cohesion 
go together, allowing the expression of shared 
needs and concerns. Playing in a group allows 
students to learn from one another, emphasizing 
the support offered through reassurance that no 
one is better than the other, but has “only been 
playing longer” (Interview with Jesse Mogale 
2020). 

Partnership is seen as a vital element to 
CAFCA’s success. From the connection to the 
MCLC, Rutgers University in Newark often sends 
out teachers or visitors to the school. Other 
partnerships have resulted in CAFCA’s students 
getting the opportunity to perform elsewhere, 
even overseas (Tesnir-Smith 2019). Similarly, the 
connection with the University of Pretoria has 
provided CAFCA with a weekly practice space 
on the Mamelodi Campus. Although this space 
was not designed for music-making in terms of 

acoustics, lighting and storage, it was a large 
improvement from the dilapidated school 
classroom of Vukani Mawethu High School they 
were practising in. 

Although CAFCA is not formally a part of the 
Pre-University Academy at the UP Mamelodi 
Campus, just the music students’ exposure to 
the campus has inspired them to continue their 
studies further (Interview with Jesse Mogale 
2020, Tesnir-Smith 2020). Although the students 
started as musicians, their further studies 
often have nothing to do with music at all, for 
example, taking a business degree. Music was 
the gateway for opportunities that did not exist 
before.

MCLC

UP 
MAMELODI

CAFCA

RUTGERS
UNI.

Fig. 35: The network of CAFCA 
Jazz School (Author 2020)
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Summary
Comparing all of the identified nodes to one 
another, a common thread runs throughout. 
Through the act of music-making, the proposed 
aim for each node is to expose the community 
to the skill, celebrating Mamelodi’s heritage and 
providing opportunities for new generations 
to express themselves positively, as well as 
form connections and relationships through 
the language music, bringing the community 
together under one collective identity. 

Each musical node identified through the 
mapping in 2020 further emphasized the 
opportunity for networking and upliftment of 
the community through music. Each node has 
some sort of outside connection already for 
their success to grow and therefore provides 
the opportunity for this proposed collaboration 
within the local context of Mamelodi East. 
The additional schools identified increase the 
growth and reach of this networking opportunity 
for providing supporting platforms of positive 
expression for school children. Each musical 
node started with nothing, from an empty brick 
box to the shade of the trees. They proved that 
no matter the situation, music can and will be 
made if the people are together. Networking 
through these current nodes, and additionally 
with future nodes, could provide each node 
access to amenities, relationships and resources 
that they are each in need of to further their 
individual music-making agendas. This could 
alleviate their limitations and hindrances, 
simultaneously contributing to the success of 
the overall Music Network, the greater whole 
(Castells 2011). 

MAGNET

TSAKO 
THABO

CAFCA

AHS

MSS

BAL.

VIL.

SOM.

MCLC

UP

RUTG.

MORETELE
PARK

Fig. 38: Music Network diagram 
(Author 2020)

Moretele Park
To the north of Tsako Thabo and Mamelodi 
Secondary School lies Moretele Park, at the 
base of the Magaliesberg Mountain Range and 
adjacent to the Pienaarsrivier (Pienaar’s River). 
For most of the year, Moretele Park is used as 
a recreational resort that was opened in 1986 
(Tshwane Government n.d.), with overnight 
facilities with hot water and electricity, swimming 
pools, picnic and braai areas that can all be 
rented out for use by the community (Blokland 
2007). According to Blokland (2007), the facilities 
require an upgrade, especially the hall which is 
hardly ever used. 

The open field on the left of the site is where 
the majority of music festivals occur. Since the 
early 80s, there have been jazz festivals that 
attracted thousands of people (Gauteng 2018). 
These festivals were also a place for political 
rallies and a platform of expression for the equal 
rights movement of the Apartheid struggle. 
Internationally famous artists like Miriam Makeba 
and Hugh Masekela have performed to 
hundreds of thousands of people over the years 
(Blokland 2007). A typical temporary open-air 
stage and additional festival facilities are set 
up before each event and disassembled at the 
end.

Over the past decades, there has been an 
annual jazz festival called the Moretele Park 
Tribute Concert where local jazz artists perform. It 
is also a place for new up and coming musicians 
to make their debut. The tribute concert was 
first launched in 1998 at the Orlando Stadium in 
Soweto but has since moved to Moretele to pay 
homage to Mamelodi’s musical heritage (SA-V, 
n.d.). Here South Africa’s diversity is celebrated 
through music, bringing everyone together for a 
celebratory event. 

Another large music festival that is hosted 
at Moretele Park is Mamelodi Heritage Day, 
organized by the Mamelodi Tourism Association 
(MTA) (Ntuli 2019). This is only fitting as Moretele 
Park is a significant stop along the Mamelodi 
Heritage Route (Van der Waal 2000). Employees 
of the MTA express Mamelodi as “having a lot to 
offer… stories worth telling” (Ntuli 2019). MTA’s 
Abraham Mohale (Ntuli 2019) expressed the 
community of Mamelodi as having their own 
way of speaking, their own behavioural conduct 
and their own sounds of music. The culture and 
heritage are so rich in Mamelodi and deserve 
to be expressed as a form of collective identity, 
especially through its musical heritage. 

Additional Music Education
Through desktop studies, it was found that there 
were a handful of other schools, both primary 
and secondary, within the context of Mamelodi 
East that has music education as an after-
school activity. These predominantly serve the 
children within that specific school and similarly 
seem to have a lack of connection with the 
surrounding community. These schools do not 
have any music-making facilities but rather use 
open spaces or empty classrooms that are in 
the same dilapidated state as those at Tsako 
Thabo Secondary School.

Each musical node identified through the 
mapping in 2020 further emphasized this 
opportunity for networking and upliftment of 
the community through music. The additional 
schools identified increase the potential success 
and reach of this networking opportunity by 
providing supporting platforms of positive 
expression for school children. 

Fig. 37: Moretele Jazz Festival (Unknown 2015)
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THEORETICAL CONTExT

Networking
The concept of networking can exist in most, if 
not all, aspects of life. From computer design to 
sociology, neurology to a plumbing system: it is 
the way everything works. Even our own bodies 
and the entire world as we know it is made up of 
tiny atoms that are networked with one another. 
The term network has multiple definitions and 
theories, but the underlying principle is that 
there are small entities of individual value and 
function that are connected in an organized 
system, making up a larger entity of greater value 
as the whole (Castells 2011, Kozikoglu & Cebi 
2015, Lima 2011, Wigley 2007). According to The 
Gestalt Theory, each individual attribute can 
be put together in multiple configurations, with 
different functions, shapes and sizes, however, 
the whole of anything is greater than its parts 
(Augustyn 2018, Sahyouni 2014). The Gestalt 
Theory has a few principles that sit well with 
our mental well-being worthy of noting for this 
dissertation (Sahyouni 2014). The first being the 
Law of Similarity. Whether it is function, shape or 
materiality, our brains automatically group similar 
aspects together. This also works for the Law of 
Distance: aspects that are closer together are 
also grouped. The Law of Pragnanz relays that 
the overall reality of an event is reduced to its 
simplest form. Lastly, with regards to design, the 
Law of Order suggests symmetry and alignment 
are essential. These laws all form part of making 
sense of something when viewing it as a whole, 
rather than seeing its individual parts (Augustyn 
2018, Sahyouni 2014). 

Networking and Participation
Participatory design processes rely on 
connections and networking with various 
stakeholders, community members, professionals 
and more, all learning and designing together for 
upliftment and better user-suited technologies 
(Bødker et. al 2004). Each participant has 
a vital role to play which can inform many 
important decisions made together by the 
group (Simonsen & Robertson 2013). While each 
participant, or a smaller group of participants, 
have their own knowledge and skills, these 
are often limited (Awan et. al 2011). Choosing 
participatory processes automatically results 
in the acknowledgment of these limitations 
for a single author, the “incompleteness and 
limitation of the lone” (Awan et. al 2011:77). 
Joining such individuals, each with their 
own limitations makes up a more substantial 
force with minimal limitations as a group. 
Communication between participants and 
stakeholders is vital to participatory processes 
and embedded in networking, as Castell (2011) 
argues. It inspires synergy and limits the number 
of contradictions a varied group may face. 
The crucial and indispensable communication 
between all participants, whether they be 
designers or community members, is seen as the 
links between the actors within the participatory 
process (Erickson 1995, Friedrich 2013, Hamdi 
2010, Simonsen & Robertson 2013). Participatory 
design cannot be done without communicating 
and therefore is redundant without networking. 

Fig. 39: Theoretical breakdown (Author 2020)

Fig. 40: Network Diagram (Author 2020)

Fig. 41: Diagram depicting participants’ networks in community. (Author 2020)
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Networking and Music
In the music industry, one cannot succeed without 
networking. From teaming up with producers, 
writers, orchestras, media managers… the 
list goes on. Right down to a single individual 
wanting to learn the cello, they need to network 
with a teacher, who is part of an exam group 
who can help the learner qualify. As proved 
by the Melodi ya Mamelodi Music Project in 
Mamelodi, South Africa, music can be used as 
a platform to bring communities together and 
provide better future opportunities for children 
from an underprivileged background (Pruneau 
2005, Roue 2017). The Magnet School is actively 
successful in its networking; from connections 
to sponsors, music halls, exam groups, teachers 
and assistants, each entity adds to the greater 
project resulting in its overall success. 

Similarly, there are two additional examples/
precedents that have proved music can be 
used as a valuable networking platform, not only 
on the ground but online and internationally. 

The first being the Memphis Music Magnet Plan. 
This online project developed from a need to 
revitalize the community of Soulsville in Memphis, 
USA (Faber 2016, Shapiro 2017). It identifies 
derelict buildings within the area, reclaiming 
them for music and the arts through events, 
recording studios and music schools, ultimately 
providing a platform for advertising Soulsville 
as the place to be for musicians (Memphis 
Slim n.d.). The soul music heritage of Soulsville 
is vital for this network’s success as it provides 
a foundation to build on. Linking to the STAX 
Museum of American Soul Music, the buildings 
and implementations work in conjunction with 
the already existing community, exposing and 
celebrating the existing untapped potential 
(Faber 2016). This networking project relies on 
small scale creative-oriented implementations 
and projects as catalysts for uplifting the 
community as a whole (Hill 2014), ultimately 
growing and strengthening the identity of this 
music district. 

(Left) Fig. 42: Map showing connection within Soulsvile, USA (Author 2020)
(Above) Fig. 43: Sketch of Memphis Slim Collaboratory (Author 2020)

Fig. 44: Memphis Slim Collaboratory, before 
and after renovation by brg3s Architects (West 
2014)

The second international example is that of 
UNESCO’s Creative Cities. Once again, this is 
a major online network that connects physical 
places and cities across the world through shared 
interests and themes. One of these themes is 
music. The concept behind the network is to 
use the culture and creativity of certain cities as 
the driving force for sustainable development 
and urban regeneration through social 
cohesion and intercultural dialogue (UNESCO 
n.d.). This relates to Lorenzo Fioramonti’s (2017) 
concept of The Well-Being Economy: using the 
underlying existing potential of communities to 
enable growth and development as a whole. 
Each Creative City of Music has been identified 
due to its rich history embedded in music and 
music festivals, signifying the importance of 
music within that city. Each city is uplifted 

through the celebration and value of music 
and often encourages exchange schemes of 
learners or musicians with other Creative Cities 
of Music to share knowledge and learn about 
the creative world we live in (Interview with 
Sandra Wall June 2020, UNESCO n.d.). Sandra 
Wall is the project leader for the Creative City 
of Music, Norrköping, in Sweden. She connects 
different music organizations across the city 
with one another through the networking of 
events, institutions and other smaller project 
implementations (Interview with Sandra Wall 
June 2020). This allows for as much diversification 
as possible, including all genres and types of 
music. The overall network looks at incorporating 
and using music as a driver for uplifting the 
city as a whole through focusing on four 
major areas: education, industry, business and 

communication (Grundtman 2016). Stimulating 
music in these areas allows for opportunities for 
these groups to support themselves. The city is 
also slowly incorporating music through the built 
environment to accommodate the projects. The 
old paper mill in the city has been transformed 
into the concert hall of the Norrköping Symphony 
Orchestra, playing an important role in the city’s 
development (Interview with Sandra Wall June 
2020). Using architecture to uplift the musical 
qualities of the community links directly to this 
dissertation. Over time, the Creative City of 
Music could save funds for renovating spaces 
to meet the increasing musical activities. 
Through networking within Norrköping, the city 
becomes Sweden’s Capital of Music and a hub 
of innovation that inspires the rest of the country 
through music (Grundtman 2016). 

Sandra Wall
Norrköping, 

Sweden

Underlying existing musical culture and 
heritage

Fig. 45: UNESCO Creative Cities of Music (Author 2020)



101100

Networking and Architecture
In architecture, networking is the interrelation 
of spatial units, purposefully designed to allow 
potential social interaction through connections 
and boundaries (Kozikoglu & Cebi 2015). 
Researchers agree that the design of spatial 
dispositions affects the quality and quantity 
of social interactions; from accommodating 
to separating, celebrating or hindering, 
spatial design affects our lives, activities and 
relationships (Dovey & Dickosn 2002, Hillier 
1996, Lawson 2005). In an investigative game of 
networks with architecture students, Kozikoglu 
& Cebi (2015) explored the extent of network 
architecture and how each node of the network 
impacts another. The findings were that the 
network structure is ultimately informed by the 
choices of each node. Only certain relationships 
impact the network as a whole, while others 
do not. This can be affected by additional 
‘rules’ that apply to the overall network system. 
Fundamentally, the main conclusion drawn 
from the workshop with the students was that 
the nodes, or spatial entities, are fixed in terms 
of their links, but their geometric compositions 
are constantly changing (Kozikoglu & Cebi 
2015). This agrees with other research done for 
architecture and networks, emphasizing the 
importance of the iterative process of this type 
of design (Do & Gross 2001). Proposing that 
certain nodes help activate the network must 
be followed by the potential development and 
growth of the network, where those initial nodes 
might change, be removed and others might 
be added. Understanding that networks are 
dynamic forms which cannot fully be pinned 
down, can inform and enhance the design of 
the overall architectural network as well as its 
individual elements (Kozikoglu & Cebi 2015). 
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Fig. 46: Networking of programmes 
in Mamelodi Secondary School 
influencing architectural design 
(Author 2020)

Music and Architecture 
There have been numerous studies that have 
investigated the relationship between music 
and architecture and their influences on one 
another. According to literature, there are 
three types of relationships between music and 
architecture: inspiration, image and method 
(Capanna 2009, Tayyebi 2013, Young et. al 
1993).

Inspiration drawn from music for architectural 
design may be derived from a certain genre of 
music, but more often than most, it is drawn from 
a specific piece of composed music (Young et. 
al 1993). Visual inspiration can come from the 
“kaleidoscopic collection” (Capanna 2009:258) 
of the lines and symbols used to represent a 
piece of written music. This may result in a purely 
aesthetic or geometric form of architecture but 
can also inspire the programmatic layout of a 
building (Capanna 2009, Tayyebi 2013), whether 
it be disharmonic or melodic. Mood, dynamics, 
and structure of a space can also be inspired 
by a specific piece of music (Young et. al 1993). 
Similarly, inspiration can be drawn from an 
architectural piece to write a musical melody 
or composition (Kloos et. al 2012, Young et. al 
1993). It can be composed in terms of audible 
output for a specific location (Kloos 2012) or 
related to the building’s cultural and historical 
connections (Young et. al 1993). There are many 
sources of influence that apply to both sides 
of the music-architecture relationship. A study 
done (Young et. al 1993) between architecture 
and music students uncovered a list of these 
sources, many of which have been mentioned 
above. Additionally, materials, physical context, 
function, geometry, user, statement, cost, text 
and many emotions or perceptions (for example 
aggression, tension, triumph, etc.) form part of 
this list. 

The most visual relationship between 
architecture and music is that of an image. This 
can be the literal transferring of the graphical 
aspect of music to the design of a built form or 
an architectural element (Capanna 2009). The 
rhythmic form of written music notes can be 
abstracted to represent architectural towers, 
walls or streets (Capanna 2009, Tayyebi 2013). 
Architecturally, the overall built form can be 
designed to represent a musical image, such 
as Piano House by Huainan Fangkai Decoration 
Project (2007). Similarly, architectural elements 
can take on the identical imagery of music: 
piano staircases or swimming pools, for example 
(Tayyebi 2013). On the opposite end, the 
visual design of musical instruments can have 
architectural designs or geometries, such as 
Daniel Libeskind’s Grand Piano (2003). 

Lastly, music can be used as a method of 
extraction of design concepts and principles 
(Capanna 2009, Tayyebi 2013). This ranges 
from the types of musical instruments used 
(for example strings and brass) to the types of 
sounds these instruments emit in a certain piece 
of music; for example, violins producing smooth, 
light sounds versus heavy, discontinuous sounds 
produced by percussion instruments (Capanna 
2009). A specifically composed melody can be 
used as the starting point for an architectural 
concept (Young et. al 1993) or simply the 
abstract analysis of a genre to inspire a spatial 
mass (Tayyebi 2013). Vice versa, the Golden 
Sequence found in architecture can inspire the 
concept behind a musical suite, as discussed by 
Tayyebi (2013). 

Ultimately, the literature agrees that there is an 
interrelation between architecture and music. 
That music can be used as a “leap-vehicle” 
(Young et. al 1993:39) for architectural design 
and vice versa. 

Inspiration
Acoustic & auditory qualities

Emotion (aggression, excitement etc.)
Cultural context & location

Concept or story
Harmony

Fig. 47 Walt Disney Concert Hall (Gehry 2003)
Method

Weight
Inversion
Rhythm

Composition
Sound

Fig. 48 Bartok vs Steven Holl (Capanna 2009)
Image

Aesthetics
Materiality

Colour
Form

Proportion

Fig. 49 Bloch City (Peter Cook 1992)
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Decentralization
There are two types of decentralization that 
run through this research-led design project. 
The first being decentralization as a shift of 
authority and decision making from those in 
power outside of the local context to those 
directly engaged with the community. This 
form of decentralization achieves increased 
economic growth and improves living standards 
(Ndeneche 2011) as the decision-makers have 
greater communication and relationships with 
the direct context of the community. Although 
there are no policies or hard theoretical 
frameworks for implementing decentralization, 
the literature argues that decentralization and 
decision making by local councils, “the more 
directly concerned” (Ndeneche 2011:145), 
is vital to creating and maintaining certain 
community upliftment projects. Examples of 
these are museums, craft centres, markets and 
cultural festivals. Decentralization depends 
on “strengthening the accountability and 
administrative efficiency” (Ndeneche 2011:40), 
while simultaneously bringing the decision-
making process to the local users of the 
community. This ultimately results in the desire 
to sustain such livelihoods in the community, 
as social and cultural identities are formed 
(Ndeneche 2011). 

There are many reasons to implement 
decentralization strategies. The less political 
reasons involve the following (Ndeneche 2011): 
Decentralization adds to existing developing 
institutions that have direct involvement with 
users, creating a strong communication link 
between the user group and the local decision-
maker; Community members now have a 
valid choice in what happens within their 
area, resulting in a focus on targeted needs 
rather than generalized assumptions from 
removed authorities; Community members 

become more purposeful with their choices as 
they often immediately see the results being 
implemented, similar to action-based initiatives 
(Höök 2016). The pioneering town planner, 
Patrick Geddes, comments on this fundamental 
topic: “The ordinary citizen should have a vision 
and comprehension of the possibilities of his 
own city” (Hamdi 2010:91, Ward 1996). This 
is further commented on by Nabeel Hamdi 
(2010) explaining that for a community to 
thrive, there needs to be a “re-absorption” 
(2010:91) of authority, specifically that of the 
government, directly into the community. This 
results in the community being able to take 
and reap the benefits of directly informed and 
immediate action, instead of waiting on the 
communication through the chains of authority. 
This links participation with the concept of 
decentralization, ensuring the community is 
engaged with their stakeholders on the ground 
(Hamdi 2010). 

To evaluate the success of implementing 
decentralization in a community, one must 
consider the following questions of social 
change (Ndeneche 2011):

- Has there been an improvement of local 
public services in the area?

- Is there an increased involvement of 

community members in the decision-
making process and participation of 
development projects? 

- Are decision-makers able to perform 
their duties more efficiently and make 
decisions more in line with the direct 
needs of the community? 

The second form of decentralization considered 
in this dissertation is spatial. Instead of designing 
the programmatic and spatial layout around 
one central site, this research-led design takes 
the approach of a network, across programmes 
and sites. Each site has its own main function 
and contributions to the overall success of the 
network, while still relying on and engaging 
with the other sites in a mutually beneficial 
relationship.

In architectural networks, the success of the 
system relies on the communication and 
engagement between nodes through their 
representatives with one another (Kozikoglu 
& Cebi 2015), encouraging interaction of the 
community. This can be achieved through the 
sharing of facilities and reliance on distributed 
functions or programmes across sites or nodes 
within the network, instead of merging all the 
functions and amenities on one centralized 

Fig. 50 Decentralization in 
Mamelodi, making decisions 

directly within the community 
(Author 2020)

site. Each node still functions with its own 
separate authority but is influenced through its 
connections and interactions with other sites 
(Seal 2020).

Music, in and of itself, is a decentralized activity 
(Tanzi 2001). Although music-making requires 
a “space” to occur, this does not need to be 
a permanent structure, as the act of music-
making is in essence a temporary activity (Novak 
1997, Tanzi 2001). Acoustic and reverberation 
properties of a space may enhance or impact 
the production of sound but do not hinder the 
performance in any way. In fact, these properties 
are not always considered when deciding on 
performance space, but the consideration is 
rather influenced by the impact and exposure 
to music and the social experience that the 
musicians are offering (Uy 2012). This has been 
proved in multiple projects all over the world, 
such as Korogocho Streetscapes in Nairobi.

In Korogocho, a disadvantaged community 
in Kenya, there is a severe lack of intentional 
public space, resulting in the streets being used 
for functions beyond transportation. The streets 
are used as a space for trading, a playground, 
meeting spaces and more (Skottke 2016). A 
collaboration between Architects Without 
Borders Sweden and Hope Raisers Youth Initiative 
brought about the Korogocho Streetscapes 
project, aimed at creating inclusive ways of 
working with the residents of Korogocho, to 
initiate positive urban development through 
small-scale yet high-impact activities and 
implementations within the public streets 
(Höök 2016, Skottke 2016). Instead of following 
contemporary and traditional design 
processes of urban regeneration, Korogocho 
Streetscapes focuses on more temporary and 
direct interventions through an action-based 
approach (Korogocho n.d.). The target group 
is specifically young children and the youth, 

acknowledging that they are a resource that 
can improve their city and own lives. The project 
implementations result in ownership, community 
identity, responsibility, inspiration, positive 
self-expression and proof that it is possible to 
transform city life (Höök 2016, Korogocho n.d., 
Skottke 2016). This is done through using the 
streets as a common performance ground for 
sport, art and play. 

Music has been used as an important theme 
to transform the city in this project, from music 
and cultural festivals to discussion sessions and 
flash mobs. The Koch fest supports the exposure 
and celebration of the city’s rich musical and 
cultural heritage by giving a platform for local 
and international artists to share their expertise 
and experiences with the local community 
members. Seeing this support for the community 
instils a sense of civic pride and encourages 
community members to become socially 

committed to uplifting their city (Höök 2016, 
Korogocho n.d.). Temporary stages and events 
are set-up to accommodate this festival. A far 
more temporary project was that of Voices 
in Spaces. This was a flash mob set up by 
members of the Ghetto Classics orchestra, the 
only orchestra in Korogocho. Young musicians 
popped up one after another from their hiding 
spaces and gathered in the street which had 
been previously closed off by young cellists. 
Eventually, the whole orchestra had grouped 
and was performing for community members 
who gradually gathered to watch. The street 
was transformed into a performance ground, 
exposing music to those who may not have 
any previous musical experience, while 
showing alternative uses of the streets (Höök 
2016, Korogocho n.d.). It brings a voice to the 
previously quiet community members, giving 
opportunities for upliftment and sustainable 
community livelihoods. 

Fig. 51: Korogocho Streetscapes flash mob 
on the streets of Kenya (Author 2020)
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Music and Participation
Birch & Epp (2015) conducted participatory 
workshops with music students to develop an 
app that will help the students learn self-discipline 
and remain motivated when practising their 
instruments at home. According to Cooper 
(2001), practising individually at home is a music 
student’s least favourite activity, resulting in 
ineffective use of time. Through participatory 
design approaches, Birch & Epp (2015) aimed 
to reduce the power gap between researchers 
and participants by directly involving and 
collaborating with the children from the 
beginning, fostering emancipatory participation 
for a successful technological design (Kensing 
and Greenbaum 2013). The students were 
inspired to practise using the app as it was 
developed collaboratively and connected 
them with other music students. Music-making 
ultimately relies on participation with other 
musicians for individual growth, motivation and 
discipline (Koopman 2007). 

As implemented at CAFCA and other 
institutions across the globe, music students 
all work together in an effort to motivate one 
another and increase each other’s musical 
abilities through focusing on a common goal, 
rather than their different backgrounds (Friere & 
Ramos 2003, Interview with Jesse Mogale 2020). 
Koopman (2007) strongly argues for music 
education through community participation as 
a platform to develop personal growth, it is not 

a one-person act. He argues that through social 
cohesion, creativity and positive self-expression 
are encouraged, enabling learners to enhance 
their artistic abilities and identity. Group 
teaching should be at the centre of education, 
specifically music education, to give individual 
purpose and support (Slevin & Slevin 2013). 
Woodward, Sloth-Nielsen and Mathiti (2004) 
state that social and personal growth and music 
development are of equal importance (page 
4). Bowman (2005) and Koopman (2007) both 
emphasize that although there are numerous 
forms of involvement with music, the intentional 
action of participation with music, i.e. music-
making, develops a person far more than 
merely listening. This can be clearly seen by the 
success of the international community group 
of upliftment, El Sistema.

El Sistema Venezuela was started in 1975 but 
is recognized today as the “most significant 
example of collective music education” (Majno 
2012:56). The project targets and encourages 
the youth of Venezuela as a way of changing 
their lives through intense immersive musical 
experiences, to grow and achieve individual 
empowerment (Tunstall 2013). Students feel 
more motivated to practise as it becomes a 
social and communal activity (Slevin & Slevin 
2013, Uy 2012). In turn, music becomes far 
more than just musical education. Through 
participation and active immersion in music-

making, the youth learn civic and social 
qualities that improve their overall life and 
future (Majno 2012, Koopman 2007, Tunstall 
2013). These include cooperation, responsibility, 
empathy, empowerment and self-discipline. As 
the conductor of the El Sistema orchestra states: 
“We are not trying to create musicians. We 
are trying to create citizens” (Tunstall 2013:70). 
Participation through music allows a platform 
for social issues to be raised, motivation for 
education and knowledge exchange between 
students, teachers and peers. 

COMMUNITy MUSIC

EL SISTEMA VENEzUELA

MOTIVATION

    SOCIAL         COGNITIVE      EMOTIONAL Fig. 52: Conductor Gustavo Dudamel leads 
El Sistema during a June 2009 rehearsal in 
Venezuela (Coex 2009)
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Architecture and Participation 
An architect can typically be defined as one 
who designs buildings (Awan et al. 2011:27). 
They characteristically spend a lot of time 
concentrating on the detailing and systemic 
functions of the building, putting it together 
piece by piece. However, according to Spatial 
Agency (Awan et al. 2011), this brings multiple 
limitations to the design and ultimate success of 
the building. Firstly, the building becomes very 
static and dominant in the elements within the 
control of the architect, for example, the form, 
style and aesthetic (Awan et al. 2011). Not 
designing beyond the box, for those elements 
that are unpredictable and changing, the 
people themselves, is an inevitable matter 
that needs to be immeasurably considered 
or it could result in the failure of the design 
(Awan et al. 2011). Secondly, focusing on the 
commodification of the building simply meets 
the face-value of society’s approval, but fails in 
the post-occupancy department and does not 
meet the real-world requirements of people’s 
well-being. Lastly, suggesting that only architects 
are involved in the imaginative and creative 
output of the environment surrounding us daily 
limits the opportunity to “…capitalize upon the 
informal aspects of urban life” (Brillembourg et 
al. 2005:19) simply because we, as architects, 
are not taught to fully immerse ourselves into 
the field and gain a meticulous understanding 
of what is going on around us. It is important to 
work at the intersection between the individual 

architect and the users on the ground (Awan et 
al. 2011). Similarly, architects focus on standard 
theories presented to them over the decades 
and apply them to a context without considering 
the in-field elements of the social life of the site. 
This forms a stamped repetition of buildings and 
cities throughout the world and more unhappy 
and dissatisfied civilians. 

Through participation, the architect begins 
to confront real-world issues and produce 
successful spaces, not with the intent of making 
a name, but rather to be transformative and 
make a change in society (Awan et al. 2011, 
Hamdi 2010). “Every line on an architectural 
drawing should be sensed as the anticipation 
of a future social relationship and not merely as 
a harbinger of aesthetics or as an instruction to 
a contractor” (Awan et al. 2011:30). According 
to Geddes (Ward 1996), the users of a space 
should have the right to envision and provide 
input on the potentials of their surrounding built 
environment. Not only does this satisfy their 
needs for their community, but it provides them 
with the opportunity of learning leadership and 
entrepreneurship skills which will benefit both 
the individual and the collective community 
in the future (Hamdi 2010). These skills will also 
come in handy when proposing a much larger 
intervention that requires authority beyond the 
community (Hamdi 2010).

Fig. 53: Architecture and participation. (Original images du Bois 2019 edited by Author 2020)
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Summary of Theoretical Context
Analysing the qualitative data, according to Yin’s (2011) qualitative 
analysis methodology, the following codes or themes were determined:

1. Music and the collective identity (how does music bring people 
together and benefit the group as both a whole and individuals?).

2. Music and self-expression (how is music used as a platform for 
positive self-expression, and what kind of effect does that have on 
the music-makers?).

3. Networking (as general and specific to the overlapping topics of 
music, architecture and participation).

4. Decentralization (authoritative decentralization of participation 
and spatial decentralization of architecture and music).

5. Participation (why is it necessary for communities? How is it 
enhanced through music? How does it relate to architecture?).

This qualitative analysis process was followed by multiple iterations in order 
to ensure legitimacy and thorough investigation and understanding of 
the research (Yin 2011). This goes hand-in-hand with the iterative process 
of co-design (Please refer to Volume One of this dissertation), ensuring 
co-authorship throughout the project (Hamdi 2010). It is important to 
place emphasis on this iterative process in any design project as it would 
need to be considered from multiple perspectives to ensure contextually 
and socially relevant decisions are made.

In summary, it was found that the overall success of an architectural 
network and the higher success rates of the individual nodes can be 
greatly influenced through interactions and engagement within the 
network, sharing a common goal. This relays back to Spatial Agency’s 
(Awan et al. 2011) limitation of the lone actor, which is combatted 
through communication, especially between networked nodes. 

To develop these connections for 
communication, direct action on the ground is 
necessary. Number Eleven on the Sustainable 
Development Goals 2030 list, states that it is 
vital to “make cities and human settlements 
inclusive, safe, resilient and sustainable” (UN 
n.d.). UNESCO’s Creative Cities go on to unpack 
how this can be achieved through culture 
and creativity from a bottom-up approach, 
shifting the authority and decision-making 
responsibilities to those directly involved in the 
human settlements. Uplifting the community 
through a “now, soon, later” (Hamdi 2010:67) 
type of project, goes hand-in-hand with this kind 
of authoritative decentralization (Ndeneche 
2011). To achieve this, it is imperative to tap 
into education, industries, businesses and 
communications within a city or community 
(Grundtman 2016). Networking through music 
as a positive platform for expression, specifically 
focusing on these areas, may result in the 
transformation of society. As is so important in the 
El Sistema Venezuela project and the CAFCA 
Jazz programme in Mamelodi, music is used 
as the gateway to future career opportunities, 
to “create citizens” (Tunstall 2013:70). Exposing 
and celebrating the existing untapped musical 
potential within a community, as proved by 
Memphis Slim Collaboratory and UNESCO’s 
Creative Cities of Music, truly unlocks the 
opportunity for social cohesion and the creation 
of collective community identity, uplifting the 
community as a whole. 

Fig. 55: Theoretical Context summary (Original images Honours 2019 edited by Author 2020)

Fig. 44: The 5 Themes identified through 
theoretical analysis (Author 2020)
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Taking it online
In March 2020, the COVID-19 virus was determined 
as a global pandemic, shutting down cities and 
countries across the world into lockdown. South Africa 
was hit with a total lockdown, impacting workers, 
students and businesses across scales, economic 
classes, ages, races and religions, except for the 
limited essential workers. CEOs and janitors alike 
were suddenly thrown into the same playing field, 
supported exclusively by what was available to them 
within their own homes. In general, this consisted of 
being confined to the four-walled homes that they 
then needed to appropriate to continue their work 
online. For example, setting up a virtual office in the 
dining room or cleaning out a room from its clutter 
to have a more open space for activities such as 
exercising or playing instruments. This completely 
changed the research methodology for this project, 
challenging it and exposing the fundamental needs 
for daily survival without physical interaction with 
the world outside. After a few weeks, the lockdown 
was extended indefinitely with minor alleviations. 
During this unprecedented period of isolation, the 
stark reality of South Africa’s devastating economic 
gap began to surface. It revealed that not only 
most of the population did not have access to the 
technology required to work and study virtually, but 
also the severe impact of a decreased or terminated 
income with regards to paying bills and providing 
food for survival (Mathibela 2020, Petersen 2020). 

The following article was written as a part of this 
dissertation in response to the above-mentioned 
issue. 

Fig. 56: Students practice social distancing as 
schools reopen after the COVID-19 lockdown 
(Original image by Sishi 2020, edited by Author 
2020)
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The Impact of Economic Status on Participatory 
Design Methodologies During A Global Pandemic
What is seen as a simple solution for some, is a significant inhibitor for others.

ABSTRACT

Participatory Design involves the end users in the co-design process through 
active engagement and communication with one another. Conventionally, 
participation sessions are held face-to-face in order to directly cooperate 
with participants. This is most often used in order to fully engage qualitatively 
and draw inspiration from the people around you during the session; a 
constant ebb and flow of knowledge. Advances in technology assist 
alternative methods of participation online for when physical contact is 
not an option. However, this favours developed countries. The majority of 
participants in developing countries are from disadvantaged communities 
with limited to no access to resources, specifically technology, as well as a 
lack of skill and knowledge to use such technology for online participation. 
This issue created a significant gap between citizens of different economic 
classes in South Africa when the COVID-19 nationwide lock-down was 
enforced. For the majority of advantaged citizens, the transition to 
online life was only a slight adjustment. However, in the disadvantaged 
community of Mamelodi East in the City of Tshwane, life was brought to an 
indefinite halt. Considering the economic and knowledge gap, this article 
investigates the existing toolkits for online participatory workshops. This is 
done both through literature reviews, case studies and the researcher’s 
own implementation of an interactive website. As a result of the lack of 
participation with the website, the researcher critiques the current ways of 
appropriating participatory sessions. This results in the need for incentives, 
specifically chosen in response to the exposed needs brought on by the 
economic gap specific to South Africa. The research gathered is analysed 
according to the interactive success and response to the implemented 
workshops. The case study is a high school in Mamelodi East, Pretoria, that 
was severely affected by the COVID-19 lock-down. This article provides a 
foundation for disadvantaged communities to build on collectively during 
times of crisis and uncontrollable exclusion.

INTRODUCTION
During the COVID-19 nation-wide lockdown 
in South Africa, most people were stuck 
indoors, taking their daily work and education 
routines online. This solution was to ensure the 
continuation of working and learning during the 
pandemic, so as to keep the country going. As 
a middle-class citizen with access to the internet 
and a laptop, the researcher was one of the 
many who easily shifted their daily routine to 
indoor confinement. The true impact of going 
online was only exposed to the researcher and 
the rest of the country as the lock-down days 
rolled on.

To the East of Pretoria exists a township called 
Mamelodi. Formed during the Apartheid regime 
for the African population in 1945 (van der Waal 
2000), this settlement has a history of government 
neglect and social struggle. Today, like most 
disadvantaged communities in South Africa, 
the people of Mamelodi have little to no access 
to services, specifically internet, technology and 
in some cases even electricity (Petersen 2020). 
This resulted in millions of people sitting at home, 
unable to work, learn or connect physically with 
anyone outside their homes due to the social 
distancing of the nation-wide lock-down.

As an integral part of the researcher’s Masters 
of Architecture research, the approach for 
a design intervention in Mamelodi East was 
considered through a participatory lens. Through 
engagement with high school students of Tsako 
Thabo Secondary School in Mamelodi East, the 
theme of music-making and its connection to 
the surrounding community was uncovered. This 
developed into further research and co-design 
with specific Tsako Thabo Secondary School 

students who had an interest in or participated 
in musical extracurricular activities. 

According to the well-versed participation 
researcher, Nabeel Hamdi (2010), designing 
through a participatory lens is done as the 
most basic form of effective and efficient 
design, especially when practised in emergent 
communities. Traditionally, participation 
workshops are arranged face-to-face, directly 
involving the users of the end intervention 
from the beginning of the process (Friedrich 
2013, Kensing 2003, Simonsen & Robertson 
2013). This helps all participants (professionals, 
stakeholders and community members) to fully 
engage qualitatively and have an abundant 
flow of knowledge and inspiration with one 
another. Face-to-face workshops pose certain 
challenges, such as the limitations of meeting 
times, places and the number of participants. 
However, the number one challenge for 
traditional participatory design methods would 
be when face-to-face workshops are not a 
viable option (Friedrich 2013).

As technology develops and global cross-
communication opens opportunities for a larger 
catchment of knowledge, such participatory 
workshops have been adapted to online 
platforms. In the past, online participation was 
limited to such things as surveys or questionnaires. 
These resulted in limited feedback but from a 
much larger pool of participation than face-to-
face workshops with smaller and more intimate 
groups of people (Markus & Mao 2004). Today, 
there have been numerous technological 
advances that allow for far more interactive 
and collaborative online methods. These range 

from social media platforms to web services. 
There are also video conferencing and virtual 
meeting platforms which combine online works 
with face-to-face interaction (Sanders et. al 
2010).

This development in participatory design 
methodology allows for both traditional and 
online workshops to take place and for design 
research to continue without hassles, specifically 
when faced with a nation-wide lock-down from 
the COVID-19 pandemic. However, as literature 
very clearly points out, progressing from 
face-to-face to online workshops has its own 
challenges. This article focuses on the gap in 
knowledge for real world application of online 
participatory design: what happens when 
the very community that participatory design 
methods are intended for, such as Mamelodi 
East, does not have access to the internet in 
order to participate in online workshops during 
a forced social distancing regime?

This article sets out the traditional methodology 
of participation design and its transition to 
online platforms. It is then followed by the 
background and history of the case study: 
the disadvantaged community of Mamelodi 
East (van der Waal 2000), clearly defining why 
such participatory methods are necessary in 
underserved areas. Following the lock-down of 
the COVID-19 pandemic, critique of literature 
and investigation of alternative participation 
methodologies will be outlined, in order to 
expose the necessary measures that needed to 
be taken for the inclusion of users during such 
trying times. 

PRETORIA, SOUTH AFRICA

Pretoria CBD

University of 
Pretoria

Mamelodi East

Fig. 57: Working from home, the “new normal” (Original by Byworth 2020, 
edited by Author 2020)
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LITERATURE REVIEW
Using Participatory Methods
General citizen participation in community 
decision making goes back as far as Plato’s 
Republic (Plato in Grube 1992). More specifically, 
participation in design processes can be traced 
back to the development of computers in the 
workplace in 1970 Scandinavia (Simonsen 
& Robertson 2013). Over time, methods and 
processes of participation have developed 
and have been researched thoroughly across 
multiple discourses. Today, participatory 
methods are used to help design technologies 
and aspects of daily life to be more successful 
in use, durability and more contextually suitable 
(Hamdi 2010, Simonsen & Robertson 2013). This is 
done by tapping into participants’ knowledge 
and skills, emphasizing the richness and 
underlying potentials of lived members of the 
community, ultimately acknowledging them as 
experts in their own field (Simonsen & Robertson 
2013). 

In architecture, designers implement 
participatory methods in order to gain a real-
world and hands-on understanding of the 
context (Brown 2009), starting from immersive 
mapping of social relations and issues in the 
field, to the iterative process of design and 
finally the implementing of the project as a built 
form (King 1983, Sanoff 2011). Joining forces with 
community members and other stakeholders 
at every stage of the design process creates 
a sense of community, social relations, citizen 

empowerment and results in more ownership for 
the intervention’s success (Bens 1994, Guy 2002, 
Kretzmann & McKnight 1993, Sanoff 2011). From 
an efficiency point of view, participatory design 
often minimizes costs and delays and can 
prepare for any anticipation of the community’s 
concerns or critiques early on (Creighton 1994). 
It also solidifies the legitimacy of the project 
through a fair, open and often democratic 
process (Sanoff 2011). 

Conventional Participatory Methods
Participation starts with a collective drive 
around shared interests and values (Simonsen 
&Robertson 2013). Through a process of 
investigating, understanding and developing, 
the desired outcome comes to fruition. Most 
literature states that this process is conventionally 
done in the field and face-to-face with the 
relevant participants and stakeholders (Kensing 
2003, King 1983, Markus & Mao 2000). Physical 
interaction amongst the group of participants 
allows for relationships to be formed through 
mutual respect and the learning about one 
another (Simonsen & Robertson 2013). This helps 
each person involved to fully understand each 
other when opinions and decisions are brought 
to the table (Kensing 2003, King 1983, Markus 
& Mao 2000). Fundamentally, participatory 
design is “designing futures for actual people” 
(Simonsen & Robertson 2013:5), including both 
action and reflection, constant reiteration of the 

end design. This back and forth ends up being a 
social activity through which interaction creates 
design (Ehn 1993). 

There are multiple ways of conducting 
participatory design research conventionally 
(Sanoff 2011). Sanoff (2010) is well versed in 
using participatory prototypes in the USA for 
community planning and architecture. In his 
workshops, small scale models are built to 
represent buildings and other physical features 
of the community design (Sanoff 2010). Other 
researchers have used 3D prototypes that are 
more robust than simple paper models (Hussain 
& Sanders 2012). Most often, questionnaires and 
surveys are used in the beginning of the process, 
as well as in a qualitative form of reflection later 
on (Gaver et. al 1999). More generative tools 
that provide qualitative data sets are immersion 
walks, personal journals of daily life, sending a 
camera home and collaging (Sanders & William 
2001, Simonsen & Robertson 2013). These tools 
enhance a participant’s creativity and can 
often unveil information deeper than the surface 
level. Physical activities, such as enacting a 
possible future through improvisation, or role 
playing “as if by magic” (Lepir & McPherson 
2019:113) scenes can surface intrinsic values 
and feelings of participants. They are also an 
excellent tool to use for reflection and learning 
about a situation from multiple perspectives 
(Carroll 2000). Mike Ford, also known as the 

Hip Hop Architect, uses the writing of rap songs 
as a platform for kids to express the issues and 
needs of their communities in order to envision 
better architecture for the future (Hooper 2017). 
Similarly, sport, games and other activities can 
be used as platforms for participatory processes 
(Bødker et. al 1993). 

The challenges that the participatory process 
faces through conventional methods are 
that of practicality and quantity, as discussed 
thoroughly by Pirjo Friedrich (2013). Starting 
from the beginning of the process, one can 
find it challenging to obtain participants. This 
is due to lack of interest or, more so, mistrust of 
professionals from past experiences (Friedrich 
2013, Hamdi 2010). In terms of meetings or 
workshops, the time available is limited. This 
often only allows a smaller group of selected 
participants and isolated sessions. In such 
variable workshops, researchers find that there is 
a much wider pool of information and far richer 
aspects brought to light that encourages deep 
discussion. These open-ended conversations 
often take much longer than expected and 
result in running out of time (Ehn 1993). Lastly, 
when participants cannot be reached face-to-
face, conventional methods of participatory 
design need to be adapted (Friedrich 2013, 
Gaver et. al 1999).

(Top) Fig. 58: Participatory Action Research 
workshop at Tsako Thabo school (vd Hoven 
2019)
(Middle) Fig. 59: Co-design workshop at Tsako 
Thabo school (Author 2019)
(Bottom) Fig. 60: Analyzing a scale model of 
Tsako Thabo school (Greyling 2019)
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Web-based Participatory Methods
As Friedrich (2013) points out, the main focus 
of the participatory design process is not so 
much on the methods used, whether these be 
conventional or not, but rather on the actual 
participation. The point is to design for real 
humans by actively and thoroughly involving 
those people in the process (Hamdi 2011, 
Simonsen & Robertson 2013). This allows for 
flexible participatory method typologies without 
losing the overall impact. 

In the 21st century, there have been multitudes of 
technological development. One technological 
typology, specifically, that most of the world’s 
population engages with every day of their lives 
is social media (Friedrich 2013). The term is used in 
this paper to refer to any form of user generated 
content through online services. This includes 
social platforms, software and developed web 
services. As Friedrich (2013:17) describes so well, 
social media has “changed the way people, 
communities and companies interact over the 
internet”. It has resulted in far more immediate 
forms of communication, connecting people 
from across the world, expanding boundaries 
like never before. 

Along with Friedrich (2013), other researchers 
have explored how the power of social media 
platforms can be used to gain a large number of 
qualitative data sets (Fischer 2004, Hagen 2011, 
Johnson 2013, Markus & Mao 2000, Nambisan 

2002, Sanders et. al 2010). Choosing participants 
is no longer limited to their physical location 
and availability of time but is now open to a 
much larger pool that shares interests and have 
different backgrounds (Fischer 2004). Physical 
workshops can be combined with online virtual 
conferences, increasing the ease of access 
for most users (Sanders et. al 2010). As many 
people are familiar with social media platforms, 
collaboration and networking becomes easier 
and more enjoyable (Friedrich 2013). Research 
points out that there are many additional 
benefits for both the researcher or designer and 
the users of social media, above and beyond 
that of physical participatory processes. The 
process can be monitored constantly and at 
any time of the day by the researchers (Hagen 
2011, Vanattenhoven & Jans 2007) while also 
being accessible across countries, allowing for 
qualitative insights and communication from 
varied physical contexts (Hammer-Jakobsen 
and Goldman 2009). As social media platforms 
are generally open source, other participants 
and researchers can see each other’s content 
and the conversation of inspiration can flow 
(Hagen 2011, Vanattenhoven & Jans 2007). 
The data becomes richer and more elaborate 
(Kaptein et. al 2009) as anonymity can easily be 
achieved, giving users the confidence to speak 
with complete honesty and raw self-expression 
(Reid & Reid 2005). Without interruptions and 
constraints of physical interaction, there can be 

continuous contact between the researchers, 
designers and users resulting in immediate 
interviews or action if required (Hagen 2011, 
Vanattenhoven & Jans 2007). From cost savings 
to unlimited participants and more flexible 
schedules, participatory efforts of collecting 
qualitative data have been opened up to far 
more new possibilities through the use of social 
media (Bolt 2006, Gough & Phillips 2003). Lastly, 
a very important note from literature about using 
social media as a platform for participatory 
processes, is that all the data collected is 
immediately in a digitized form. This saves time 
from transferring the raw data collected on site 
to a digital platform and makes the storage and 
sharing of collected data much easier (Friedrich 
2013, Yndigegn 2010). 

Friedrich (2013) also breaks down the uses of 
social media attributes for co-design possibilities. 
This ranges from the openness of the platform 
to interaction, collaboration, immediacy and 
connectedness through user-created content. 
Each of these aspects can be considered 
and applied for any social media platform the 
researcher chooses to use. 

Online tools for participatory methods have 
disadvantages and challenges specific to 
the design process (Friedrich 2013, Kaptein 
et. al 2009). It is necessary to note that each 
case is user-specific, and the presence of the 

challenges is variable to each session and user. 
The most obvious challenge for social media 
platforms is internet accessibility (Kaptein et. 
al 2009). This ranges in levels of the obstacle, 
from no electricity to lack of money to pay for 
the internet to limited amounts of data. For 
researchers, it takes a lot more effort to learn 
and master the social media platform for co-
design than for physical workshops (Friedrich 
2013). User participation and maintaining user 
interest through a screen is also a considerable 
challenge that needs to be prepared for prior 
to the session (Bolt 2006). 

Although technology has developed favourably 
in light of participation processes, these 
methods prove to be both a challenge and 
a new opportunity when faced with a global 
lockdown and the large economic gap found 
in developing countries. 

Fig. 61: Taking co-design and participatory 
research online during a global pandemic 
(Author 2020)
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METHODOLOGy 

The research done as a part of this article falls 
within an interpretivist paradigm, collecting 
qualitative data. This type of data collection is 
used in order to gain a real-world and hands-on 
understanding of the context in which the project 
is based (Friedrich 2013, Simonsen & Robertson 
2013). It is human-centred and uses real people 
in order to gain real perspective (Brown 2009), 
ultimately resulting in a higher success rate. The 
data was analysed according to Robert Yin’s 
(2011) qualitative analysis methodology. This 
was done to draw similarities or contradictions 
of phrases, themes and metaphors between 
primary and secondary sources, as well as to 
summarize the overall findings and identify the 
gap in knowledge.

This research was done in response to 
an obstacle for a Professional Masters of 
Architecture mini-dissertation at a South African 
university. Founded on participatory design 
methods, initial investigation and collaboration 
were conducted by implementing traditional 
methods of face-to-face interviews and 
workshops. When the COVID-19 pandemic 
struck South Africa, traditional methodology for 
the participatory design stage of the project 
was interrupted indefinitely. In order to continue 
with the design process, web-based methods 
were adopted, and a user-oriented website 
was developed.

The website developed for this research was 
created using a free open platform called 
Wix™. This platform allows for both desktop 
and mobile versions of a customized website 
to be developed. This creates the opportunity 
for inclusive access for the majority of users. The 
designed website, Music Makers (https://lakonst.
wixsite.com/musicmakers), briefly outlined the 

dissertation project and very clearly indicated 
what form of participation was required from 
the users. Ethical disclaimers were featured on 
every page of the website in order to ensure full 
understanding of the intended use of the data 
collected. Verbal or physical acknowledgment 
of the ethical disclaimer prior to commencement 
of workshops, video calls and questionnaires 
were compulsory. An important aspect to 
note is that all users’ anonymity was ensured 
throughout the entirety of the project.

Two main functions of the website became 
evident over the course of the research. 
Simultaneously, the website acted as an 
interactive platform for collecting data as well 
as a platform for uploading and sharing of 
data collected off the website. This was done 
by linking to forms made using KoboToolbox™ 
as the platform for collection. In general, the 
researcher found the first function to be limiting 
in terms of control and ensuring participation. 
The site was shared on many social media 
platforms by both the researcher and others, 
as well as direct communication via email 
and WhatsApp™ messages, however lack of 
encouragement and motivation resulted in 
limited interaction or declined responses with 
the online workshops. The level of interaction 
was decided by the user and could not be 
managed or supervised by the researcher at 
all. The second function of the site proved to 
be more successful from the researcher’s side. 
Private and supervised workshops were held on 
separate online platforms and the summarized 
data and conclusions were uploaded to the 
website. This resulted in the data being collected 
to be more effective and ensured, while the 
viewing and sharing of this data with others 
remained limited and difficult to trace. During 

video conferences, for example examinations, 
the website proved to be a user-friendly and 
successful platform for sharing the data and 
other uploads.

The initial target group of musically inclined 
students from Tsako Thabo Secondary School 
could not be reached throughout the lockdown 
period of the COVID-19 pandemic. This was due 
to the complete lack of access to the internet 
and limited financial opportunities to buy data, 
typical of the economic gap prevalent in South 
Africa. This resulted in total isolation with regard 
to communication and participation with the 
researcher. Although there are community 
members who have access to most services, the 
research was limited due to the target group 
required for the dissertation. The focus group 
of Tsako Thabo Secondary School learners that 
participate in musical extracurricular activities 
within Mamelodi East were chosen specifically 
due to their ability and education in the making 
of music (i.e. playing instruments and singing). 
As the target group was established during 
face-to-face workshops, only a small number 
of members were involved. Transitioning online, 
however, was found to be necessary for the 
continuation of the research, to expand beyond 
the initial target group, allowing larger groups 
of people to participate (Markus & Mao 2004). 
This was still predominantly focused on music 
makers within Mamelodi East, but due to the 
lack of participation, the catchment area grew 
larger and expanded into any musician willing 
to participate. An opportunity for international 
engagement and participation presented 
itself as a result of the COVID-19 lockdown. 
Although this did not directly involve the target 
group of Mamelodi musicians, it did allow for 
collaboration with international musicians, 

social enthusiasts and participatory professors, 
all contributing to the development of the 
research-led design project. 

The adaptation to the research methodology 
was largely influenced by literature, specifically 
that of Pirjo Friedrich (2013). Social media 
platforms were found to be far more powerful 
for reaching a wider number of individuals. This 
was proved through the joint effort between 
unofficial meme pages of the University of Pretoria 
and Stellenbosch University using Instagram 
Stories™ (Life At Tuks 2020, SU Just Kidding 
2020). A student-led initiative was organized 
to ask other students to voluntarily buy data 
for other certified financially disadvantaged 
learners. This helped them gain access to the 
internet in order to continue their studies during 
the COVID-19 lock-down, when their universities 
provided futile solutions that could not help most 
disadvantaged students (Life At Tuks 2020). It 
has since developed into an initiative for raising 
funds for students with no financial means to buy 
food or pay rent. It has also influenced similar 
initiatives run by the student key committees of 
the University of Pretoria to raise funds through 
social media platforms (Mathibela 2020). These 
initiatives were proactive responses to the 
spotlight on the severe economic gap within 
the University’s educational ecosystem as a 
result of the COVID-19 lockdown. 

Fig. 62: Screenshots of the developed website 
Home and Participate page (https://lakonst.
wixsite.com/musicmakers) (Author 2020)

https://lakonst.wixsite.com/musicmakers
https://lakonst.wixsite.com/musicmakers
https://lakonst.wixsite.com/musicmakers
https://lakonst.wixsite.com/musicmakers
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DISCUSSION

This article has gathered and correlated 
information regarding the conventional 
participatory methods as well as the development 
of online participation. Both have been proved 
to be greatly successful in practice and as ways 
of overcoming certain obstacles along the 
participatory journey. These online methods, 
although providing the opportunity for further 
connections and larger pools of qualitative 
information, do not solve the initial problem 
of the lack of consideration for the majority of 
underserved communities in South Africa when 
moving daily life online. As the community 
members of Mamelodi East are vital contributors 
to the research led design of the researcher’s 
Masters of Architecture (Professional) project, it is 
instrumentally important that they are included 
and considered in the process, no matter the 
challenges. 

Some of the students in the Honours year of 2020 
in the Department of Architecture thoroughly 
explored virtual platforms that can be used for 
participatory processes, with specific relevance 
to those available and popular in South Africa. 
These were analysed according to accessibility/
usability (data usage, installation etc.), 
interactivity (creative tools, communication 
types, participant collaboration etc.) and 
academic soundness (use for research, design, 
empowerment of users etc.) and thoroughly 
compared to one another (Buffa et al. 2020). 
This largely influenced the platforms used for 
this research project. Engaged co-design 
workshops were implemented with participants 
outside of the initial Mamelodi target group, 
due to the disconnection caused by the 
economic gap. These participants had internet 
access and shared similar interests or contextual 
backgrounds with the project, ultimately falling 

on the ‘greener side’ of South Africa’s gap. It 
is important to note that although the initial 
target group could not participate in the design 
stage of the project, due to the COVID-19 lock-
down, the background research had already 
been completed using traditional face-to-face 
participatory methods with users in Mamelodi 
East. This provided the foundation on which 
further investigation could be built that would 
not leave it uncontextualized and assumed.

Concluding from the analysis done by the 
Honours group, it is found that data and money 
is still a predominant issue when it comes to the 
first stage of accessibility for virtual participatory 
processes. As uncovered through the student 
initiative run by the Life At Tuks meme page on 
Instagram™ and Fiona Samuels (2020) Tips for 
collecting primary data in a Covid-19 era, a way 
to address the issue of not being able to reach 
disadvantaged users is through networking and 
word-of-mouth (Life At Tuks 2020). However, 
for them to engage directly with the social 
media page, data is required. Researchers and 
facilitators have provided money for data for 
their participants to collaborate virtually during 
workshops. This could be a financial incentive 
with both pros and cons. Firstly, participatory 
processes should not be a job nor chore for 
participants; it is a voluntary engagement that 
inspires overall community empowerment and 
upliftment (Byrne & Alexander 2006). Using 
incentives for participatory processes can 
result in lack of ownership and responsibility 
for the end product once the incentives end, 
which completely contradicts the point of 
participation (Byrne & Alexander 2006). On 
the other end of the spectrum, buying data 
for participants, for example, could result in 
motivation for the process, which in turn results 

in ownership and identification with the end 
participatory product; participants can see the 
‘bigger picture’. This is a risk that researchers and 
facilitators need to consider in both physical 
and virtual participatory processes. If an 
incentive is used for virtual participation, there is 
no guarantee or assurance that the participant 
will deliver their end of the bargain. 

Although there were no clear solutions to the 
initial problem statement of the economic gap, 
perhaps it is more about learning from this unique 
experience than forcing the puzzle pieces to fit. 
The economic gap is not unknown in South Africa, 
but most did not realize the dire consequences 
it could result in. Taking everything online during 
the COVID-19 pandemic has only begun to 
exhibit the extent of this issue (Croukamp 2020). 
As seen by the student-led initiatives and the 
many seminars that have been held virtually, 
the economic gap has predominantly inspired 
others to reach out and help change things for 
the better. Web-based co-design sessions are 
certainly a positive development for those who 
can access internet and technology, however, 
a data crisis is not something of desperate value 
when the real issue is a lack of income for mere 
survival. 

Simply moving online is not an entire solution on its 
own. Perhaps a hybrid of conventional methods 
with alternative processes that respond directly 
to the context of the research is necessary. 

The Gauteng City-Region Observatory (GCRO), 
Human Sciences Research Council (HSRC) and 
Social Surveys Africa (SSA) have collaboratively 
run a series of seminars during the lockdown 
period where professionals and like-minded 
people have presented and discussed ways 

of collecting social data during this time of 
restriction (GCRO 2020). It is imperative that 
these activities cannot be put on hold due to 
this disruption, but rather continued vigorously so 
as to understand the multi-dimensional impact 
the pandemic has on people’s lives. This will 
largely influence future design considerations 
in order to ensure well-being of people in 
South Africa. Some researchers had merged 
techniques and processes in order to work with 
the lockdown obstacle. It was emphasized 
that using mixed research methods in order to 
collect the qualitative data was the best way 
to go around the restrictions of the lockdown 
(Croukamp 2020). This includes both online 
participatory sessions, telephonic and face-
to-face, where possible. It was also found that 
using incentives, whether it be airtime vouchers 
or the likes, were a necessity to encourage 
participants to give their feedback (Croukamp 
2020). Lebogang Shilakoe (2020) from SSA 
spoke about their experience with telephonic 
surveys and conversations. These were found 
to be a great opportunity as more people were 
at home with more free time and they wanted 
to talk to somebody. However, this type of 
research quickly becomes costly and has a 
stigma from participants. The stigma associated 
with telephonic surveys is that they waste the 
participant’s time as the participant does not 
get anything in return (Shilakoe 2020). Working 
with network providers, the cost of calling many 
people could be reduced as well as providing 
incentives for participants, such as airtime 
vouchers (Shilakoe 2020). This process relies on 
having contact details for participants. If the 
researcher does not have these details from past 
projects or fieldwork prior to physical restrictions, 
they could use social media platforms to 
advertise. Similarly, to the incentive with the 

Life At Tuks Instagram™ page, participants 
(or donors) responded to adverts placed on 
social media and privately exchanged contact 
details with the researcher. Once again, the 
facilitator does not necessarily have control or 
assurance that a certain quantity and quality 
of participants would respond, although there 
is a higher chance of success if incentives are 
provided.

Fig. 63: Conventional participatory research workshops collage (Author 2020)



123122

Participatory Test during Lockdown
Following the initial research trial done through 
the website, findings from the literature reviews 
and research done by the Honours group, 
the researcher found it imperative to test a 
combined participatory research approach.

The researcher set up a ‘Rap Battle’ competition 
in a digital poster format to send to the 
principal of Tsako Thabo Secondary School. This 
poster was visually similar to those uploaded 
on the researcher’s website for the previous 
participatory challenges. A QR code was 
provided on the poster, linking to a collection 
form on KoboToolbox™. The form created for 
uploading the entries was tested multiple times 
using the researcher’s and other cell phones 
both with and without internet access. The only 
issue that came up was that internet access 
was required to upload the data, however, this 
would happen automatically as soon as a phone 
would connect to the internet, even hours after 
the form had been submitted. This form consisted 
of the ethical disclaimer, acknowledgement of 
consent, request for contact details (in order 
to communicate with the winner) and space 
to upload the participants’ video or audio 
files. The poster indicated that the winner of 
the competition would receive a R100-00 
McDonald’s™ food voucher. This specific prize 
of a food voucher was chosen in response to 
the dire needs of citizens falling on the lower 
side of the economic gap, as proved clearly 
through the data-turned-food initiatives set out 
by Life At Tuks. 

The poster was sent to the principal using 
WhatsApp™. The researcher had formed a 
good relationship with the principal and had 
his contact details from previous engagements 
with the school prior to the COVID-19 lockdown. 
Within three-quarters of an hour, the researcher 

had been connected with two school teachers 
who had already shared the poster with their 
students and had received a lot of interested 
feedback from their students. Comparing this 
stage of sharing the poster to the same stage of 
sharing the website previously for weeks with still 
little interest, the Rap Battle competition was a 
much bigger hit. This could be due to the prize, 
the more direct approach of sending the poster 
directly to the principal instead of merely sharing 
a link or the lack of internet access that was 
required in order to complete the competition. It 
is unclear as to whether the teachers forwarded 
the poster to their students or simply expressed 
the competition brief verbally. At this point in 
time, the teachers involved did have face-to-
face contact with the students during the week. 

The morning of the deadline for the competition 
entries, the researcher contacted one of the 
teachers to ensure everything was moving 
smoothly. The teacher responded saying the 
students had uploaded their entries, however, 
on the researcher’s side of the KoboToolbox™ 
form, there were no uploads. The researcher 
then lost contact with the teacher due to 
unknown reasons. A few days later, the 
researcher reached out to the principal again 
to try and understand what the issue was. 
Eventually, through the principal contacting 
the teacher again, the researcher regained 
contact with the teacher and worked together 
over the WhatsApp™ voice call feature to solve 
the issue. It seemed that the students did not 
have internet access to upload their work and 
therefore required the school’s infrastructure 
in order to complete their entries. This again, 
proved to be insufficient and the teacher had 
to go out of his way to buy his own data for 
his phone to upload the student’s entries. This 
brought about its own set of challenges. The 

teacher would download the entries sent to 
him via WhatsApp™ and upload them to the 
KoboToolbox™ form. Somehow, this messed 
with the file type and could not be opened from 
the researcher’s side. Eventually, to simplify the 
situation, the researcher suggested the entries 
to be sent to her using the same platform they 
were sent to the teacher: WhatsApp™. This 
proved to be far more efficient and successful. 
The participants’ contact details (cell phone 
number and name) and acknowledgement of 
the ethics disclosure were provided through the 
KoboToolbox™ form.

In total, there were three entries that met the 
brief that the teacher was happy to submit to the 
researcher. The winner was selected and sent a 
winner’s poster via WhatsApp™. The researcher 
had to change the prize as McDonald’s™ 
would not sell a singular voucher. However, an 
even better solution came to play. KFC™ sells 
virtual vouchers that can be sent to the receiver 
via SMS and is valid for three years from the 
purchase date. This voucher is extremely useful, 
especially during a nationwide lockdown as it 
requires no face-to-face contact. 

As a summary, WhatsApp™ proved to be the 
more efficient and successful way to contact 
participants and to share data collected. As 
proved by the students in the Honours studio, 
WhatsApp™ is used by most of the population 
in South Africa and uses an incredibly low 
amount of data. Although, it does not provide 
a formalized way to collect data anonymously 
and ensure ethics acknowledgement, it is the 
researcher’s responsibility to ensure these issues 
are dealt with. 
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CONCLUSION

Considering the research done, the projects 
implemented during the Collecting Social Data: 
Adapting to the COVID-19 Pandemic seminar 
and the Rap Battle initiated by the researcher 
the initial concern raised by this article is that 
of compatibility and accessibility over the 
large economic gap in South Africa. Citizens 
on the lower side of the economic scale were 
simply unable to adapt to the online transition 
for work and education during the COVID-19 
nationwide lockdown. The golden thread is 
access to technology and predominantly the 
lack of income in order to afford this access. 

The research collected in this article has provided 
numerous ways of collecting participatory data, 
both online, face-to-face and a combination. 
Tools, such as KoboToolbox™ were developed 
in order to collect qualitative data from 
emergent communities in order to make a 
difference through social innovations and bring 
awareness to issues found. It was specifically 
designed to provide a platform that can be 
used by anyone, irrelevant of economic class. 
Practically, KoboToolbox™ works without 
an issue face-to-face with researchers and 
community members. However, as proved 
by the Rap Battle submissions, the interface 
became inaccessible for participants due to 
the lack of internet access. As suggested by the 
Honours studio and proved by the Rap Battle, 

WhatsApp™ is a far more accessible platform 
for contacting participants, but still requires a 
certain amount of internet access. 

One may be disheartened by the impact of 
economic status in that what is a simple solution 
for some is a significant inhibitor for others 
during a nation-wide lockdown. However, one 
can also choose to be inspired. The reason for 
this is that lockdown exposed this inequality 
of access to high tech solutions between the 
different economic classes. This is an exciting 
opportunity to create awareness and to drive 
the relevant stakeholders to address this issue. 
This research can contribute to the development 
of knowledge concerning these differences 
and it can challenge both government and 
the private providers of internet connectivity 
to join together to find an innovative solution. 
This opportunity for collaboration may be a 
starting point for various sectors of the economy 
to address other such inequalities as we stand 
together on the cusp of a new, post-lockdown 
world.

Fig. 64: Participatory research at Tsako Thabo 
Secondary School (Author 2020)
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03_INFORMANTS II
Urban Vision

Moretele Park Proposal

MMS Proposal

CAFCA Proposal

Tsako Thabo Design

Proposed Users

2020 Co-design 
Workshops

Summary

Fig. 65: Community Action Planning and Codesign collage (Author 2020)
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03_INFORMANTS II
Previous architecture dissertations (Blokland 
2007, Thomo 2007) have been researched and 
proposed in Mamelodi East and other areas 
in Pretoria, speaking on the musical heritage 
of the relevant community. These projects 
consisted of extravagant designs on a single 
site, namely Moretele Park and a vacant plot 
in Marabastad, in the form of an amphitheatre 
and assisting buildings with a function of 
performance and music education centres. 
These dissertations were well thought out and 
considered in terms of conventional architecture 
and methodology; it is therefore vital that this 
project does not repeat the same interventions 
and process, but rather considers a project 
that is more inclusive, relevant and socially 
informed due to the participation and active 
co-design with the end-users of the intervention. 
Adding to the knowledge imparted by these 
previous dissertations, as well as the previous 
2019 Honour’s design project proposed by the 
researcher herself, should provide this project 
with a solid foundation on which to build. 

During the nationwide lockdown of the 
COVID-19 pandemic in South Africa, a lot of 
the research for this dissertation was taken to an 
online platform. This inspired many opportunities 
for reaching out to researchers and other 
people with shared interests to broaden the 
influential	 field	 of	 this	 dissertation.	 One	 major	
virtual connection that was made is that with 

Sandra Wall from UNESCO’s Creative City of 
Music, Norrköping in Sweden. On a global 
scale, the qualitative and quantitative data 
documented in Mamelodi East, as well as the 
proposed Mamelodi Music Network can be used 
as part of the application process for Mamelodi 
to become one of UNESCO’s Creative Cities 
of Music. This can activate the community on 
a global scale and enhance the proposed 
musical identity of the community as a whole. 

Largely	 influenced	 by	 the	 primary	 and	
secondary qualitative data collected and 
analysed, this research-led design project 
suggests a Music Route on an urban scale 
that would form part of the existing Heritage 
Route of Mamelodi East (van der Waal 2000), 
connecting the main nodes of CAFCA at the UP 
Mamelodi Campus, Mamelodi Magnet School 
at Mamelodi Secondary School and Moretele 
Park, with the allowance for future connections 
to be made. 

On a local scale, each node has its own 
typology and programme, addressing each 
situated	 local	 issue.	This	was	 largely	 influenced	
by the different stages of musical exposure 
in a child’s development and its impact on 
their future. Adding to these main nodes are 
schools within the community that participate 
in musical extra-curricular on their respective 

sites. These sites, as mentioned previously, were 
not considered in terms of such activities and 
therefore the built aspects hinder these musical 
activities. It is not intended for these schools to 
become well-established music schools as there 
are already these in the existing nodes. Instead, 
these schools intend to provide a more inclusive 
and all-rounded STEAM education through 
music as the gateway. Tsako Thabo Secondary 
School is one of the schools and is proposed as 
an example of design considerations for the 
other schools. The proposed interventions would 
be implemented in different stages, as inspired 
by Nabeel Hamdi (2010). 

Each main node within the Music Network has 
been considered in terms of a proposal based 
on its existing functions and opportunity for 
connection with one another. 
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URBAN VISION

Fig. 67: Urban Vision sketch concept April (Author 2020)

Through participatory workshops with the 
students of Tsako Thabo Secondary School 
and other knowledgeable role-players, the 
development of an entire Music Network 
took place. This system links to the Mamelodi 
Community of Learning Collaborative (MCLC) 
and	reaches	across	all	anchor	nodes	identified	
within the community. This Network will be 
constantly evolving in terms of connections 
and spatial interventions. Activated by agents 
of change on the ground, the Network is 
decentralized both authoritatively and spatially 
through the sharing of facilities and skills. This 
allows growth over time, introduction of new role-
players and developing existing relationships 
into something more pertinent. Encompassing 
multiple interventions, across scales, sites and 
programmes, each node is connected and 
supported by the other.

Fig. 68: Urban Vision (Author 2020)
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Moretele Park (Proposal)
This node responds to music and architecture as a temporary 
performance. Used ever only for events, the overall stage and set up 
is constructed and then again deconstructed, returning the site to its 
original function, removing the musical performances with it. Not taking 
away from this temporality, the proposal for Moretele Park as a part of 
the Music Network is to act as a conglomerate of the other main nodes. 
Embracing Castells’ (2011) delimitations of networking, the temporary 
stage structure and other interventions required for large outdoor events 
are built up from fragmented pieces from the other sites, each with 
their own function. These functions are re-appropriated when brought 
together, becoming greater as a whole (Augustyn 2018, Castells 2011, 
Kozikoglu & Cebi 2015, Sahyouni 2014). The aim of this proposal is to 
inspire community members, users and stakeholders of each node and 
the surrounding areas to come together and create something that can 
be used to celebrate their cultural history, something of which they can 
be proud. This also provides opportunities for knowledge and skill-sharing 
amongst participants, uplifting the overall community. At the end of 
the event, the shared elements making up the temporary structure are 
dismantled and returned to their original sites and functions. 

This is largely inspired by the interventions done by RAW at the World of 
Music, Arts and Dance (WOMAD) festivals from 2010 through to 2013. 
Roots Architecture is a design/build workshop in the UK that brings people 
with shared interests together to create and build temporary structures, 
functioning as stages and others during the WOMAD world music festivals 
(Schoof 2013). The idea was developed through a constant frustration 
of	 the	 commodification	 of	 architecture	 and	 design	 and	 the	 resulting	
disempowerment of its users (Wood 2012). RAW aims to encourage 
its participants, both professional and laymen, to think beyond the 
structured box and be creative, active and involved. Each year, there 
have been many inspired and clever design outputs, including stages 
that are interactive and create relationships between the musicians and 
the audience; a dynamic energy (Oppenheim 2011). 

As inspired by literature, abstract analysis of the typical music played 
at the festivals using music as a method (Capanna 2009, Tayyebi 2013, 
Young et. al 1993), namely Philip Tabane’s music commemorated 
at the annual jazz tribute concert at Moretele Park found an inherent 
relationship between the beat and the melody, the main vocal and the 
backups; background elements are of necessity to emphasize the main 
element of the show. 

Strings vs percussion: elegant relationship 
between staccato and smooth sounds.

Voices: smooth female falls as an echo  after 
stronger male voice.

ANALYSIS THROUGH MUSIC

User Groups
Performers
Public visitors
Security
Backstage crew
Furniture rentals
Stage setup crew
Portable toilets
Food services
Bars and services
Waiters (VIP)
Cleaners
Medical services
Photographers 

Perform

Fig. 69: Moretele Park site analysis (Author 2020)
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Melodi ya Mamelodi Music School 
(Proposal)
As discussed in the analysis, this existing music 
school is physically separate from the academic 
side of Mamelodi Secondary School. Due to this, 
many students and members of the community 
miss out on the opportunity to be exposed to 
the offerings of music. The proposal for this 
site is to serve as an opportunity for the future 
development of co-music and academic 
schools. This is done through the celebration 
of music and architecture, with music largely 
influencing	 the	 transition	 between	 different	
zones within the school. The idea of physical, 
visual and audible accessibility throughout the 
site	is	influenced	by	the	proposed	drama	of	roof	
overhangs. The roof becomes a performance 
in and of itself, attracting attention and interest 
from beyond the school boundary. The journey 
of music starts from the street, drawing those 
curious into the building and exposing them 
to the experience of learning and performing 
music. 

Analysing the imagery (Capanna 2009, Tayyebi 
2013, Young et. al 1993) of the specialized 
instruments taught at the music school, it was 
found that sound only occurs through the 
interaction and transitioning of an external 
element through, on or with the instrument 
itself.	 This	 largely	 influenced	 the	 relationship	
between music and architecture, looking at 
their intersection and what opportunities were 
provided for interaction, physically, visually and 
audibly. 

ANALYSIS THROUGH MUSIC

Brass: movement through a chamber, air and 
sound crescendo.

Percussion: requires an external element to 
make a sound.

Strings: friction between two elements  
moving in the opposite direction.

User Groups
School learners
Teachers
Music teachers
Aspiring musicians
Admin. staff
Ground-staff
Security
Performers
Kitchen staff
Cleaners
Sports coaches
Live-in staff
Public visitors
Parents 

PerformLearnPractise

Fig. 70: Melodi ya Mamelodi site analysis (Author 2020)
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CAFCA at UP Mamelodi (Proposal)
The arena at UP Mamelodi Campus is, for the 
most part, successful. It does, however, place 
musicians and performers in awkward spaces 
due to the lack of design consideration within 
the building. As CAFCA was developed for 
bridging between different backgrounds and 
providing a stable ground to build futures on, 
the proposed intervention of opening up the 
arena, bringing performance and celebration 
of music and academics right to the entrance 
threshold through architecture, will give music 
a platform within the established pre-university 
academy of the campus. 

Using music as inspiration (Capanna 2009, 
Tayyebi 2013, Young et. al 1993) to analyse the 
context of CAFCA, creating a purpose and value 
for music through architectural interventions 
provides job opportunities for a member of the 
community to build both themselves and each 
other up. The community of music becomes a 
strength in Mamelodi’s identity.  

CAFCA: bridge between different  backgrounds.

CAFCA: building up community and creating 
jobs for musicians.

ANALYSIS THROUGH MUSIC

User Groups
University students
Community  
members
Lecturers
Admin. staff
Ground-staff
Security
Kitchen staff
Cleaners
Public visitors
Parents 
Aspiring musicians
Performers
Sport coaches

PerformPractise

Fig. 71: UP Mamelodi arena site analysis (Author 2020)
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Tsako Thabo Secondary School 
(Design)
Tsako Thabo Secondary School has been 
identified	as	 the	weakest	 link	within	 the	overall	
network but can serve as a fundamental 
precedent for the future development of other 
schools with regards to STEAM education. 
Therefore, this site has been selected for the 
main design proposal for this dissertation. The 
main issue uncovered here is the current linear 
education (STEM) and architecture resulting in 
the exclusion of alternative learning and the 
freedom for learners to express themselves along 
their journey of self-discovery. By not redesigning 
the entire school, the adaptation proves to be 
possible for implementation in current existing 
schools.

Using Capanna’s (2009) methodology of music 
and architectural analysis, the researcher used 
the music and lyrics of AmaPiano songs to form 
an abstract understanding of the social context 
of music in the school. It was found that there 
was a strong correlation between the founding 
beat and the lighter synthetic instruments. The 
lyrics,	specifically	Team	Mosha’s	East and West 
(written about Mamelodi East and West) were 
that of inspiration and pride in the community. 

The process and development of the design 
proposal for Tsako Thabo Secondary School are 
outlined in the following chapters. 

Thula’s Story: micro-network of music education.

Amapiano: typical staccato rhythm over 
synthesized piano chords.

ANALYSIS THROUGH MUSIC

User Groups
School learners
Teachers
Admin. staff
Ground-staff
Security
Kitchen staff
Cleaners
Live-in staff
Public visitors
Parents 
Aspiring musicians

PerformLearn

Fig. 72: Tsako Thabo Secondary School site analysis (Author 2020)
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Ages:

Visiting hours:

# of users:

People from all over 
the country visit 
Mamelodi East to 
experience its rich 
culture, history and 
community. From 
huge annual music 
festivals to walking 
the Music Route, 
everyone feels the 
Mamelodi	vibe	flow	
through their veins. 

Public Visitor

ALL

100 - 
10 000

Ages:

Visiting hours:

# of users:

Since the Music Route 
became	an	official	
leg of the Heritage 
Route tour, multiple 
jobs have been 
created. 
From being the 
tour guide to the 
entertainer playing 
music, ensuring each 
site is communicating 
and well maintained 
is vital to the success 
of the project.

Community Member

16 - 60

100

Identified	User	Groups
The	 following	 user	 groups	 were	 identified	 as	
the predominant and common users of the 
overall network and its individual nodes. These 
users would move between each node within 
the network and perform as the network 
actors (Bencherki 2017), similar to the story 
of the young aspiring musician, Thula. The 
times, several users and proposed ages have 
been assumed based on the data collected 
throughout the 2019 and 2020 mapping 
through participatory research. The narratives 
accompanying	 each	 profile	 is	 also	 assumed	
as a part of this project. 

Network use Network use

Ages:

Visiting hours:

# of users:

Getting through 
school is tough 
enough, struggling 
to learn shouldn’t be 
added to the list of 
problems. When there 
are opportunities 
to learn in a more 
creative way, some of 
our	brains	find	it	easier	
to understand work 
and can concentrate 
for longer periods of 
time. 

School Learner

7 - 20

1 200

Ages:

Visiting hours:

# of users:

Introduced to music 
at any age, the 
musician can partake 
in extracurricular 
activities in order to 
further their passion, 
perhaps all the way 
to a career. 
Learning and 
performing in 
both groups and 
individually creates a 
way for that passion 
to be shared with the 
world. 

Aspiring Musician

7 - 25

200

Network use Network use Fig. 73: User diagram inspired by 
Simmons & Lee 2017 (Author 2020)
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2020 Co-design Workshops
Following the nationwide lock-down in South 
Africa due to the COVID-19 pandemic, the 
participatory workshops and co-design sessions 
for the year of 2020 were held online using 
interactive platforms such as Google Meets™ 
with Google Jamboard™. As unpacked in 
the article attached before this chapter, 
the initial participants from Tsako Thabo 
Secondary School were unable to be reached 
to participate online. Therefore, participants 
needed to be carefully selected based on their 
previous experiences with the context of both 
Mamelodi East and Tsako Thabo Secondary 
School. Fortunately, the researcher had worked 
closely with the UUC Honours group of 2020 
within this exact context and in relation to the 
musical topic of this dissertation. 

Fig. 74:  Researcher’s setup during Co-design 
Session 1 (Author 2020) 
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Tuesday
30 June 2020

Online
Google Slides

AM
10h00 - 11h30 3 participants

Context & user

CD 1A Co-design session 1A: Persona
This	 workshop	 aimed	 to	 provide	 a	 personified	 lens	 through	 which	
participants can respond to the following workshops. Randomizing the 
attributes of the persona removes the facilitator’s bias and preconceived 
user ideas. Each attribute is based on existing user stories from the initial 
mapping stage. 

Session Structure:
1. The facilitator selects three categories: Current Status, Dream and 

Current Issue. Predetermined descriptions for each category are 
numbered according to a dice. 

2. Each participant has a turn to roll the dice three times to determine 
an attribute in each category.

3. Participants are encouraged to provide a brief story about their 
persona,	adding	in	additional	details	they	feel	fit	the	description.	

4. These personae are used for workshops that follow. 

Expected outcomes:	 To	 determine	 more	 specific	 user	 types	 that	 the	
facilitator may not have preconceived. This allows for a wider but still 
focused range of information to be gathered.

This workshop was run virtually using Google Meets™ as the video/audio 
feed, while the group was working together through a shared project on 
Google Slides™. Each participant opened a dice on their own screen 
which could not be seen by the facilitator, therefore numbers could’ve 
been manipulated by choice. This wouldn’t impact the outcomes of the 
workshop.

 Why these participants?
•	 Three University of Pretoria post-

graduate students, each with a 
background in community architecture 
and social inclusion who have worked 
with the UUC in Mamelodi East before. 

•	 These participants have a knowledge of 
the contextual and social issues of the 
area. 

•	 The participants have engaged with 
the facilitator before and have forged 
a collaborative relationship through the 
UUC. 

•	 These participants are the same for 
each co design Workshop 1.

Conclusions: Participants are able to identify clearly with their persona 
and easily get into character for the rest of the session. All three personas 
are extremely relevant to not only students in Tsako Thabo, but any youth 
or adult within the community. Both from users within the school and 
those from the community were covered in order to gain a well-rounded 
perspective of using the site.

Participant A: High school dropout who makes 
music on her phone app. Her dream is to be 
a part of a group with people who share her 
interests. Her school didn’t support her dream. 

Participant B: Standard student at Tsako Thabo 
high school. His dream is to be a successful 
singer. His parents don’t support his dream and 
want him to focus on maths and science.

Participant C: Community member who plays 
the trumpet in her spare time. Wants to inspire 
others with her passion for music. However, she 
is shy because there are many people who bully 
her because they think the trumpet isn’t cool.

PARTICIPANT A PARTICIPANT B PARTICIPANT C

   RESULTS FROM SESSION

Fig. 75: Predetermined categories and attributes for persona workshop (Author 2020)

*Representative sketches
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Tuesday
30 June 2020

Online
Google Slides

AM
10h00 - 11h30 3 participants

Program; concept; schematic design 
development

CD 1B Co-design session 1B: Side-by-Side
This	workshop	reflects	the	value	of	relationships	between	certain	programs	
by	 the	 specific	 context-related	 persona	 chosen	 earlier.	 This	 helps	 the	
designer consider effective program organization. This workshop was 
inspired by the “Side by Side” co-design workshop for The National Design 
Leadership Initiative of Enterprise Community Partners (Hwang 2014). 

Session Structure:
1. The facilitator provided a range of programs that exist between 

Mamelodi High School and Tsako Thabo High School.
2. There were two sets of programs: those with solid lines and those 

with dashed lines, representing open or closed, direct or indirect 
relationships respectively. 

3. The participants each had to pick as many or as little programs 
as they wished and organize them based on their persona’s 
perceived experience, wants and needs.

4. It was emphasized that the layout was based on how they wished 
the programs to relate, not necessarily what is usually expected. 

5. Each participant presented their layouts through a brief description. 

Expected outcomes: Participants would focus on the music-based  
programs, placing them at the centre or most interactive position in the 
layout. Participants would choose many programs and create large 
layout diagrams. 

Virtual adaptation using Google Slides™: each participant had their own 
slide to work on, each with the same number and type of programs. 
Some participants did not understand the solid/dashed line relationship, 
but the relationship between programs was still explained well during the 
discussion. 

Participant A: Library: silence to sit and concentrate on work with 
earphones. Music room: creativity and learn more. Courtyard: meet new 
friends and share interests. Music with courtyard: becomes a stage when 
needed to share with the public.
Participant B: Music close to hall (opening to public): show parents (and 
community) there are different layers of education, not just science and 
maths. Garden and courtyard: sing and showcase to others. Concern: 
music rooms and sounds traveling and disturbing others.
Participant C: Music room: spills out to other spaces (e.g. garden and 
sports	field)	for	performances	and	interaction.	Staff	room:	visual	security	
for bullies but closed so the security is subtle (don’t get the feeling of 
being constantly watched).

Conclusions: Spaces surrounding the music room are serving spaces 
to both standard and musical programs, suggesting much interaction 
between the disciplines. Being connected to outdoors was evident in all 
three options, complimenting the conclusions from the 2019 workshops. 
There was not much interaction with other subjects (e.g. physics, maths or 
history class were all options), all acting separate from one another. This 
contradicts the outcomes of Session 1C. 

Inspired by “Side by Side” co design workshop for The National Design Leadership Initiative of Enterprise Community Partners. 

Fig. 76: Questions for participants 
to consider when arranging their 
programmes. (Author 2020) 

•	 Library: quietness to sit and concentrate 
on work with earphones

•	 Music room: creativity and learn more
•	 Courtyard: meet new friends and share 

interests
•	 Music with courtyard: becomes a stage 

when needed to share with public

•	 Music close to hall (opening to public): 
show parents (and community) there 
are different layers of education, not just 
science and maths.

•	 Garden and courtyard: sing and showcase 
to others

•	 Concern: music rooms and sounds traveling 
and disturbing others

•	 Music room: spills out to other spaces (e.g. 
garden	and	sports	field)	for	performances	
and interaction

•	 Staff room: visual security for bullies, but 
closed so the security is subtle (don’t get 
the feeling of being constantly watched) 

PARTICIPANT A PARTICIPANT B PARTICIPANT C
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Tuesday
30 June 2020

Online
Google Slides

AM
10h00 - 11h30 3 participants

Program; design development

CD 1C Co-design session 1C: Design Crit
Using an existing design proposed by the facilitator (in this case, the 
researcher), the participants were encouraged to re-imagine the spaces 
through the lens of their individual persona. Critique, suggestions and 
comments were all encouraged. This workshop helps the facilitator to 
develop their design from perspectives other than their own.

Session Structure: 
1. The	 facilitator	 briefly	 explains	 the	 design	 plan,	 pointing	 out	

important aspects that have been developed. 
2. Participants are encouraged to circle aspects that work well or 

are not successful in different colours, show arrows or sketches for 
suggestions, make notes on the side etc.

3. Throughout the workshop, participants are encouraged to 
engage with one another and the facilitator, asking questions and 
discussing suggestions.

Expected outcomes: The expectations were to fully engage with the 
design and critique it extensively. Using many tools to visually express 
suggestions	 and	 comments.	 Re-design	 of	 the	 plan	 from	 specific	 user	
lenses.

Due to it being done virtually, the participants did not know how to use 
the drawing tools provided by the online platform. This resulted in more 
discussion and verbal critique than visual expression. Notes were made by 
the facilitator. The participants were shy to start so the facilitator needed 
to ask questions to start off the workshop.

Participant A: Open to the community: inviting and engaging. No 
spaces for introverts (students/musicians) to pull back in to - loud and 
overwhelming (inclusion for all students). It’s not STEAM on its own but 
integration between disciplines, informing each other.
Participant B: All the “cool” things on one edge of the school. Organize 
school according to sound & adaptability of spaces. Levels of transition 
(music, sounds, safety, interaction etc.). Classrooms act as harsh 
boundaries in centre: unsafe & bullying.
Participant C: Proximity of music classes and hall is good but sound travels. 
Buffer zones between different disciplines. Parents and community 
first	 engagement	 with	 music	 (appreciation).	 Music	 as	 an	 overarching	
theme addressing all issues in Tsako Thabo (e.g. bullying, community 
engagement, lighting, corridors, courtyards etc.). 

Fig. 77:  Visual representation of co-design discussion (Author 2020) 

Conclusions: Integration of STEAM through levels and transitions  
between	 zones.	Addressing	 the	 specific	 issues	of	 Tsako	 Thabo	 through	
music and alternative forms of education (more contextually & socially 
relevant than general and assumed). Most suggestions ran parallel with 
outcomes of 2019 co-design workshops.

PARTICIPANT A PARTICIPANT B PARTICIPANT C

•	 Open to the community: inviting and 
engaging

•	 No spaces for introverts (students/
musicians) to pull back in to - loud and 
overwhelming (inclusion for all students)

•	 It’s not STEAM on its own but integration 
between disciplines, informing each other

•	 All the “cool” things on one edge of the 
school 

•	 Organize school according to sound & 
adaptability of spaces

•	 Levels of transition (music, sounds, safety, 
interaction etc.)

•	 Classrooms act as harsh boundaries in 
centre: unsafe & bullying

•	 Proximity of music classes and hall is good 
but sound travels 

•	 Buffer zones between different disciplines 
•	 Parents and community	first	engagement	

with music (appreciation)
•	 Music as an overarching theme addressing 

all issues in Tsako Thabo (e.g. bullying, 
community engagement, lighting, corridors, 
courtyards etc.) 
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Friday
3 July 2020

Online
Google Slides

AM
10h00 - 11h30 3 participants

Concept & design development

CD 2 Co-design session 2: Imagine if…
Participants create imaginary situations by randomly combining an object 
and a property. They then consider what could happen in that special 
situation, discussing creative design implementations. These are then 
reflected	on	for	more	practical	design	solutions.	This	session	was	adapted	
from “Combine and Fantasize” co-design workshop by Studio Delft 
(Hageman & Nieuweboer 2018).

 Why these participants?

For this co-design session, the researcher 
worked with lecturers from the Social Inclusion 
studio of the post-graduate architecture 
program at Chalmers University, Sweden. 
The researcher has a social relationship 
with them due to engagement through the 
NRF STINT research project (as discussed 
in Volume One of this dissertation). The 
participants are professionals within this 
field	of	architecture,	providing	a	high	level	
of qualitative information.

Session structure:
1. The	 facilitator	chooses	 specific	architectural	objects/elements	 that	

are relevant to the context prior to the workshop, as well as some 
musical qualities (properties). 

2. At the beginning of the workshop, encourage participants to suggest 
their own musical properties. 

3. All the objects and properties are covered with respective coloured 
cards and the game board is set-up.

4. Each participant is encouraged to pick a random card from both 
the object and properties pile, placing them on the game board. 

5. The	 other	 participants	 instantly	 propose	 the	 first	 creative	 design	
solution that comes to mind.

6. The	first	participant	who	picked	the	cards	then	questions,	critiques,	
adds to and chooses their favourite option presented. 

7. The round is repeated, with a different participant starting each time, 
as long as the time or number of cards permit.

8. The	 facilitator	 encourages	 reflection	 for	 more	 practical	 solutions	
inspired by the creativity at the end of the workshop.

Expected outcomes: Through the unusual situations created, this game 
stimulates creativity, allowing for unique and creative design solutions for an 
existing issue. Due to the background of the participants, it was expected 
for	social	inclusion	to	be	a	major	influence	on	the	design	considerations.

This workshop was run through Google Slides™, with audio/video through 
Google Meet™. The researcher controlled the tools for Google Slides™ as 
a lesson learned from the previous virtual workshop, avoiding lack of tool 
knowledge from participants.

LIANE THUVANDERMARCO ADELFIOEMILIO DA CRUZ BRANDAO
Architect and researcher within 
the	field	of	sustainable	building.	

Liane focuses on the visualization 
of environmental aspects & 

implementing sustainable design 
within architecture.

(Chalmers 2020)

Urban Planner with an interest in 
multi-stakeholder processes and 

driving forces contributing to 
compact, mixed-use and socially 
sustainable urban development.

(Chalmers 2020)

Director of the master’s 
programme Architecture and 
Planning Beyond Sustainability 

with a focus on social 
sustainability, co-creation and 
participation. He was a part of 

Architects Without Borders (ASF- 
Sweden) for many years.

(Chalmers 2019)
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“Imagine If...” game board showing the object (floors) & the musical property (energetic). 

Conclusions: There are many, many layers of the 
intersection between architecture and music, 
whether this be through inspiration, method or 
image as discussed in the theory (Capanna 2009, 
Young et. al 1993:39). Using the existing structure 
of the buildings to create and manipulate 
spaces through musical qualities creates unique, 
interesting and interactive spaces. Additionally, 
incorporating the performance of music (e.g. 
expression and emotion) into architecture can 
create an inspired intervention that is both 
functional, practically and socially, as well as 
aesthetic. 

Fig. 78: Liane, Marco and 
Emilio during their trip to South 
Africa for the STINT Research 
project (Zorn 2020)

1. “Imagine if the bricks are loud” - very big, overwhelming structure with bricks 
bashing against each other, taking over the space, making me feel small.

2. “Imagine the walls are soft” - the walls allow movement (e.g. jumping) to 
happen against them.

3. “Imagine the concrete is staccato” - sprinkles of concrete, remains after an 
implosion, solid but fragmented, dismantling or destruction of a structure. 

4. “Imagine the roofs are energetic” - meeting space on walkable roof, poetic 
energy below roof storing and collecting intimate moments and memories.

5. “Imagine the beams have emotions” - sense of responsibility, balance and 
spiritual equilibrium 

6. “Imagine	the	floors	are	slow” - you think you are moving fast, but you are slow. 

1 2 3

4 5 6
Fig. 79: Reflective sketches (Author 2020)Some favourite suggestions...
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12 August - 
28 August 2020

Online
WhatsApp

- 3 participants

Music as method for design inspiration

CD 3 Co-design session 3: Rap Battle
When the levels of the lockdown in South Africa had decreased and 
more freedom of movement and interaction was allowed, the researcher 
implemented the Rap Battle. Although the researcher was still not allowed 
to interact with the participants involved, the workshop managed to go 
ahead. This workshop used Capanna’s (2009) music as method concept 
as an abstract informant for the design. 

Rap Battle structure:
1. A catchy and vibrant poster was created and sent to the 

participants (school learners at Tsako Thabo Secondary School) 
through social media applications. 

2. The instructions were to create a one-minute rap or hip-hop song 
to inspire people. 

3. Participants were encouraged to rap about how they see their 
world and how they can bring people together to make their 
community better. 

4. Freedom of music as backing, lyrics, recording options and sound 
making devices were all left up to the participants. 

5. A McDonald’s™ voucher was advertised as the winner’s prize.
6. The winner was chosen by the researcher based on feedback and 

relevance to the topic. 
7. A time period of two weeks was given for the battle to run. 

Expected outcomes: participants would respond with lyrics written about 
the current state of staying at home in lockdown and show support for 
their friends and family as a source of inspiration. 

The methodology and breakdown of this Rap Battle workshop has 
been unpacked in the article written for this dissertation in Chapter 2: 
The Impact of Economic Status on Participatory Design Methodologies 
During A Global Pandemic (Author 2020). 

The submissions for the Rap Battle were beyond expectation in quality of 
both lyrics and musical talent. Students used applications on their phones 
to create professional-sounding backing tracks and recordings of their 
songs. 

(Left) Fig. 80: Rap Battle poster sent to participants over WhatsApp (Author 
2020)

A few select lines of inspiration from the submitted entries 
transcribed	by	 the	 researcher	 (only	 first	names	have	been	
provided in order to protect identities):

“With every sun comes a 
new day”
“My grandpa taught me 
how to lead the way
That’s the thing I got from 
my grandpa
Every time I close my eyes I 
remember”
- Moloko

“Pour me a cup of that vision 
Make sure my stories get 
written for as long as I’m living
For the music I’m driven
For the image I’m driven”
- Memory (winner)

“Ain’t nobody believed in me
You put your faith in me”
 “I’m from the mud, straight out 
of the gutter but I’m going to 
shine”
“I don’t care about the fame
I just want to jump on the stage”
“I was made for it”
- Joel

Conclusions: as informants for the design proposal, the 
music developed in the Rap Battle can be translated into 
architecture through music as inspiration (Young et. al 1993:39) 
and concept or principles (Capanna 2009, Tayyebi 2013). As 
a	 “cup	of	 that	 vision”	 (Memory	 2020),	 inspiration	can	 flow	
through the material choice, geometry, emotion and layout 
of the architecture. It is not about simply providing equipped 
music rooms, but designing places for experiences to take 
place, stories to be told and expression to be celebrated.  

Fig. 81 Selected lyrics from the Rap Battle entries (Author 2020)
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159158 Fig. 82: 1:500 context model of the site in the foreground, with a 1:50 model in the background (Author 2019)

04_SITE ANALYSIS

General Analysis
Tsako Thabo Secondary School is situated on 
Tsomo Street in Mamelodi East. The contours 
slope the site towards the North-West boundary. 
Most of the buildings lie in an East-West 
orientation with larger windows on the Eastern 
side and smaller clerestory windows on the West. 
The main, and only entrance is currently off 
Tsomo Street on the North-East side of the site. It 
is used for both pedestrian and vehicular access 
and is controlled by a single guard, signing 
visitors in and out. Moving through the school, 
starting at the entrance, visitors can be very lost 
due to the lack of “entrance” and direction 
through the school due to the monotonous 
design and single level buildings. As a child, 
making your way through Tsako Thabo school 
is not a pleasant experience. Especially those 
who partake in the seasonal, singular music 
activity: the choir. The choir practiced in an 
empty classroom in 2019 (Author 2019) which, 
although had a good amount of daylighting, 
was cramped and rigid, leaving little room for 
flexibility. The choir master also received many 
complaints about their practice venue due to 
the noise carrying to surrounding classrooms 
and the makeshift library (Interview with Alfred 
Lithuli 2019). In 2020, the choir practiced in the 
school hall (Author 2020). The journey the school 

learners take to get between classes, leaves 
one exposed in the large, open courtyards and 
vulnerable or trapped in the pinched corridors – 
the perfect opportunities for bullies. 

The school hall is lengthy & narrow, susceptible to 
noise and mean onlookers, with a lack of space, 
lighting, acoustic and ventilation consideration. 
There is a slight sense of ownership of this hall 
as patterns and graphics have been painted in 
bright primary colours along the bricks on the 
inside walls. The floor, wall and roof surfaces 
are all hard and reflect sound throughout the 
hall. This is an issue as the sound continues to 
bounce and mixes with other sound reflections. 
The sounds overlap and therefore are not 
crisp and clear to hear in the audience. When 
other instruments, such as the African drum, 
are played with the choir, the sound becomes 
overwhelming and messy. The stage is also 
minute in comparison to the rest of the building 
and only raised slightly off the ground floor 
surface. This would make it difficult for visual 
accessibility for large crowds and audiences 
during a meeting, assembly or performance. 
The larger windows on the Eastern side of the 
hall do not let much light in due to the large 
overhangs, but rather allow for a significant 

amount of noise to travel through from the 
courtyards. This is exceptionally disturbing for the 
choristers practicing during lunch breaks, which 
is the only time the choir can practice (Interview 
with Jacob 2020). Due to the design flaws of the 
school hall, the building becomes an underused 
resource in dire need of a redesign. 
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Fig. 83: Circulation & bullying in corridors (Author 2020) Fig. 84: Sun path & impact of openings on Western facades (Author 2020)

Fig. 85: Noise density (Author 2020) Fig. 86: Vegetation - shading & noise barrier (Author 2020)

Fig. 87: School hall (Greyling 2019)

Fig. 88: School hall stage (Greyling 2019)

Fig. 89: Students watching the choir practice during 
break (Author 2020) Fig. 90: Analysis of school hall (Author 2019)
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Music School Typology Precedents in Pretoria 

ST. MArY’S DIocESAN ScHooL for GIrLS 
PErforMING ArTS cENTrE, HILLcrEST, 
PrETorIA
The Performing Arts Centre (PAC) is separate from the main 
school buildings, housing a variety of cultural activities (van 
Wyk 2014). The grouping of these activities creates a place for 
ownership, where “music is cool” and you want to be a part of 
it (Author 2019). The PAC has its own Concert Hall, small in size, 
with a sprung floor, large teaching rooms and twelve smaller 
practice rooms with sufficient daylighting and ventilation. The 
layout of these programs create an awkward shaped open 
courtyard in the centre which provides an intimate space for 
waiting and socializing between practices and events. THE PAC 
also has a well-equipped Music Technology and Recording 
Studio with all the latest software and sound equipment (van 
Wyk 2014). Academic learners and staff are all invited to use 
this facility, as well as the general public, for a fee. 

Fig. 91: St Mary’s Performing 
Arts Centre (Author 2019)

AfrIkAANSE Hoër SEuNSkooL: ArT 
cAMPuS, HATfIELD, PrETorIA 
(Mathews and Associates Architects, 2014)

Afrikaanse Hoër Seunskool (AHS) has one of the largest music 
departments in South Africa. Jaco van Staden, the Head of 
Department for Melodi ya Mamelodi at Mamelodi Secondary 
School, is a teacher at AHS. AHS offers both individual and 
group learning classes, allowing the collective gathering of 
musicians and skills. The Art Campus aims to bring all of these 
activities together (Mathews 2014) through a vibrant artistic 
precinct made up of a main performance hall, recording 
studio, four classrooms with acoustical design, twenty individual 
practice rooms and admin facilities for staff. Although the 
Art Campus is situated within the larger school campus, it is 
at the back of the academic complex on a small, leftover 
triangular piece of land. This presented opportunities for urban 
corridors and courtyards to be designed, connecting aspects 
of the classes and rest of the school (Mathews 2014). During 
a visit to the campus, the researcher noted that the main 
performance hall in fact had little consideration for natural 
ventilation and lighting and hardly any storage room for the 
chairs, instruments and makeshift stage. The stepped threshold 
between the courtyard and hall hindered and embarrassed 
a guest performer from attending a performance due to his 
wheelchair disability (Author 2019). The courtyard outside 
the hall has an open pergola reflecting the keys of a piano, 
but functionally does not provide covering for visitors during 
the rainy seasons in summer. The individual practice rooms, 
although acoustically designed, are very tight and cramped, 
especially for those learning larger instruments, such as the 
cello. The ceilings are extremely low and uncomfortable with 
little natural lighting from a very small window (Author 2019).  

Fig. 92: AHS Kunste kampus 
(Author 2019)
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EXISTING MATErIAL STuDY
Sites within the Network

• Aesthetic and acoustic properties.
•	 uP Mamelodi: used for sliding panels 

with gaps allowing audible access. 

Timber

• Readily available, cheap, durable, 
very hard surface.

•	 Tsako Thabo: all floors, sealed, hard 
surface that bounces sound.

•	 uP Mamelodi: structural columns, 
external panels. 

concrete

• Readily available, cheap, can create 
interesting aesthetics. 

•	 Tsako Thabo: painted exterior, 
exposed interior. 

•	 uP Mamelodi: semi-permeable and 
aesthetic.

Exposed masonry

• Expensive, durable, easily made 
aesthetic.

•	 Tsako Thabo: horizontal and vertical 
members. 

•	 uP Mamelodi: horizontal members.

Structural steel

Affordable and readily 
available materials.
Not much consideration for 
acoustics or sound quality.
Important to respect  
material properties but also 
test their limits. 

• Readily available, cheap
•	 Tsako Thabo: exposed and effects the 

acoustics within the Hall. 
•	 uP Mamelodi: easily forms the  organic 

shape of the roof. 

corrugated roof Sheeting

• Finishes interior well - aesthetic.
•	 Mamelodi Magnet School: entire 

inside is painted.
•	 Tsako Thabo: paint used to express 

ownership and positivity. 

Plaster and paint

• Readily available, slightly pricey, 
durable, hard surface, can create a 
harsh glare.

•	 Mamelodi Magnet School: laid in an 
angled pattern, reflects sound.

Tiles

•	 Tsako Thabo: none.
•	 Mamelodi Magnet School: 

implemented.

ceiling board

Fig. 93: Existing material palette 
(Author 2020)
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Acoustic qualities

• Relatively durable 
• Hard reflective surface
• Can create interesting patterns and 

movement with different layouts 
(expression)

• Creates sound when walked on

Laminated	flooring

• Predominantly little effect on acoustic 
qualities of a surface 

• Impacts other materials aesthetically

Paint

• Reflective surface with little absorptive 
properties

• Masonry walls act as sound insulators 
(especially cavity walls)

Exposed masonry

• Absorptive surface
• Can be used on both floors and walls
• Maintenance required
• Quiet surface for circulation 

carpet

EXISTING MATErIAL STuDY

• Hard reflective surface
• Emits sound when contacted (e.g. 

walking on paving with hard shoes)

Paving

• Reflective surface
• Structural function for acoustic panels/

ceiling/roof etc. 

Structural Steel

• Alternating reflective and absorptive 
panels on walls and ceilings for best 
effect

• Timber, stainless steel, gypsum etc. 

Acoustic panels

• Alternating reflective and absorptive 
panels for best results

• Can be created in an interesting 
design

• Suspended ceiling allows sound to 
travel through and be absorbed in 
space beyond

ceiling board

Fig. 94: Acoustic material 
palette (Author 2020)
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Main
Entrance

Entrance 
Courtyard

Parking

Care-
takers
House

Guard

Library

Admin Block

STEM 
Classrooms

Hall

STEM 
Classrooms

STEM 
Classrooms

Art 
Class

Staff 
Room

Board 
Room

Kitchen

WC

Courtyards

Courtyards

row 3

row 2

row 1

WC

Controlled 
Public

Open
Public

Private 
Access

Public

Private

EXISTING ProGrAMME TSAko THABo SEcoNDArY ScHooL

The school is predominantly 
STEM education focused 
with little integration with 
other forms of education. 
This is evidently impacted 
the architecture in layout 
and proportion. There is 
only one route in and out 
of the school, controlling 
movement and visitors. The 
academic programmes 
are largely separated from 
the other programmes and 
surrounding community. 

Controlled 
Public

Open
Public

Private 
Access

Public

Private

ProPoSED ProGrAMME

Existing

Parking

Care-
takers
House

Guard

WC

The Performance Centre aims to 
integrate different programmes 
with one another, influenced by 
the Wesley College precedent 
(next page), in order to provide 
users with many opportunities 
to collaborate and learn across 
disciplines. There are additional 
servant  spaces that have not 
been included in this diagram 
(see detailed programme 
requirements). 

Main
Entrance 
& Admin 

block

Central 
Courtyard

Spine

Hall
Foyer

Multipurpose Hall

Multipurpose
STEAM 

Classrooms

STEM 
Classrooms

WC

Library

Vehicular 
Entrance

Outdoor
Field

Cafeteria & 
Kitchen

WC

Sound 
Studio

Performer 
Entrance

Back-
stage

Perform
ance centre

Community
Engagement

Community
Engagement

Community
Engagement

Community
Engagement

Community
Engagement
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Music & performing arts 
centre:
incorporation of  
multiple departments 
allows for one to learn 
from the other and 
gain inspiration

courtyard character:
movement through 
the building, ease of 
access, connection to 
surrounding landscape, 
outdoor performance 
spaces. 

Interconnecting  
volumes “sound 
chamber”:
where all   
departments meet; 
interactive, multi-
functional  and  
collaborative space.

facade composition:
rhythmic patterns 
representing the de-
constructed school 
crest. Gives dynamic 
and  musical feel. 

4 key features

Fig. 96: Key musical aspects of Wesley College 
design (Gardiner 2013)

ProGrAMME PrEcEDENT: WESLEY coLLEGE MouBrAY STrEET 
MuSIc ScHooL, MELBourNE, AuSTrALIA

(coX Architecture 2013)

Centrally located facility that houses the 
departments of music, performing arts and 
digital arts. Each department has its own 
required internal spaces that visually impacts 
the exterior rhythm of the facade. The school 
also houses individual spaces for practicing and 
performing as well as multipurpose classrooms.  
By overlapping all of the departments in the 
centre of the building at the Sound Chamber 
Staircase, there is an opportunity for constant 
collaboration. This results in the sharing, 
interaction and exchange of information 
between all departments (Cox 2013).

Fig. 95: Wesley College rhythmic facade (Author 2020)

Sound Chamber 
staircase

Secondary 
staircase

Stretcher 
lift

Internal Courtyard Cafeteria

Adamson Hall

Change 
rooms

Black Box 
Theatrette

Dance Studio

Service 
& Loading 

zone

Storage

Recep-
tion Library Foyer

Drama studio

Recital Hall

Sin-
gle

tuition 
spaces

Ensemble 
practice

Rehearsal 
studio

Communal area

Computer 
lab

Staff

Controlled 
Public

Open
Public

Private 
Access

Public

Private Fig. 97: Wesley College programme 
diagram (Author 2020)
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Name Description Users Size (m2) Amount Requirements

Main Entrance & Admin Block

School reception
The first space visitors come into 

contact with when entering the school 
(visual & physical) with printer and storage 

space. 

42 
(min. 15*) 1 Waiting space

L T P

S o

Staff	offices Offices for administrative staff with storage 
space.

55 
(combined) 4

Principal,  
Administrative 

Personnel

L T P

S o

Staff bathrooms 
(unisex)

Private bathrooms for staff and teacher 
access only. 28 1 <30 people (G1): 

4 WC, 2 WHB
L T P

S O

Staff bathrooms 
(Disabled)

Private bathrooms for disabled staff and 
teacher access only.

(included 
above) 1

1 WC & 1 WHB 
Min. area 2.9m2

Min. dimension 1.6m

L T P

S O

Staff room
Break room for teachers & staff, equipped 
with seating & a kitchenette (fridge, sink, 

kettle, storage etc.)
40 1 <30 people (G1): 

3 WC, 2 WHB
L T P

S O

Sick room
Quiet space away from noisy programmes 
for children or adults to rest. Equipped with 

storage and clean facilities with direct 
access to reception.

10 1 Minimum two beds, 
storage and fresh air

L T P

S O

*Rooms and minimum sizes and requirements according to DBE Guidelines 
2012 and in accordance with SANS 10400.

ProPoSED ProGrAMME & rEQuIrEMENTS L

T

P

S

o

Learners

Staff

Teachers

Outside visitors

Parents

Natural ventilation

Multi-functional spaces

Natural daylighting

Acoustic consideration

Connection with outdoors

Name Description Users Size (m2) Amount Requirements

Boardroom A quiet space with furniture that can be 
moved around to suit conference needs 45 1 15 - 30 people

L T P

S o

L T Pcleaner’s closet & 
storage Store for cleaning chemicals & equipment. 4,5 1 Secure locking, hard-

wearing
L T P

S O

Academic

STEM classrooms Existing classrooms for standard learning. 
Improvement of requirements. 45 - 60 19 15 - 30 people

L T P

S O

STEAM classrooms
Widely adaptable and open classrooms 
with spaces both inside and outside for 

alternative learning.
45 - 135 8 15 - 50 people

L T P

S o
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Name Description Users Size (m2) Amount Requirements

Student
Bathrooms

Unisex & disabled bathrooms that are an 
upgrade from the existing in terms of 

safety.
73 2

300 girls
300 boys
Disabled

L T P

S O

L T P
courtyards

Open aired spaces that are used 
predominantly during break times by 

students. Spill out spaces for classrooms 
(STEM and STEAM).

2920 -

Visual safety
Storm water drainage

Adaptable
Seating

L T P

S O

Parking Existing parking for teachers and visitors. 400 1 Security
30 cars

L T P

S o

Academic Ancillary Spaces

Main 
foyer

Gathering & spill out space for audience 
members for events. 268 1

Tangible objects to 
congregate around 

(PDW 3 2019)
Minimal seating

Fire safety

L T P

S o

cafeteria
A small kitchen that provides meals for 

students during the day and visitors and 
performers during events (music & sport). A 
source of income for community members.

655 1 Basic kitchen to serve 
600 students & visitors.

L T P

S o

New Performance centre

Main Hall
Large hall with loose seating that allows for 
multiple uses - indoor sports, performances, 

dances, large conferences, school assemblies, 
community meetings etc. Acoustics NB.

633
(180* min.) 1

650 Seats
Fire safety
Acoustics

Durable flooring

L T P

S o

*Rooms and minimum sizes and requirements according to DBE Guidelines 
2012 and in accordance with SANS 10400.

Name Description Users Size (m2) Amount Requirements

Backstage
Areas dedicated to performers to get ready 
and wait during performances and events. 

Additional smaller spaces for rehearsals (black 
box setting).

570 1

Rehearsal space
Unisex WC

Storage & lockers
Adaptable
Fire safety

L T P

S o

L T P
Main Stage

Largely adaptable stage for different uses. 
Off-stage wings.

Acoustic properties.
530 1

Durable flooring
Multiple 

configurations
Indoor & outdoor

L T P

S o

Balcony
To provide additional seating, performer 
movements during events or additional 

lighting/decoration support.
280 1

Railing
Fire safety

Visual accessibility

L T P

S o

Sound Box
Room for all technical and lighting support 
systems. Clear and unobstructed view to 

stage and hall at all times.
20 1 Fire Safety

Ventilation & lighting
L T P

S O

Storage
Storage for all chairs (Room & under the 

stage) & other furniture items e.g. 
conference tables.

10 each 2 Fire Safety
L T P

S O

outdoor 
Amphitheatre

Permanent seating used for community 
meetings, watching outdoor sports, outdoor 

performances etc.
280 1

Durable material
Multiple uses
Orientation & 

weather

L T P

S o

Performers’ 
Entrance

Welcoming entrance space that is controlled 
with a reception and office. Space for visitors 

or music-enthusiasts to socialize.
215 1

Reception
Small office

Pausing space

L T P

S o
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Name Description Users Size (m2) Amount Requirements

Bathrooms (unisex)
Bathrooms including disabled.

Divided throughout the Centre to serve all 
programmes.

263 
(combined) 4

<1000 people (A2): 
15 WC, 4 WHB (min.)

1 Disabled

L T P

S o

Delivery zone Drop off zone for equipment, furniture, food 
deliveries etc. - 1 Direct to road

Back of house
L T P

S o

Waste & 
recycling

Close to kitchen & cafeteria.
Recycling bins that can be accessed from the 

road (pick-up).
90 1

Direct to road
Back of house

Security

L T P

S o

Electrical room HT-LT room with a generator, fuel storage and 
transformers for solar panels. DB cupboard. 15 1

Natural ventilation
Ground floor

Council access

L T P

S o

Performance centre Ancillary Spaces

L T Pcleaner’s closet & 
storage

Store for cleaning chemicals & equipment in 
the Performance Centre. 4 2 Secure locking, hard-

wearing
L T P

S O

L T P
Dry and cold store Shelves for food & cooking equipment. 

Walk-in fridge for cold food store. 35 1 Near duct for 
drainage

L T P

S O

Shower rooms 
(unisex)

Shower and change rooms for sport 
activities with locker spaces. 45 1 <20 people (A2): 

4 Showers (min.)
L T P

S o

# of peak users:

PErforMErS
Whether these are 
performers of sport, food or 
music, they travel to express 
themselves at the Centre, 
sharing knowledge and skills 
along the way.

VISITorS

30
M  T  W  T  f  W/E

AM

PM

# of peak users:

coMMuNITY MEMBErS
Intrigued by the architecture 
and passion, friends, families 
& others come to watch 
different performances and 
be exposed to the underlying 
talent of Mamelodi East.

500
M  T  W  T  f  W/E

AM

PM

# of peak users:

ScHooL LEArNErS
In need of facilities to 
practise and perform, 
learners and teachers from 
other schools come to the 
Centre, engaging with those 
at Tsako Thabo. 

50
M  T  W  T  f  W/E

AM

PM

# of peak users:

STEM LEArNErS
Passing through high school 
with their main focus on 
academics with little interest 
in other aspects.

LEArNErS

400
M  T  W  T  f  W/E

AM

PM

# of peak users:

STEAM LEArNErS
Learning through alternative 
methods i.e. incorporating 
music into Maths class, 
makes it easier for these 
learners to understand and 
pass. 

200
M  T  W  T  f  W/E

AM

PM

# of peak users:

EXTrAMurAL LEArNErS
With a passion for sport, 
music or nutrition, these 
learners engage in after 
school activities to further 
learn what the Centre has to 
offer.

100
M  T  W  T  f  W/E

AM

PM

# of peak users:

TEAcHErS
Whether these teachers are 
STEM or STEAM, they have a 
world of knowledge to pass 
on to their students, with little 
distraction, much motivation 
and a love of learning more. 

STAff

30
M  T  W  T  f  W/E

AM

PM

# of peak users:

ADMIN STAff
From the principal to the 
accountant, these staff are 
the bones of the school, 
organizing, ensuring and 
maintaining a happy 
schooling experience for all.

15
M  T  W  T  f  W/E

AM

PM

# of peak users:

GrouND STAff
The foundation of the school. 
Cleaning, gardening, fixing 
and securing takes up a lot 
of time and effort to ensure 
the school and Centre can 
run smoothly. 

15
M  T  W  T  f  W/E

AM

PM

ProPoSED uSEr GrouPS
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Fig. 98: Concept graphic showing the 
“explosion of expression” (Author 2020)

05_RESPONSE: CONCEPT
This chapter aims to provide an outline of 
the overall concept presented in the design 
portion of this dissertation. It is then followed 
by the specifics of both design and technical 
development. To begin, a summary of the 
general, urban and architectural issues is 
required. 

General Issue
Generally, the typical school typology 
implemented at Tsako Thabo Secondary School 
does not allow for freedom of alternative 
learning and inclusion of many different types 
of learners. The curriculum is STEM (Science, 
Technology, Engineering, Mathematics) 
focused, resulting in rigid education with which 
a lot of students struggle. Recreational activities, 
such as the choir, art classes and sports are 
seasonal activities that do not have prescribed 
spaces. This ultimately results in little to no sense 
of belonging and acceptance for a lot of 
learners within the school.

Urban Issue
The urban issue presented here is that of 
disconnection between the school and the 
surrounding community, including minimal 
interaction with other schools in the area. This is a 
missed opportunity as each school or institution 
could share facilities and resources in an effort 

to uplift the Educational Ecosystem of Mamelodi 
East. Again, it can result in community members 
lacking a sense of belonging and identity, both 
on an individual and community scale. Little 
inspiration then flows through the streets, missing 
the open door for upliftment. 

Architectural Issue
The form of the school buildings hinder the 
opportunities for positive self-expression and 
development of identity due to its rigid and 
contained layout. Harsh boundaries surround 
the school, creating a clear division from the 
community. The buildings exhibit a severe 
lack of consideration for privacy, acoustics, 
natural ventilation, daylighting, spatial layout, 
accessibility and a built identity, especially the 
school hall. 
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Concept Narrative
Following Nabeel Hamdi’s (2010:67) concept of 
“now, soon, later”, small changes are proposed 
for immediate integration, followed by small 
scale design implementations in the near future. 
Lastly, a large-scale architectural intervention 
will be implemented later to fully serve and 
uplift the school and surrounding community 
in response to the abovementioned issues and 
overall research question. 

The concept, for now, is to integrate STEAM 
(Science, Technology, Engineering, Arts, 
Mathematics) into the curriculum, providing 
alternative forms of education that are inclusive 
and allow more opportunities for learners to 
lead successful and experiential educational 
careers. 

Following this, the existing architecture needs to 
be adapted to accommodate these new forms 
of learning. The soon stage looks at stripping 
away the existing structure and refurbishing it 
in terms of natural ventilation, daylighting and 
especially acoustics. Taking the concept of a 
typical learning environment and spilling it out 
into the courtyards with interactive seating and 
platforms, with expressive roofs and overhangs 
creating a comfortable yet enjoyable space in 
the shade. This intervention was largely inspired 
by the principles drawn from the Korogocho 
Streetscapes, whether these spaces be used 
for formal or informal learning or socializing. 
The classrooms along the boundary edge are 

proposed to open up and provide spaces for 
the community to integrate with the school 
through learning and skills development in the 
afternoons and on weekends. This stage serves 
as a very plausible precedent for other schools 
and institutions to adapt and integrate with 
STEAM and the community.

The later stage, and the focus for this dissertation, 
is the demolition of the fatally flawed existing 
school hall and replacing it with a large scale 
Performance Centre. Metaphorically, the 
Performance Centre is the epicentre of a musical 
and expressive explosion, rippling out through 
the landscape and impacting change through 
the site and proposed Music Network within 
the community. This intervention celebrates 
identity, expression and performance across 
many aspects of a developing child’s life, 
from music, academics and sport, to nutrition 
and everyday life. The existing admin block 
has also been affected by this explosion and 
has been developed to serve as an exciting 
and welcoming entrance, exposing those 
beyond the school boundaries to the idea of 
encouragement of positive self-expression and 
celebration of identity. 

Acoustic consideration becomes the most 
dominant influencer throughout the design of 
the site, both aurally and visually. From “loud 
bricks” (Co-design session 2 2020) to the rhythm 
of water fountains, there is constantly a sense 

of acoustic integration as one moves through 
the site. Not only increasing the interior acoustic 
qualities of the existing classrooms, but also 
ensuring sound does not add to the list of issues 
of the site. By incorporating natural sound 
elements, such as water and vegetation, the 
transition of noise between programmes, both 
within and beyond the site boundaries, can be 
designed and controlled. 

The acoustic design of water elements relate to 
the architecture through rhythm, movement and 
sound (Songabau 2019). This expression of water 
is given an opportunity through the catchment 
and reuse of rainwater collected throughout 
the site, both existing and proposed. Adding to 
this sustainable aspect is the implementation 
of ground cooling of the natural ventilation fed 
into the main hall. This is assisted through the 
function of the stepped roofs, housing fans for 
the removal of the hot air within the building, 
expressing the implementation’s process. 
The roofs’ openings towards the South allow 
a consistent flow of daylighting into the hall, 
adding to the environmental considerations. 
Lastly, the landscape is reused as much as 
possible across the site in order to ensure a 
sustainable approach is taken towards the 
intervention. 
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Stages of Design Interventions

STEAM education for inclusion of all 
students.

Development of STEAM classrooms & 
courtyards for social & interactive learning.

School Hall & amphitheater for larger 
engagement with the community & 
exhibiting of The Arts within the school.Small scale intervention

Medium scale intervention

Large scale intervention

Unique & bespoke to each school

Adapted to needs of each school
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Through many iterations of basic drawings 
and parti diagrams, it was found that a major 
shift in architectural language needed to be 
embraced. As a part of the Music Network, this 
language needed to be identifiable throughout 
the networked nodes in order for it to make 
sense and have its necessary impact. Following 
the principles of The Gestalt Theory (Sahyouni 
2014) reviewed in the literature, similarity is the 
most obvious principle for users to identify and 
recognize. Therefore, it was vital for this aspect 
to be unique in form and stand out from the 
existing built environment of the community. 
This was needed in order to answer the initial 
research question of exploring the effects 
of music-making within Mamelodi East as a 
positive platform of self-expression for school 
learners and the surrounding community. It was 
imperative for the building to be dynamic and 
have energy, to use music and performance as 
the driver for uplifting the community as a whole 
(Grundtman 2016, Young et. al 1993).  

This intervention acts as the flagship for the 
proposed Mamelodi Music Network, feeding 
into the global project of UNESCO’s Creative 
Cities. This will put Mamelodi on the map and 
bring inspiration and pride to the community. 
The Performance Centre stands out from the 
surrounding community respectfully and inspires 
its users. The architecture is made up of expressive 
symbolism: platforms and acoustics driving the 
overall language, challenging the rigid grid 
and creating a new identity for both the school 
and the community founded in Mamelodi and 
her citizens’ past, present and future in music-
making. The Performance Centre is grounded 
by the existing school language and filled in 
with expressive lighter elements and roofs, 
interacting between both architecture styles 
and academic disciplines, as highlighted in Co-

Fig. 100: Section parti diagrams expressing the concept (Author 2020)
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Literature, co-design sessions and thorough 
analysis is summarized into the following 
conceptual intentions for the design development 
of the Performance Centre. 

•	 The intersection between performance 
and architecture creates a new collective 
identity for Tsako Thabo Secondary School 
and the surrounding community.  

•	 Platforms provide places for performance 
and positive self-expression. 

•	 The concept of networking runs through-
out. Celebrating each aspect in a child’s 
academic life in a way that generates a 
greater whole, as well as the detailing of 
the architecture working together and 
adding to the overall narrative.

•	 Providing places for expression allows de-
centralization of authoritative and spatial 
hierarchies, allowing freedom of perfor-
mance and expression.

•	 Participating both in the design develop-
ment, with the end proposed design inter-
vention and across the networked nodes, 
enhances the relationships between and 
within the school and community. 

design Session 1B (2020). The transition of music 
and performance became vital, according to Co-
design Session 1C (2020), as a way of addressing 
both the research question and the existing issues 
found within the school. 

From exploring the existing site, multiple 
opportunities were made available for the 
integration of the architectural intervention with 
the surrounding site and community. Using the 
Law of Similarity (Sahyouni 2014), the individual 
networked nodes are brought together by 
the expressive elements rippling through the 
community, providing opportunities for social 
interaction (Dovey & Dickosn 2002, Hillier 1996, 
Lawson 2005) through their connections and 
boundaries (Kozikoglu & Cebi 2015). These 
opportunities are enhanced by the shift of 
decision making from those in power to those 
within the nodes, directly linking to the community 
(Ndeneche 2011). This is further made possible 
through the physical decentralization of decision 
making (Seal 2020) across the musical nodes, 
integrating deeper into the community. As 
proved successful in the Korogocho Streetscapes 
project, Memphis Slim Collaboratory and 
UNESCO’s Creative Cities of Music, the proposed 
intervention uses the music nodes to network and 
transform the community through exposure and 
celebration of its underlying potential. 

Fig. 101: Design development collage (Author 2020)
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SCHOOL 
ENTRANCE ADMIN BLOCK CLASSROOMS

ENGAGE

PERFORM

ACOUSTICS

APPROPRIATE

TRANSITION

WATER

In response to these intentions, six design strategies were 
developed in order to ensure a relevant language that 
is theoretically, architecturally, programmatically and 
conceptually driven. Each strategy is considered within their 
relevant programmes and places, often integrating with 
another strategy as well. 

Engage: this is defined in terms of accessibility. Not only visual 
and physical access with areas across the site, but also 
audible access as a way to encourage interaction through 
interest and curiosity.  

Perform: enhanced by raised levels and framed views, 
music, academics, sports, nutrition and everyday life is put 
on display and the performance of each is celebrated. 

Acoustics: throughout the site it is vital to consider the 
travelling of sound and noise, both outdoors and indoors. 
Acoustic reverberation, insulation, isolation and interference 
are all great influences on the architectural consideration of 
places. 

Appropriation: due to the integration of STEAM education and 
the intent to celebrate all aspects of a child’s development, 
both formal and informal, place appropriation is required. 

Transition: performance becomes the transitional layers 
while moving through the site. Whether this be level changes, 
thresholds above, accessibility or acoustic considerations. 
(three transition typologies sketches)

Water: as a part of the sustainability of the site, water is also 
largely used for the acoustic qualities of outdoor spaces. In 
some cases, the water camouflages and masks unwanted 
noise, in others it is a physical element of guidance. 

These strategies are refined and carried through both the 
design and technical development of the performance 
centre.

COURTYARDS FOYER HALL CAFETERIA CIRCULATION AMPHITHEATER EDGE SPORT
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Design Iterations

Concept Precedent

06_DESIGN DEVELOPMENT
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Fig. 102: Photograph of 1:200 model (Author 2020)

06_DESIGN DEVELOPMENT
Throughout the process, and within the principles 
of participatory design, iterative exploration 
is vital (Simonsen & Robertson 2013). Each 
iteration was critiqued and reflected on by 
both the researcher and other members of the 
UUC. As the design intervention is intended to 
act as a flagship of expression for the proposed 
Mamelodi Music Route, the roofs became a 
driving factor from the very beginning. Further 
along the design process, the expressive quality 
of the form and roofs were derived from music as 
inspiration, concept and the relation to design 
principles (Capanna 2009, Tayyebi 2013). This 
inspiration was analysed and inspired by the 
abstraction of the AmaPiano music genre and 
Thula’s music networking story within the school. 
These underlying music narratives have acted 
as the “leap vehicle[s]” (Young et. al 1993:39) 
through which the architectural language has 
been designed. 
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Iteration 1: June
Prior to this iteration, an analysis and comparative 
table was drawn up between Mamelodi 
Magnet School and Tsako Thabo Secondary 
School. This was done in order to determine 
which site would be most beneficial in terms of 
providing an example for other schools across 
the community. Tsako Thabo was chosen as it 
serves as the weakest link in the overall network 
and can be used as the most relevant example 
for other schools. 

The first iteration was very subdued and worked 
a lot with the soon and later stage (Hamdi 
2010) of the school. Prioritizing the orientation 
of the school hall, this iteration sets out the 
school as largely separate from the majority 
of the community. It was further taken online 
to Co-design Session 1 and developed to use 
the existing buildings as much as possible. 
Extension and celebration of existing structure 
began creating new spaces for interaction 
and alternative learning. The connection with 
the community was inspired by the small-scale, 
high-impact implementations of Korogocho 
Streetscapes (Höök 2016, Skottke 2016). The 
classrooms opened up to the activities across 
the street, exposing the surrounding community 
to music and other activities at an interactive 
scale. This also provides the opportunity for 
micro-networking between the school and 
the community through music. As argued by 
Koopman (2007), this community music-making 
encourages social cohesion, creativity and 
positive self-expression. The idea of platforms and 
performance started making an appearance as 
a way of transforming the edge conditions into 
a common performance ground (Höök 2016, 
Skottke 2016). This intervention was still at a very 
small scale and needed further developing. 

Fig. 103: Maquettes investigating the existing 
school structure (Author 2020)

Fig. 104: Initial design sketch of the soon 
stage interventions (Author 2020)
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Iteration 2: July
The second iteration followed Co-design Session 
2 which, in section, was largely impacted by 
the creative architectural solutions posed in 
the workshop. This iteration further developed 
the soon stage of the intervention with regards 
to the STEAM classroom adaptations. The 
hall started developing at a larger scale as 
a hierarchical response, with fragmented 
elements that would later inspire the overall 
language of the design. These fragmented 
elements started bringing through the language 
of networking in architecture, allowing potential 
social interaction (Kozikoglu & Cebi 2015).  
The main axis was developed and existing 
buildings that were completely hindering the 
opportunity of performance and expression 
were reconsidered. The roof started becoming 
a performance of its own, influenced by some 
acoustics and daylighting. The overall emotion 
of the roof (Young et. al 1993) was influenced by 
the upbeat and positively inspiring AmaPiano 
music that is extremely evident in both the 
school and the surrounding community. The 
roof also started framing views and guiding 
movement through the site, influenced by the 
alignment depicted in The Gestalt Theory’s Law 
of Order (Augustyn 2018, Sahyouni 2014). 

Fig. 105: Plan and section investigations 
(Author 2020)
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Iteration 3: July - August
The third iteration sees the first development 
of the Performance Centre, including music, 
sports, nutrition and academics. The concept 
of performance started going beyond the 
built intervention and started at the street, 
spilling into the community. The fragmented 
elements started playing a bigger role in the 
overall design. This is significant in the design as 
it begins to respond to the research questions in 
terms of providing a platform for expression and 
discovery of self, overall empowering both the 
individual and the community. The intersection 
of multiple programmes within the Performance 
Centre, as influenced by the Wesley College 
precedent, added to the value of the greater 
whole (Ndeneche 2011). Principles from The 
Gestalt Theory of symmetry, grouping rhythm 
and order were also pulled through the design 
(Sahyouni 2014). Spaces were provided for 
group music making and other forms of group 
interaction as a place for social, cognitive and 
emotional development, as inspired by the 
outcomes of the El Sistema project (Majno 2012, 
Tunstall 2013). The concept for water as a sound 
barrier was also introduced. 

The endless iterations of the roof began at this 
stage. Initially, the roof iterations were done 
based off the researcher’s instinct in order to 
get an overall idea of what the possibilities were. 
These were then influenced by the acoustic 
qualities as well as the structural implications. 
The roofs’ overall expression was largely inspired 
by the findings from Co-design Session 2, where 
the roofs were imagined to have energy. This 
influenced what the roof was creating below: 
meeting spaces, spaces to create memories, 
social interaction etc. Starting with an organic 
type roof, the intersection between orthogonal 
and organic became important. From an 
acoustical point of view, this type of geometry 
actually proved to be less effective when 

Fig. 106: Organic roof explorations 
(Author 2020)

carrying sound than its more linear counterpart. 
Following this, a more reserved set of roofs were 
developed as lighter elements that simply sat 
over the main structure of the Performance 
Centre. In some cases, the roof touched the 
ground lightly, defining movement on the 
pedestrian scale. This principle was developed 
further, looking at how one could slip behind 
the roof which created a new space within 
the building. Where the roof touched down to 
the ground, the idea of roof as threshold was 
explored: where does the roof become a wall? 
Does the roof create visual, physical or audible 
boundaries? 
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Iteration 4: September 
Looking at the current design in context 
and with the contours of the site, it became 
important to decide whether the proposed 
language wanted to relate to the existing or 
stand proud. Where did it become appropriate 
to challenge the rigid geometries of existing 
architecture? This was greatly inspired by the 
initial fragmented elements of the amphitheatre 
in Iteration 2, subtly pulling through the concept 
of expression into the architecture. Transition 
spaces, movement, interaction between 
“performances”, harmonic and rhythmic 
considerations (Capanna 2009, Young et al. 
1993) were all redefined and iterated during this 
design iteration. This was largely influenced by 
the conclusions drawn from the theory triangle 
of relationships between music, architecture, 
participation and networking. 

(Photographs) Fig. 107: Orthogonal roof 
explorations (Author 2020)
(Sketches) Fig. 108: Incorporating an expressive 
language on plan and site plan (Author 2020)
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Iteration 5: September
This iteration redesigned the previous iterations’ 
explorations. From the roof becoming wall 
and threshold, to slightly challenging the grid 
for acoustic purposes. Transition spaces and 
functional requirements were all the same 
and the design started to become rigid and 
repetitive. The kinetic energy and expressive 
aesthetics were missing. Taking the design 
back to its simplest attributes, the plan and 
section parti diagrams were explored through 
a collaborative workshop with other members 
of the UUC studio. It was concluded that a shift 
in language was imminent in order to respond 
to the overall research question. This current 
design was not achieving that. The first cutting of 
the landscape for the Lower Ground Floor was 
taken into consideration here. This provided an 
opportunity for sustainable reuse of the cut land 
as fill for underneath the ground floor, as well as 
opening up and connecting to the community 
along the Western threshold of the site.

(Photographs) Fig. 109: Additional roof 
explorations (Author 2020)
(Sketches) Fig. 110: Refining the plan and 
sections (Author 2020)
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(Photographs) Fig. 111: Roof implications with 
existing classroom roofs & site (Author 2020)
(Sketches) Fig. 112: Detail exploration of 
connections, plans and sections (Author 2020)
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(This page) Fig. 113: Development of the plan 
parti diagram (Author 2020)
(Opposite page) Fig. 114: Development of the 
section parti diagrams (Author 2020)
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Iteration 6: October
Finally, expression revealed itself, at least 
in section. Inspired by the developed parti 
diagrams, this iteration saw the beginning of the 
biggest changes in architectural language and 
decision making. Inspired predominantly by the 
relationship between acoustics and expression, 
the section started becoming interesting. 
Stereotomic elements were introduced and 
exaggerated, holding the performance space 
and relating to the fragmented elements. This 
was achieved through the inspiration of music 
(Capanna 2009), specifically the relation of 
the different sounding instruments coming 
together and forming one harmonious piece. 
The different languages of architecture were 
considered on a more detailed level, coming 
together as a network of architectural elements 
forming a whole harmonious design (Dovey 
& Dickosn 2002, Hillier 1996, Lawson 2005). On 
plan however, this still lacked in an explosion of 
expression. Looking at the developed maquette, 
the overall building still felt overly controlled and 
rigid. 

(Photographs) Fig. 115: Investigating the 
terraced roof on site (Author 2020)
(Sketches) Fig. 116: Implications of the roof on 
plan and section (Author 2020)
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Iteration 7: October
Developing the previous iteration’s parti 
diagrams and being free from the rigid grid 
resulted in a far more expressive language 
coming through. The technical concept of 
stereotomical structures grounding the overall 
building, with expressive elements and a 
light roof spanning off them was developed. 
Circulation became an aspect of performance 
and expression, while the conversation 
between ordered and offset began in a way of 
ordered fragmentation. The words “capturing” 
and “exuberant” started describing the two-
dimensional qualities of the design. The roof 
still remained uncertain and in need of much 
further exploration to reveal an expressive 
quality like the rest of the design. This iteration 
was influenced by the principles derived from 
the precedent, Vitra Fire Station in Germany by 
Zaha Hadid Architects (1993). 

(Top of this page) Fig. 117: Updated site plan 
parti diagram (Author 2020)
(This page) Fig. 118: Updated section parti 
diagrams (Author 2020)
(Opposite page) Fig. 119: Transferring the parti 
diagram into the ground floor plan (Author 
2020)
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Precedent: Vitra Fire Station, 
Germany (Zaha Hadid Architects 
1993)
The Vitra Fire Station’s movement and tension 
begins as an extension of the street, acting as a 
linear reference for the surrounding complex. This 
linearity is defined and shaped by the obliquely 
intersecting concrete wall and roof planes, in 
turn defining the functional space within. From 
the outside, the walls appear smooth and pure, 
but are given a form of expression through 
being punctured, slanted or folded to create 
circulation spaces or accommodate specific 
programmes inside (Fiederer 2016). In order to 
maintain the purity of the materials and planes, 
distractions such as cladding and edging 
were avoided (Fiederer 2016, Noever 2003). 
This simplification was carried throughout the 
building; from frameless glazing to the hidden 
lighting on the interior. The walls and roofs emit a 
sense of “frozen movement” (Noever 2003:146) 
in tension, with the expectation for the entire 
building to burst into action at any moment. 
As one moves around the building, the overall 
impression changes dramatically, framing 
oblique views and hinting at openings (Fiederer 
2016). 

Fig. 120: Concept painting (Hadid n.d.) Fig. 121: Plan drawings (Victor 2018) Fig. 122: Vitra Fire House by Zaha Hadid (Author 2020)
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Iteration 8: November
This iteration fully embraced the concept of 
an explosion of expression across the site.  The 
fragmented elements, although seemingly 
random, started following a direction of impact, 
in a rather “staccato” fashion (Codesign 
session 2). These created their own network 
of architecture, affecting the quality and 
quantity of potential physical, social and 
audible interactions. From separating spaces, 
to guiding or hindering movement, creating 
adaptable gathering spaces or creating white 
noise to audibly separate programmes (Dovey 
& Dickson 2002, Hillier 1996, Lawson 2005). The 
functions of each fragmented intervention are 
temporary and determined by the need of 
the users. These constantly change and inform 
or enhance the overall architectural network 
across the site and Music Network (Kozikoglu & 
Cebi 2015). The intricacy of the design started 
allowing the separate elements to come 
together, becoming a whole made up of 
components (Lynn 1993), a network of its own. 
This is further designed into the interrelation and 
networking of the systems (solar energy, water 
and ventilation). The interrelations between the 
existing and the proposed was developed in a 
form of “dynamic stability” (Lynn 1993: 26). This 
concept is further elaborated on in Chapter 7: 
Techné. 

(Photographs) Fig. 123: Expressive symbolism 
throughout the site (Author 2020)
(Drawings) Fig. 124: Site plan and plans with 
expressive architectural language integrated 
with orthogonal language of school (Author 
2020)
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Iteration 9: December
The roofs started becoming more functional 
than purely aesthetic. The first stage of this 
iteration saw the Northern façade begin to 
open up to the field and outdoor seating 
spaces, allowing light and movement to flow 
between the spaces. The Southern façade 
allowed large openings for light to enter the 
functional spaces within. The columns and roof 
do the majority of the work of the structure, 
similar to that of Mies van der Rohe’s Barcelona 
Pavilion (1928). Leaving the freedom for walls 
to weave in and out of the structure and 
express themselves. In hindsight, this concept is 
similar to that of the music that was abstractly 
analysed through music as method (Capanna 
2009, Tayyebi 2013, Young et. al 1993) within 
the proposed Mamelodi Music Network. As 
seen in both the Amapiano style and the world-
renowned jazz music of Philip Tabane, there is 
a relationship between the solid structure of 
the music (the beat and the main vocals) and 
the freer elements that are used to emphasize 
the emotion and expression of the music (the 
melody and backups). 

The roofs spanned across the great distance 
of the centre, touching down on either end. It 
was a struggle to work out the practicality of 
the roofs meeting the ground and allowing for 
openings to occur. Although, seemingly logical 
and controlled, the flatness of the roofs still hid 
the exciting and expressive design beneath 
their structures. 

1

2

3

4

5

6

7

8

9

H

G

F

E

D

C

B

A

I

J

K

N

M

L

O

P

LOWER GROUND FLOOR PLAN
1:200 ON A2

UP

UP

UP

UP

UP

1

2

3

4

5

6

7

8

9

H

G

F
E

D

C

B

A

I

J

K

FLY TOWER

N

M

L

O

P

FIRST FLOOR PLAN
1:200 ON A2

(Photographs) Fig. 125: Model development 
without the roof (Author 2020)
(Drawings) Fig. 126: Lower ground floor and first 
floor digital development (Author 2020)
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(Photographs) Fig. 127: Roof 
development model (Author 2020)
(Drawings) Fig. 128: Ground floor plan 
development with concept diagram 
underlay(Author 2020)
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(Opposite page from top left to right)
Fig. 129: Site plan with rippling effect  (Author 
2020)
Fig. 130: STEAM classroom roof development 
with ripple effect (Author 2020)
Fig. 131: Performance Centre roofs developed 
in sections and overlayed (Author 2020)

(This page) Fig. 132: Overall form concept 
sketch with expressive roofs (Author 2020)

The second stage of this iteration shows how the 
expressive roof of the Performance Centre was 
enthusiastically explored, largely influenced by 
the results from Co-design session 2: the “roofs 
are energetic” and the “beams have emotions”. 
The height levels of the roof no longer allow 
harsh light from the East and West, but rather 
provide acoustic and aesthetic properties. 
Functionally, the roofs also provide space for 
the ventilation fans to run, powered by the 
collected solar energy. The structure of the roofs 
were proved possible through the author’s visit 
to the Cradlestone Mall in Johannesburg (see 
Chapter 7 Roof Precedent). Technically, this 
assisted with the development of the beams 
and trusses spanning the great distances at 
different angles across the hall. Visually, the 
roofs bring across the ripple effect of the 
epicentre of expressive explosion with certain 
geometries repeating themselves so as to not 
appear random. These forms are similar to the 
earth forms of sedimentary rock and are also 
distributed throughout the site in a controlled 
manner. As developed in previous iterations, 
these fractured forms are multi-functional, 
based on the appropriation brought to them by 
the user. Some have been specifically designed 
to be only used as stairs, others include seating 
and viewing platforms, while some open 
up to create smaller platforms that can be 
appropriated for interaction and self-expression 
on a smaller scale than the main stage. Further 
developed were the roof openings to the South 
in order to allow a constant soft amount of light 
to enter the main hall and backstage change 
rooms. 

The different elevations (North and South) were 
developed to serve different functions. The 
Northern elevation opens up to the sports field 
and outdoor stage and seating to allow for a 
larger spill out event to take place. This is done 
through the use of bi-fold doors that are manually 

opened and closed, either fully or partially. This 
technology is further used throughout the site 
and especially for the opening up of the STEAM 
classrooms. The bi-fold doors allow the visual 
representation of the ripple effect through the 
fracturing and folding of the facades. 

The Southern elevation is more functional in 
terms of programme, and therefore does not 
require this manipulation of the façade as much 
as the Northern elevation. The few bifold doors 
here allow for Southern light to naturally light 
the interior spaces of the Performers’ Entrance, 
rehearsal space and sound studio. 
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07_TECHNE
Logos and Techne

Roof Precedent

Roof and Detailing Development

Roof Structural Model

Systems: Acoustics

Systems: Water

Sustainability

Fig. 133: Graphic representation of Performance Centre (Author 2020)
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07_TECHNÉ
This chapter explores how the overall concept of 
expression and performance can be brought through 
to the structural intentions, materiality, building systems, 
services and sustainability. 

Logos and techné
It is imperative for the building to be dynamic and have 
energy: an explosion of expression providing inspiration 
(Capanna 2009) and a “cup of that vision” (Memory 2020). 
This assists in achieving the intention of an inclusive and 
celebratory architectural intervention within the proposed 
Music Network by providing a flagship of identity through 
expression. In order to achieve this, a “dynamic stability” 
(Lynn 2013:26) is created between the integration of the 
new with the existing. 

The stability is constructed through the main structural 
elements of the Performance Centre. The columns and 
beams are ordered according to a 5x7m grid, influenced 
by the existing built structure and orientation of Tsako Thabo 
Secondary School. The stability elements are stereotomic 
and hold the necessary servant spaces, as according to 
Louis Kahn (Slunecko 2018), where they meet the ground. 
As seen in the linear layout of Uytenbogaardt’s Steinkopf 
Community Centre (1978-80), these elements create 
a structural order that allows secondary and tertiary 
architectural elements to be freely integrated (Beck 1985, 
Bosman 2017). Mies van der Rohe’s Barcelona Pavilion 
(1929) expresses the same structural concept. The columns 
follow an underlying grid and act as the only structural 
elements within the building. The rest – the roof, walls, 
doors, glazing, etc. – fill in the voids, create spaces and 
influence circulation (Mies van der Rohe Architects 2011) 
in a free and unconstructed manner. These freer elements 
of the Pavilion are also visually emphasized through the 
use of elaborate cladding materials, such as marble. 

Fig. 134: Mies van der Rohe’s Barcelona Pavilion (Author 2020)

The dynamic guides, stops, frames, celebrates and 
creates space within the overall design. These elements 
are responsive, incorporating, fluent and adaptable (Lynn 
2013:30) to the existing, the main structure and the context 
of expression. They consist of platforms, walls, openings 
and coverings, defining and designing spaces according 
to their expressive programme. The Performance Centre 
exists at the epicentre of this musical explosion, followed by 
ripples of influence throughout the site and Music Network. 
These elements are the details of the interrelationship 
between music and architecture (Capanna 2009, Tayyebi 
2013, Young et. al 1993:39), creating an intricate network 
of expression and identity (Lynn 2013). This interaction 
and relationship between the stability and the dynamic 
bring together the tangible and intangible aspects of 
architecture (Frascari 1984). The walls and ceilings within 
this category are largely influenced by and impact the 
acoustic qualities of the designed spaces, impacting 
the overall social and built performance. The openings 
welcome natural lighting into the space while the layering 
of seemingly unpredictable platforms, floors and walls 
create a continuous flow of movement and form. The 
lightweight expressive roof covering falls a part of the 
dynamic as well. Each layer and material associated 
with this category are celebrated for their best structural 
performance, including the heavier rammed earth walls 
grounding and holding the Centre.  

Fig. 135: Uytenbogaardt’s Steinkopf Community Centre (Author 2020)
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Roof PRECEDENT: CRADLESToNE SHoPPING MALL, 
JoHANNESBURG (BENTEL & ASSoCIATES 2013)
This relatively new shopping mall in Johannesburg is situated on the edge 
of the UN World Heritage site, the Cradle of Humankind. The roof of the 
shopping mall takes its formal inspiration from the layering of strata in the 
earth, as found at the Cradle (Bentel 2013). The ceiling reflects this same 
concept through the contours of its jagged armadillo shape (LAD 2013), 
bringing light to both acoustic and aesthetic qualities. The roof touches 
down on its neighbouring flat roofs, hidden behind three-dimensional 
geometric bulkheads. The design of the roof allows the flooding of Southern 
light into the space. 

From on-site and desktop analysis, the researcher attempted to understand 
the basic structure of the roof (Fig. 136). The main structure is a series of 
slanted beams, held together and support by trusses with glazing. Covering 
this is standard metal roof sheeting. The ceiling elements below are of 
Saint-Gobain’s Gyproc high performance ceiling board (LAD 2013). These 
are constructed as individual elements, leaving an air space between the 
structure of the roof and the ceiling itself. Similar to the Exeter Roof (See 
Systems: Acoustic precedent), this could be done to allow sound to be 
absorbed by a system above it. 

Fig. 136: Trying to understand the structure of the roof (Author 2020)
Fig. 138: The roof of Cradlestone Mall shown from the inside (Author 2020)Fig. 137: Aerial photographs (Google Maps 2020)
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Roof & DETAILING DEvELoPMENT

Fig. 139: Initial exploration of roof form and 
structure with acoustic influence (Author 2020)

Fig. 140: Exploring the effect of the 
structure on the design (Author 2020)
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SAFLOK© ROOF/WALL DETAIL
Scale 1:10 on A1

COMPOSITE BEAM AND ROOF-TO-BUTTRESS DETAIL
Scale 1:10 on A1

OUTDOOR SEATING DETAIL
Scale 1:20 on A1

SAFLOK 700© aluminium zinc concealed
fix roof sheeting fixed to SAFLOK 700©

clips, fixed to 50x76x20mm lipped
channels @ 1500mm c/c with wafer

head self-tapping fasteners. To
engineer's specifications.

Aluminium zinc flashing bracket fixed to
sheeting and 75x38mm RHS with

Ø22mm hex headed screws.

Waterproofing membrane.

Min. 340mm deep steel truss @ 1200mm
c/c. To engineer's specifications.

10°

12,5mm drywall fixed to steel studs. With
min.60mm Pink Aerolite© insulation.

Interior finished with plaster and paint.
To engineer's specifications.

SAFLOK 700© aluminium zinc concealed
fix sheeting fixed to SAFLOK 700© clips,

fixed to 50x76x20mm lipped channels @
800mm c/c with wafer head

self-tapping fasteners. To engineer's
specifications.

75x50x20mm Steel lipped channel @
300mm c/c fixed to trusses. With min.
100mm Pink Aerolite© insulation and
9mm Rhinoboard© ceiling with drop
shadow cornice.

Truss welded to min. 20mm steel plate,
fixed to concrete upstand with Ø12mm

threaded rods.

DPM lapped up min. 150mm
above NGL.

NGL

Min. 255mm R/C slab with raft
foundations. To engineer's

specifications.

150x15mm Tile skirting.
Tiles and tile adhesive
on min. 40mm screed.

MALE
DRESSING ROOMS

Waterproofing membrane

120x70mm Galvanized steel box gutter
fixed to 75x38mm RHS fixed to purlins.
Waterproofing lapped over edges of

gutter with additional membrane
underneath.

SAFLOK 700© roof sheeting cranked at
ends into box gutter.

DPM

DPM

Min. 255mm precast R/C
seating, with waterproofing
admixture. To engineer's
specifications.

Min. 300mm depth
concrete footing.
To engineer's
specifications.

Top of concrete to be slightly
sloped away to avoid water
pooling.

Minimum 20mm crushed stone gravel ballast
on Geotextile water permeable filter fabric,
on torch-on bitumen waterproofing system,
on min. 30mm screed @ 1:80 fall to FBOs, on

15mm fibre cement boards.

152x152mm I-beams @ 4075mm c/c, with
142x64x20mm Lipped channels @ 600mm

c/c, to engineer's specifications.

9mm Ecophon© ceiling boards
fixed to steel angle hangers @

900mm c/c fixed to primary
suspended ceiling structure with

drop shadow cornices.
Min. 100mm Pink Aerolite©

insulation.

SAFLOK 700© roof sheeting with
waterproofing, on 50x76mm steel purlins @

1300mm c/c fixed to 75x100 RHS truss bottom
chord.

Purlins fixed to R/C buttress wall with Ø12mm
threaded rods welded to structural steel

plate. To engineer's specifications.

110mm masonry beam fill.

REHEARSAL ROOM

LOWER GROUND DUCT DETAIL
Scale 1:20 on A1

DUCTFEMALE
ABLUTIONS

NGL

Existing NGL

230mm Masonry Wall

Waterproofing
membrane along

wet side of masonry
wall

Torchon Waterproofing
membrane laps up min.
1000mm height

Ø110mm Agricultural drain

Layers of Ø25mm
aggregate, quarry rock
and bidem cloth.

255mm R/C slab with min.
40mm screed to fall with
Torchon WPM.
To engineer's
specifications.

DPM

DPM

250mm R/C retaining
wall. To engineer's
specifications.

SAFLOK© ROOF/WALL DETAIL
Scale 1:10 on A1

COMPOSITE BEAM AND ROOF-TO-BUTTRESS DETAIL
Scale 1:10 on A1

OUTDOOR SEATING DETAIL
Scale 1:20 on A1

SAFLOK 700© aluminium zinc concealed
fix roof sheeting fixed to SAFLOK 700©

clips, fixed to 50x76x20mm lipped
channels @ 1500mm c/c with wafer

head self-tapping fasteners. To
engineer's specifications.

Aluminium zinc flashing bracket fixed to
sheeting and 75x38mm RHS with

Ø22mm hex headed screws.

Waterproofing membrane.

Min. 340mm deep steel truss @ 1200mm
c/c. To engineer's specifications.

10°

12,5mm drywall fixed to steel studs. With
min.60mm Pink Aerolite© insulation.

Interior finished with plaster and paint.
To engineer's specifications.

SAFLOK 700© aluminium zinc concealed
fix sheeting fixed to SAFLOK 700© clips,

fixed to 50x76x20mm lipped channels @
800mm c/c with wafer head

self-tapping fasteners. To engineer's
specifications.

75x50x20mm Steel lipped channel @
300mm c/c fixed to trusses. With min.
100mm Pink Aerolite© insulation and
9mm Rhinoboard© ceiling with drop
shadow cornice.

Truss welded to min. 20mm steel plate,
fixed to concrete upstand with Ø12mm

threaded rods.

DPM lapped up min. 150mm
above NGL.

NGL

Min. 255mm R/C slab with raft
foundations. To engineer's

specifications.

150x15mm Tile skirting.
Tiles and tile adhesive
on min. 40mm screed.

MALE
DRESSING ROOMS

Waterproofing membrane

120x70mm Galvanized steel box gutter
fixed to 75x38mm RHS fixed to purlins.
Waterproofing lapped over edges of

gutter with additional membrane
underneath.

SAFLOK 700© roof sheeting cranked at
ends into box gutter.

DPM

DPM

Min. 255mm precast R/C
seating, with waterproofing
admixture. To engineer's
specifications.

Min. 300mm depth
concrete footing.
To engineer's
specifications.

Top of concrete to be slightly
sloped away to avoid water
pooling.

Minimum 20mm crushed stone gravel ballast
on Geotextile water permeable filter fabric,
on torch-on bitumen waterproofing system,
on min. 30mm screed @ 1:80 fall to FBOs, on

15mm fibre cement boards.

152x152mm I-beams @ 4075mm c/c, with
142x64x20mm Lipped channels @ 600mm

c/c, to engineer's specifications.

9mm Ecophon© ceiling boards
fixed to steel angle hangers @

900mm c/c fixed to primary
suspended ceiling structure with

drop shadow cornices.
Min. 100mm Pink Aerolite©

insulation.

SAFLOK 700© roof sheeting with
waterproofing, on 50x76mm steel purlins @

1300mm c/c fixed to 75x100 RHS truss bottom
chord.

Purlins fixed to R/C buttress wall with Ø12mm
threaded rods welded to structural steel

plate. To engineer's specifications.

110mm masonry beam fill.

REHEARSAL ROOM

LOWER GROUND DUCT DETAIL
Scale 1:20 on A1

DUCTFEMALE
ABLUTIONS

NGL

Existing NGL

230mm Masonry Wall

Waterproofing
membrane along

wet side of masonry
wall

Torchon Waterproofing
membrane laps up min.
1000mm height

Ø110mm Agricultural drain

Layers of Ø25mm
aggregate, quarry rock
and bidem cloth.

255mm R/C slab with min.
40mm screed to fall with
Torchon WPM.
To engineer's
specifications.

DPM

DPM

250mm R/C retaining
wall. To engineer's
specifications.

Fig. 141: Roof/wall detail prepared for the Tech Crit 
in September (Author 2020)

Fig. 143: Changes in level - roof detail 
prepared for the Tech Crit in September 
(Author 2020)

Fig. 142: Exploration of an expressive roof 
structure (Author 2020)

Fig. 144: Detailed development of different roof 
components (Author 2020)
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Roof STRUCTURAL MoDEL

Fig. 145: 3D diagram of the roof structure (Author 2020)

140x300x10mm RHS columns angled at 105° @ 
5000mm c/c. Welded to min. 20mm steel base plate, 

fixed to R/C upstand beam with ø12mm threaded 
rods. To engineer’s specifications.

Min. 500mm deep trusses made of 140x300x10mm 
RHS, welded to RHS columns, @ 10 000mm c/c. To 

engineer’s specifications.
Clad with brick slips (faggots). See Detail B.

75x100x20x3mm Lipped channel 
purlins fixed to RHS beams and 
trusses @ 1200mm c/c. To engineer’s 
specifications.

140x300x10mm RHS beams used for 
box gutter structure (See detail A), 
welded to trusses at lowest point of 
roofs. To engineer’s specifications.

SAFLOK 700© concealed fix roof 
sheeting, fixed to SAFLOK 700© clips, 
fixed to llipped channels with wafer 
head self-tapping fasteners. To 
engineer’s specifications. 

This model shows the main structure of the 
roof design. At first glance the roof seems 
complex, however, it is simply constructed of 
long spanning beams and trusses with roof 
coverings. This simple support structure allows 
for the freedom of the walls below to create 
exciting spaces as needed.

140x300x10mm RHS beams fixed 
to RHS @ 5000mm from centres of 
trusses. To engineer’s specifications.

140x300x10mm RHS beams welded to 
trusses. To engineer’s specifications.
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GENERAL TECH DEvELoPMENT

Fig. 146: 1:20 Tech section exploration through Roof C 
(Author 2020)

Fig. 147: General tech notes and detailing explorations 
(Author 2020)
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SySTEMS
As already analysed, the conditions of the school hall and 
classrooms are poor and have a negative effect on its 
users. This is a similar condition across most schools within 
the area and needs serious re-consideration (Honours 2019). 
In order to create a comfortable and less-stressful interior 
environment for learners and teachers, considerations such 
as acoustic conditions, daylighting and ventilation need to 
be carefully designed. Taking these conditions into the design 
of the building can largely enhance the users’ wellbeing and 
performance (Ecophon 2018).   

Systems: Acoustics 
Due to programme and main focus of this dissertation, the first 
system that needs to be addressed is acoustics. In order to 
calculate and have a proper understanding of the acoustic 
qualities of a space, one needs to consider the activity within 
the space, the people performing this activity and the overall 
space itself (Ecophon 2018). This is used when assessing the 
overall Activity Based Acoustic Design of the building and is 
analysed using the Ecophon acoustics calculator (Available 
for online use at: http://www.ecophon.ua/en/about-
ecophon/e-tools/ecophon-acoustic-calculator/ ).

The following three parameters are assessed in this calculator 
(Ecophon 2018):

1. Reverberation Time: how fast does sound energy dis-
appear within a space? It is preferred for the reverber-
ation time to be as short as possible in order to avoid 
chaotic and disturbing echoes.

2. Speech Clarity: how clear is speech perceived in the 
space? The higher the value, the more improved 
speech clarity there is.

3. Sound Strength: how does the sound reflect on all the 
surfaces within a room, and how does this contribute 
to the sound level? If the value is lower, this means the 
sound level is also lower. 

In order for a good room design, there needs to be a good 
balance between these three parameters that supports the 
room’s activity and people. 

Fig. 147: Acoustic development (Author 2020)

The existing classrooms have been assessed 
and recommendations have been made for 
implementation in the soon stage of this project 
(Hamdi 2010). This will benefit the learners and 
teachers within the classrooms by increasing 
the comfort levels within the space, allowing 
more successful learning to take place. As 
seen in Fig. 149, the reverberation time, speech 
clarity and strength of sound all fall below the 
recommendations from Ecophon. Iterating this, 
alternating reflective and absorptive wall panels 
were added to facing walls with a total area 
of 12m² on each wall. This largely increased 
the acoustic quality of the classroom (Fig. 150), 
meeting the minimum recommendation values 
from the base model. Anything added beyond 
this would only increase the sound quality of the 
space. 

The existing hall was analysed in a similar way. 
Again, the acoustic qualities of the hall were 
far from what is recommended (Fig. 151). The 
calculated reverberation time was too long, as 
well as the speech clarity being too low. Therefore, 
for the iteration and design of the proposed 
Performance Centre hall, a ceiling absorber 
with a high sound absorption coefficient and 
wall absorbers positioned to reduce reflections 
were added to the calculations. This resulted in 
both the reverberation time and speech clarity 
reducing to as close to the recommended values 
as possible (Fig. 152). Due to the simplicity of the 
calculator only analysing walls at right angles, 
the values calculated can only be estimates. 
Following Ecophon’s recommendations and 
the precedent analysis of the Exeter School 
Multipurpose Space, the acoustic design for the 
Performance Centre Hall developed (Fig. 157). 
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Fig. 149: Results and recommendations for the existing classroom (Ecophon 2020)

Fig. 150: Acoustic results of the classroom meeting the recommendations 
through added wall panels (Ecophon 2020)
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Fig. 151: Results and recommendations for the existing school hall (Ecophon 2020)

Fig. 152: Estimated acoustic results for the proposed Performance Centre hall 
(Ecophon 2020)
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http://www.ecophon.ua/en/about-ecophon/e-tools/ecophon-acoustic-calculator/
http://www.ecophon.ua/en/about-ecophon/e-tools/ecophon-acoustic-calculator/
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The ceiling of the Performance Centre hall is 
used to reflect and direct sound from the stages 
to the audience below. Similarly, the reflective 
panels on the angled walls create the same 
effect with sound from the centre of the hall. 
Alternating these panels are absorptive panels 
that help reduce the reflections and ensure short 
to zero reverberation. This ensures the sound is 
crisp and clear, with no echoes or overlapping 
noise that can disrupt audience members and 
onlookers during any of the activities that may 
take place within the space, including cultural 
events and a volleyball match. 

Fig. 153: Acoustic diagram through cross section of the Performance Centre hall (Author 2020)

Fig. 155: Acoustic diagram through the long section of the Performance Centre hall (Author 2020)

Fig. 154: Acoustic diagram through a 
typical classroom (Author 2020)

Reflective panels Absorptive panels Alternating absorptive & 
reflective  panels

Fig. 156: The structural concept of a sushi roll (Dake Wells 2015)

Fig. 158: Acoustic analysis of the ceiling (Author 2020)Fig. 157: Interior view of Exeter multipurpose hall (Author 2020)

ACoUSTIC PRECEDENT: EXETER 
SCHooL MULTIPURPoSE SPACE, USA 
(Dake Wells Architecture 2009) 
The addition to the school building repurposes an existing 
interstitial space to provide a social, performance and 
sport centre for the small community of Exeter. Natural 
daylighting and acoustics are great influencers of 
the design. The ceiling and roof structure is made up 
of folded timber elements designed to control and 
optimize the acoustics within the multipurpose hall. The 
folded timber reflects and directs sound to the audience 
below, while surrounding materials on the floor and 
walls absorb sound and eliminate reverberation 
(Schwab 2015). This structure was inspired by a sushi roll 
with layers of varying absorptivity (Schwab 2015). The 
reflective suspended timber ceiling is attached to an 
exposed steel structure, leaving a void for the sound 
to travel through and be absorbed by tectum tubing 
above. Skylights penetrate this system, allowing the 
flooding of natural lighting into the hall. 
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Systems: Water
Water is a visual, aural and environmental aspect that can 
be sophisticatedly designed into architecture to enhance the 
overall functionality and experience of the building. Water 
possesses architectural elements relevant to this project such 
as rhythm, movement and sound (Songabau 2019). It can be 
used as an acoustic camouflage for unwanted noise with the 
pleasant sound that moving water emits (Brown & Rutherford 
1994, Pouya 2017). According to a recent study done, water 
is the second highest natural sound that relates to a “positive 
perception of the urban soundscape” (Jeon et al. 2012: 2101). 
Acoustically, still water bodies, such as lakes, ponds, pools and 
puddles, reflect noise and often carry the sound across the 
water body (Rådsten 2015). Moving waters, such as waterfalls, 
fountains, cascades and rivers can create a natural music 
that can be manipulated and designed in terms of rhythm, 
pitch, volume, sharpness and harmony (Rådsten 2015). Pairing 
moving water with vegetation significantly improves the 
absorption and masking of unwanted sounds (Rehan 2016). 
(diagram of water as road traffic noise mask)

It is important to consider the intricate design of moving 
water interventions as the loudness of the natural sound may 
negatively impact some programmatic functions, for example, 
being unable to talk and teach in a classroom due to the 
deafening loudness of a water fountain outside the window. 
Therefore, the types of water implementations have been 
considered closely according to both the slope of the site, 
collection points and programmatic layout. 

Water interventions have been used as a guiding element within 
the site, as well as a physical and aural threshold between the 
site and the street. In some cases, the reflection of light on the 
water intervention displays a performance of this system onto 
a nearby built surface, once again tying back to the original 
concept of celebrating expression and performance. 

Fig. 159: Water and sound diagrams (Author 2020)
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SUSTAINABILITy 

Rainwater Catchment
The large roof of the Performance Centre 
provides the opportunity for water catchment 
that can be filtered and used for maintaining 
the landscaping as well as feeding back into 
the building for the flushing of toilets in the 
Performance Centre. The water storage is vital 
to consider as Pretoria has a series of 4-5 months 
that receive less than adequate to zero rainfall 
consecutively. The water needed for these dry 
Winter months can be collected during the 
Summer months with a large amount of rainfall 
and thunderstorms (Napier 2000).  

Initially, the calculations determined the water 
catchment from the Performance Centre roofs 
only. This proved to be insufficient yield for the 
total water demand. The existing roofs and 
courtyard run-offs were added into the system 
calculations and an excess of water yield was 
determined. This determined the decision to 
install a 5 000 litre storage tank that stores the 
majority of the water. The water fountains 
implemented throughout the site for acoustic 
purposes are used as additional water stores 
to collect any water above and beyond the 
estimated amount. 

Fig. 160: Rainfall averages for Nov 2019 - Dec 2020 in South Africa (SAWS 2020)
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1. WATER yIELD
Rainwater Harvesting Data

Total Water yield GROUND FLOOR PLAN
Scale 1:500 on A3

Performance Centre Roof Diagram

Roof A

Roof B

Roof C
Roof D

Roof E

Roof FRoof G
Roof H
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Total Loss & Demand

2. MoNTHLy WATER DEMAND
Landscaping & Irrigation Demand WC Demand

Water loss (open Reservoirs)

3. WATER BUDGET

Initiation Phase

first operational year
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ventilation
In order to ensure a comfortable yet sustainable 
interior environment within the school hall, natural 
ventilation is required. Due to the intervention 
sitting within the temperate climate of Pretoria, 
overheating due to the outside air temperature 
is quite likely. Therefore, cooling of the outside 
air before releasing it into the interior of the 
building is necessary. This is achieved through 
the implementation of a ground cooling/earth 
tubes system. 

The air is brought in from the outside through 
vents in the ground beyond the building. These 
vents are situated lower than the building in 
order to allow the pipes to slope up towards the 
building. This ensures no water leakage into the 
building due to the condensation build up inside 
the pipes (Milligan 2013). The excess water built 
up in the pipes flow down to a catchment sump 
and is released back into the ground through 
an agricultural drain. The hot air (Summer) flows 
through these pipes under the ground. The cool 
earth, with a temperature of 16.5 - 21˚C (Zaki & 
Almssad 2007) in Summer then cools the hot air 
in the tubes and causes condensation to build 
up. This condensation further assists with cooling 
the air as well as dehumidifying it before it enters 
the building (Milligan 2013). In winter, the warm 
earth surrounding the tube heats up the cold air. 
The adjusted air is then sucked into the building 
through a fan and floor vents. The cool air flows 
through the building, warming up and eventually 
rising to the ceiling. This hot air is then released 
outside through vents situated in the stepped 
roofs. In winter, these roof vents are closed while 
vents in the wall close to the floor are opened, 
allowing the sinking cold air to escape to the 
outside. Situating the fan in the floor allows for 
a constant flow of air into the building from the 
earth tubes, pressurizing the interior even when 
doors and windows are open.  

Photovoltaic Energy
The new roof also provides the opportunity for 
solar energy to be collected on the most Northern 
facing slopes. This solar energy is used to power 
the Performance Centre at night, the ventilation 
fans in the floor and to provide electricity for the 
water pumps to operate between the storage 
tanks, open reservoirs/fountains and through 
the building to the bathrooms.  

Daylighting 
The roofs of the Performance Centre are sloped 
to open up towards the South in order to allow 
for natural daylighting to enter the hall. This has 
been assessed using Sefaira (Fig. 164).

Landscape Reuse
The design intent considered the slope of the 
land, allowing an opportunity for the landscape 
material to be reused for the cut and fill of the 
site beneath the Performance Centre. 

Additional Considerations
The above-mentioned sustainable aspects 
are also proposed to be achieved with the 
renovation and upgrading of the rest of the 
existing school buildings. 

Rainfall 

Gutters 
& drains

Initial filter 
(leaves & 

debris)

Above 
ground 
pump

Fountain with 
safety grate & 
pump for jets, 

with float valve

WCs with 
float valves

Filtration 
sieve

5 000l Jojo storage 
tank with float 

switch to turn off 
pump when full

Solar 
panels 
facing 
North

Solar inverter

DB

Inverter

Battery 
bank

Municipal 
connection

Switch over 
control unit

Summer vents

Winter vents

Fan & floor 
vents

Ground 
cooling/ 

warming & 
condensation 

Inlet vent

Catchment 
sump & agr. 

drain

Pipes sloped 
uphill

Fig. 162: Integrated system network diagram (Author 2020)
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Within the proposed Hall, there are large 
stereotomic elements constructed of rammed 
earth. Using this technology, above and beyond 
the beautiful aesthetics, the sustainability of 
the building is increased. Rammed earth walls 
have a very low environmental impact in 
terms of materiality as only the subsoil is used 
(FIA 2018)., leaving the top soil for agricultural 
purposes. This soil, however, needs to be low in 
clay. Due to Mamelodi having a high content of 
clay in the soil, it will mean the soil needs to be 
sourced elsewhere. This increases the carbon 

footprint due to transportation. Rammed earth 
construction doesn’t require highly skilled 
labourers and the formwork can be reused 
multiple times, all saving on costs and energy.

The rammed earth walls on the West and East 
of the hall provide excellent thermal mass from 
these harsh directions, adding to the creation 
of a comfortable interior environment. In 
order to celebrate these elements, the other 
components (walls, ceilings etc.) are kept 
‘separate’ through visual and physical gaps 
between technologies. This can be clearly seen 
in the plans and sections. 
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DAyLIGHTING DEvELoPMENT
The following analyses were run using Sefaira.

1. EXISTING SCHooL HALL
The existing school hall as a daylight factor of 2.45%. 
This is an adequate amount of daylighting, falling within 
the recommended scope of 2-5%. However, the space 
receives zero direct sunlight and therefore relies on 
reflective surfaces and large openings to allow indirect 
light in. The materiality of the current hall, is reflective, 
but as 97% of the space receives daylight according 
to the Spatial Daylight Autonomy (sDA), this results in 
35% Annual Sun Exposure (ASE). This suggests that there 
may be glare and unwanted solar heat gain within the 
classroom. This results in an uncomfortable interior for 
activities that include more than 400 people within the 
small space.

Daylight Factor

Direct Sunlight

Over-lit & under-lit

Fig. 163: Existing school hall from the outside courtyards (Greyling 2019)

2. ITERATIoN 8 ANALySIS Daylight Factor

Direct Sunlight

Over-lit & under-lit

This iteration of the proposed Performance Centre has 
a daylight factor value of 1.08% which is inadequate 
and therefore has a dark interior space. Similarly, there 
is no direct sunlight except for the outside seating area 
which is not covered from the sun. The SDA of 46% is 
also not within an acceptable zone for a comfortable 
area, resulting in the majority of the space is underlit. 
As a result, the ASE value is extremely low (2%), which 
would usually be considered good as there would 
be no glare nor unwanted solar heat gain. However, 
due to the darkness of the interior space, mechanical 
lighting will be required daily throughout the year for the 
space to be operational. This, however, will decrease 
the sustainability of the overall building significantly and 
will not be acceptable. 

Fig. 164: Process model of Iteration 8 (Author 2020)
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3. fINAL DESIGN ANALySIS Daylight Factor

Direct Sunlight

Over-lit & under-lit

This iteration takes into consideration the opening and 
closing of the bifold doors on the Northern facade. The 
images shown are of the bifold doors all completely 
open. 

When the bifold doors are fully open, the space 
has a daylight factor of 8.49%. This is above the 
recommended amount and may result in the 
adjustment between exterior and interior light to be 
uncomfortable for users. This number decreases to 3.1% 
when the bifold doors are closed, therefore resulting in 
a well daylit interior due to the South-facing openings in 
the roofs. Most of the exterior seating and balconies on 
the Northern facade receive direct sunlight. This slightly 
enters the main hall when the doors are fully open. 
This results in most of the hall being overlit with a slightly 
high ASE value of 45% which may result in glare. When 
the doors are fully closed, this value drops to 5% which 
is acceptable for the interior space. It is recommended 
then for a simultaneous interior and exterior event for 
the bifold doors to only be half open, which should 
decrease the SDA value of 82% slightly, still resulting in a 
well day-lit interior with little glare. 

The hall foyer is underlit due to little openings. This is 
acceptable as a part of the threshold between the 
school and the performance space, providing an 
exciting experience for users when entering into the 
large open hall - the calm before the storm.

SUSTAINABLE BUILDING ASSESSMENT TooL
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08_CONCLUSION

Fig. 165: Learners investigating a scale model of the school (Author 2020)
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08_CONCLUSION 
The proposed Performance Centre is an 
inclusive and interactive celebration of life. 
It inspires school learners, teachers, aspiring 
musicians, community members and the like. 
Music was used as the “leap vehicle” (Young et. 
al 1993:39) for the initial urban design concept, 
while developing into an inclusive form of 
performance and expression. By opening up 
the school and redesigning the classrooms, 
alternative and STEAM education can be fully 
implemented, providing every learner with a 
chance for success. Acting as the flagship for 
the Music Network, the Performance Centre 
connects with other schools in the surrounding 
community, sharing their facilities of learning 
and in turn providing a place for celebration 
and performance. Additionally, it provides an 
opportunity for international collaboration and 
support with UNESCO’s Creative Cities of Music, 
uplifting the community through ownership, 
pride and support. Both the school of Tsako 
Thabo and Mamelodi East have new identities, 
founded in the heritage of the Mother of 
Melodies (van der Wall 2000). 

As an answer to the research question of the 
decentralization of music-making providing 
a platform for positive self-expression for 
school learners and enhancing the collective 
community identity of Mamelodi East, the 
Performance Centre enables the community 
and Tsako Thabo school with an exciting and 

positive communal experience for music and 
performance, the reliance on a centralized 
institution and authority is relaxed. Providing this 
platform for positive self-expression empowers 
the people to make a direct and immediate 
change in their individual lives and the collective 
community (Ndeneche 2011). The proposed 
Performance Centre and research successfully 
answers the research question. 

This dissertation focused on one node of the 
proposed Music Network. A future investigation 
could explore the possibilities of expanding the 
network through different programmes and 
functions, beyond Mamelodi East. As a whole, 
music was only one opportunity for change 
uncovered in Tsako Thabo Secondary School. 
Recreational activities, routes, school typologies 
and other aspects mentioned in Volume One 
(Konstantinou, Naidoo & Smith 2020) of this 
dissertation would all provide a researcher with 
immense depths to unpack. 

This dissertation went through many trials 
and errors, specifically with the methodology 
application. Due to the COVID-19 nationwide 
lock-down, the participatory research and 
co-design needed to be adapted and 
modified to work within the restrictions of the 
lock-down circumstances. Not only did this 
provide alternative ways to the participatory 
methodology, but it also brought to light severe 

issues that need to be addressed regarding 
the educational ecosystem of South Africa 
in general and the research intentions. This 
research reaches far beyond the proposed 
Performance Centre by challenging the way 
people address issues and find solutions. The 
dissertation itself is a prime example of finding 
opportunities amongst difficulties, turning 
obstacles into ideas and focusing on the 
fundamentals of community architecture – the 
relationships between people and productive, 
energising spaces.

Fig. 166: Photograph of 1:500 site model (Author 2020)
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First Floor Plan
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South Sectional Elevation
Original Scale 1:200 on A3
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Original Scale 1:200 on A3
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Section A:A
Original Scale 1:20
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Section A:A - Portion A
Original Scale 1:20
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Section B:B
Original Scale 1:200 on A3
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DETAIL A BUTTERFLY ROOF GUTTER
Scale 1:5 on A3

min. 300

m
in

. 2
30

SAFLOK 700© concealed fix roof sheeting cranked at ends into
box gutter, fixed to SAFLOK 700© clips, fixed to
75x100x20mm lipped channels @ 1200mm c/c with wafer
head self-tapping fasteners. To engineer's specifications.

Min. 500mm deep steel truss @ 10 000mm  c/c. To
engineer's specifications
140x300x6mm RHS beam welded to trusses. To
engineer's specifications.

100mm Pink Aerolite© insulation

Waterproofing membrane

Flashing with silicon sealant, fixed to purlins

Stainless steel box gutter, sloped to RWDP.
Fixed to 63x40mm RHS, fixed to beam. To
engineer's specifications

35x35mm U-channel fixed to RHS
beams

Cold bridge insulation

Detail A
(Original Scale 1:5)

DETAIL B ROOF TO ROOF JUNCTION
Scale 1:5 on A3

SAFLOK 700© concealed fix roof sheeting cranked
at ends into box gutter, fixed to SAFLOK 700©
clips, fixed to 75x100x20mm lipped channels @
1200mm c/c with wafer head self-tapping
fasteners. To engineer's specifications.

SAFLOK 700© concealed fix roof sheeting
cranked at ends into box gutter, fixed to

SAFLOK 700© clips, fixed to 75x100x20mm
lipped channels @ 1200mm c/c with wafer

head self-tapping fasteners. To engineer's
specifications.

100mm Pink Aerolite© insulation

12.5mm Gypsum ceiling board with
shadow gap detail, fixed to ceiling tees
@ 60mm c/c, fixed to RHS beam.
Plastered and painted.

SAFLOK 700© flashing

Waterproofing membrane

110mm Brick slips with brick force
every four courses. Fixed to

100x75x6mm angle iron, fixed to
140x300x10mm RHS. To
engineer's specifications.

110mm Spacer with expansion joint

Weephole @ min. 1000mm c/c

DPC overlapping flashing

Waterproofing membrane

100mm Pink Aerolite© insulation

Plaster and paint

Brick force every fourth course

Detail B
(Original Scale 1:5)
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DETAIL C ROOF H HIDDEN GUTTER
Scale 1:5 on A3

overflow line

245

SAFLOK 700© concealed fix roof sheeting cranked at
ends into box gutter, fixed to SAFLOK 700© clips,
fixed to 75x100x20mm lipped channels @ 1200mm
c/c with wafer head self-tapping fasteners. To
engineer's specifications.

100mm Pink Aerolite© insulation

Waterproofing membrane

140x300x10mm RHS beam and column
system. To engineer's specifications.

Stainless steel box gutter, sloped to
RWDP. Fixed to 75x38mm RHS, fixed
to beam. To engineer's specifications

Flashing with
waterproofing

membrane

12mm Gypsum ceiling board fixed to
beam with ceiling tees @ 600mm c/c.
Painted.

12.5mm structural drywalling, fixed to
RHS. To engineer's specifications.
Plaster and painted.

Detail C
(Original Scale 1:5)

DETAIL D LOWER GROUND DUCT
Scale 1:20 on A3

DUCT

HALL ABOVE

Existing NGL

230mm Masonry Wall

Waterproofing
membrane along

wet side of masonry
wall

Torchon Waterproofing
membrane laps up min.
1000mm height

Ø110mm Agricultural drain

Layers of Ø25mm
aggregate, quarry rock
and bidem cloth.

255mm R/C slab with min.
40mm screed to fall with
Torchon WPM.
To engineer's
specifications.

DPM

DPM

1500

35
0

26
20

15
35

250mm R/C retaining
wall. To engineer's
specifications.

Detail D
(Original Scale 1:20)
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FINAL 1:500 MODEL



287286

FINAL 1:200 MODEL
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departments of Chalmers University of Technology, in Sweden, and University
of Pretoria, in South Africa.

The intention of the project is to develop a data collection methodology
that results in efficient storage of collected information in an online data
warehouse. This data warehouse allows for layers of information to be
accumulated each year and easily accessed.

As part of our dissertation outcome, we have contributed to the creation of
the ukuDoba Method, which we have applied to our individual dissertations
as a research methodology.
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Preface

The ukuDoba handbook is the outcome of the 
Swedish-South African project “Stitching the City” 
that integrates education and research. The project 
aims at developing a method and digital library of 
geolocated data for knowledge facilitation to support 
data re-use in architectural courses. It also aims at 
establishing a collaboration between the University of 
Pretoria, South Africa, and the Chalmers University of 
Technology in Gothenburg, Sweden. 

 “Stitching the City” has been hosted by the 
course Planning and Design for Social Inclusion in 
Gothenburg (2019 and 2020) and the Urban Citizen 
studio in Pretoria (2020). Many thanks Emilio and 
Carin!

ukuDoba has been tested in field studies by students 
in two areas: Mamelodi-East in the City of Tshwane 
and Hammarkullen in Gothenburg and the handbook 
has been developed by the six master students in 
an iterative process. Thank you, Robin, Lauren, Purll, 
Mumtaheena, Kelsey and Markus for your invaluable 
work! Without you, no handbook.

A special thank you goes also to Cameron and 
Victoria for development of the GeoNode structure 
to store and share our data. Finally, thank you Marco, 
Monica, Serena for your support and constructive 
input. 

Liane & Chrisna
October 2020

ukuDoba 
Methodology

Version 1.0

A Methodological Framework for Effective Data 
Collection and storage
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ukuDoba

Over time, physical maps and folders are 
being stacked in bookshelves. This format 
of data collection is difficult to access 
and build upon. Year, after year, these 
research processes are repeated, by both 
universities,  leaving layers of rich data 
disjointed.

ukuDoba - the methodological framework, 
has been developed for the collection and 
sharing of non-traditional types of spatial 
economic data at a street and precinct 
level in an online platform. These cross-
disciplinary micro-data can be layered and 
easily accessed by researchers from different 
disciplines as well as students and community 
members.

Contents
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  Getting started      12
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  Carry-on question example:    14
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The ukuDoba  

Methodology

Data
Collection

KoBo 
Toolbox

Data
Conversion

QGIS

Data
Warehouse

Geonode

ukuDoba

The methodological framework, ukuDoba, 
and online platform, Geonode, are 
currently being tested in two study areas: 
Mamelodi East in Tshwane, South Africa 
and Hammarkullen in Gothenburg, 
Sweden.

Here, we present a step by step guide 
to follow the ukuDoba methodology of 
how to effectively digitally collect, convert 
and store data in an online platform, 
GeoNode. 

In Zulu the word ukuDoba means ‘fishing’. 
With this booklet, we hope to help users 
‘fish’ for the data they need for their 
project.



309308

10

Data Collection

• Kobo Toolbox is an open access Digital data collection tool that allows you to 
create a questionnaire that can be downloaded to your mobile device, filled in 
on the ground, offline, and geo-referenced on site. You can take  photographs, 
record video and voice clips, or write text.

• After fieldwork, you can then upload the data to the internet over WiFi and 
access the data via your computer. This data can then be shared with others and 
they can then use it or edit it.

• Other tools used for similar data collection are: Maptionnaire, FieldPapers, 
EpiCollect5 etc.

• Communities to share their knowledge.
• To digitally store data in a Digital platform (easier to access and use).
• To geolocate collected data

What?

Why?

1Data Collection

12

KoBo Toolbox

1. Use your computer to start. You will only use 
your phone when filling out the form on site.

2. https://www.kobotoolbox.org/  > Scroll down  
> Researchers, Aid Workers and Everyone 
Else > Create an Account > Verify in email 

1. Open KoBo Toolbox on your computer 
browser > New > Build from Scratch > Fill in

2. Project Name > Use a set format (e.g. 2020_
Location_Project Name) > Create Project

3. “+” > types of questions (see glossary for 
types of questions)

• Question 1: select  Acknowledge 
question (digital consent for 
interview). See example below:

• Question 2: select Point question 
(current location of interview).

• Question Settings > Mandatory 
Response > Yes (Question 1 and 
Question 2)

Getting started

Creating a questionnaire

I hereby voluntarily grant permission for participation in this project, as explained to me 
by the researcher. I am aware that the results of the investigation may be used for the 
purposes of publication. I will remain anonymous: my comments may be used without 
giving any geographic or personal references (name, address, ID, occupation, age, income 
etc) that may accidentally imply my identity.

4. Layout and Settings > Select Start Time and 
End Time

5. Save & Preview
6. Return to List (top left corner)

11

Data Collection

• Always collect data in groups of three 
people. 

• The first person is in charge of taking 
notes and should focus on gathering 
data using the data collections tool.

• The second person is in charge of 
leading the interview and can have the 
questions open on their phone as a 
guide. 

• The third person is in charge of 
documentation of the process and 
takes pictures, video and audio 
records.

How?
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KoBo Toolbox

KoBo Toolbox

Glossary: Question Types & Examples

Point: tracks your current location*

Acknowledge: gives consent to the interview*

Text: add in between questions for additional notes

Quantitative Tools examples:
How many children do you have? 
Which ones are applicable to you?

Qualitative Tools examples:
How would you rate this park?
When did the music festival happen?

Media: captures images, sounds and videos

Line and Area: highlights a route or area

* Make these questions mandatory to fill in. 

Note: Some tools present challenges in application due to internet 
access and device compatibility.
_______________________________________________________________________
Calculate tool example: 

“How many girls?” ► Settings ► Data column name ► “girls”

“How many boys?”► Settings ► Data column name ► “boys”

${girls} + ${boys} ► Settings ► Data column name ►”total_children”

“There are ${total_children} in this room.” 

14
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“Which colour is your favourite?” 
• Blue
• Red 
• Yellow 
• Other 

“If other, explain.”

To use your questionnaire

1. Menu > Draft > Your Project > Deploy
2. To share with others: Hover over project name 

> share icon (right hand side)

Carry-on question example

Settings of question > Skip Logic > Add a Condition > Select a Question 
> “Which colour is your favourite?” > “Other”
Now the text box question will only pop up if “other” is selected.

13

KoBo ToolboxKoBo Toolbox
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Point: tracks your current location* 

Acknowledge: gives consent to the interview* 

Text: add in between questions for additional notes 

Quantitative Tools examples: 
  How many children do you have?  
  Which ones are applicable to you? 

Qualitative Tools examples: 
  How would you rate this park? 
  When did the music festival happen? 

Media: captures images, sounds and videos 

Line and Area: highlights a route or area 
 

Glossary: question types & examples

Calculate tool example: 

“How many girls?” > Settings > Data column name > “girls”

“How many boys?” > Settings > Data column name > “boys”

${girls} + ${boys} > Settings > Data column name > ”total_
children”

“There are ${total_children} in this room.” 

* Make these questions mandatory to fill in.  

Note: Some tools present challenges in application due to internet access and 
device compatibility.
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KoBo Toolbox

After collection

Step 1 Complete

1. Edit data before uploading forms.
2. Android Users: 

 To Edit = Edit Saved Form 
 To Upload = Send Finalized 
Form >    Select All > Send Selected 
 
iOS Users: 
 To Edit = Save form as draft > 
Select    form in side menu > edit 
it 
 To Upload = Open side menu > 
Select   Forms > Upload (iPhone 
will automati  cally upload forms when 
connected to   internet if not saved as 
draft) 

3. Desktop PC > Kobo website > Deployed > 
Your Project 

4. Summary of data collected > Data > 
Reports

5. Downloads > Export Type > CSV (Legacy) > 
New Export > Pending >  Click to Refresh 
> click the file link to download

15

KoBo Toolbox

Android Users: “Android Application”
Download KoboCollect > Follow instructions on KoBo Toolbox  to open form   
(enter given unique URL) > To fill in form on your phone: Fill in blank form

iOS Users: “Online-Offline (multiple submission)”
Click Open > copy URL of form > Open https://www.the-qrcode-generator.com/ in a 
new tab > select URL > paste URL of form > Save > scan QR Code on phone to open 
form

1. Internet access needed to open form on phone
2. No internet access needed when using form in field 

 
Note: Save form as Draft if editing needs to be done after the interview. 

Data collection

There are two ways to collect data. Follow the relevant steps:
Collect Data > dropdown options
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Data Conversion

What?

Why?

A geographic information system (GIS) is a framework which provides a platform for 
users to engage with spatial data, through analysis and editing. There are alternative 
platforms that can perform this function, however we will use QGIS as it is a free 
service, making it more accessible to a wider range of people.   

For the purpose of this framework, QGIS will be used to convert the data  into a 
usable file type that can be imported and stored in the data warehouse GEONODE.

2Data Conversion

20

QGIS

4. File name > Click (...) to browse > Select your CSV (Legacy) File > Open

5. Drop down tab > File Format > select CSV (comma separated values)
6. Drop Down tab > Geometry definition > Select Geometry CRS = Project CRS: 

EPSG:4326-WGS 84 > Select X field = Longitude and Y field = Latitude > Add > 
Close window 
 
Note:  
Once editing the X and Y fields, if the points appear on a blue screen then delete 
your imported CSV (legacy) layer, re-import it and let X field= Latitude and Y field 
= Longitude. 
If you do not use a CSV legacy file, you will not have the option to select the x   
and y fields.

19

QGIS

Getting started

Importing CSV Legacy files

Download QGIS Standalone Installer Version 3.10 (64 bit)  > Install QGIS > Run QGIS

1. Open QGIS application on your computer > Project tab > New
2. Side Browser Menu > Drop down tab XYZ Tiles  > Right click on Openstreetmap 

> Add Layer to project 

3. Main menu > Layer tab > Add Layer > Add Delimited Text layer 
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QGIS

Exporting ESRI shape files

Notes

Tips

1. Layers Menu > Insure Openstreetmap layer is  below your Layer
2. Right click on your layer > Export > Save feature as
3. Create a new folder on your computer with your project name to export your 

shapefiles to
4. Drop down tab Format > Select ESRI Shapefile > File Name > Click (...) to browse 

> Write your file name > Drop down tab CRS  > Select Project CRS: EPSG:4326 - 
WGS 84 > Ok 
(There should be 6 shapefiles exported)

There is no need to save QGIS files as the only files that 
are required are the ESRI Shapefiles that you export.

To learn more check the Youtube tutorial:  
https://www.youtube.com/watch?v=sQ2z-D8TN2E

Step 2 Complete
24

Data Warehouse

What?

GeoNode is a web-based application and platform that facilitates the creation, 
sharing and collaborative use of geospatial and non-geospatial data.

The Geospatial data can be stored as Layers, formats that GeoNode supports:
Shapefiles & its associated files (.cpg, .dbf, .prj, .qpj, .shp, .shx)
GeoTiffs (.tiff, .tif)
American Standard Code for Information Interchange (ASCII)
The Non-geospatial data can be stored as Documents, formats that GeoNode 
supports:
Microsoft Word (.doc & .docx), Powerpoint (.ppt & .pptx), Excel (.xls & .xlsx)
Image Formats (.gif, .jpg, .jpeg, .png, .tiff, .tif)
OpenDocument File Formats (.ods, .odt,. odp)
Portable Document Format (.pdf)
Compressed Files (.rar, .zip, .gz)
Markup Languages (.sld, .xml, .qml)
Text documents (.txt)

Both of these could be linked with each other. Also documents that are non-
spatial in nature can still be uploaded to GeoNode and then linked to a spatial file 
afterwards.

You are able to take all other files that are not individually supported and create a 
.zip file in order to upload them.
(Cheat file : .zip file)

3Data Warehouse
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Uploading layers

Geonode

Getting started
Please refer to The Stitching the City geonode link and not the genode 
demo when the document refers to geonode.

Open Geonode (https://geocatalogue.co.za/) 
Register ► Wait for approval ► Sign In
Main Menu ► About ► People  ► Find other users and yourself
(Edit your profile to include your contact information)

Geonode (Stitching the City QR Code)
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GeoNode

Getting started

Please refer to The Stitching the City GeoNode link and not the GeoNode demo 
when the document refers to geonode.

1. Main Menu > Data > Upload Layer
2. Drag the shapefiles and its associated files in 

Drop files here. 
(Exported from previous tool, eg: QGIS/Kobo, 
make sure all six file types are there - .cpg, .dbf, 
.prj, qpj, shp, shx. and avoid duplicates.)

3. Permission > Select Users and Groups in all 
tabs > Upload Files 
(To control who you want to share the collected 
data with.)

4.  Inspect Data > Next  
(Recheck the list of data uploaded and edit if 
needed. Leave Advanced tabs on default.)

5. Layer uploaded. 
(Find the preview window, Infos, Attributes. 
You can Share, Rate, Comment or make it 
Favourite)

6. Editing tools > Styles > Edit > Edit if needed 

(Stitching the City QR Code)

Open GeoNode (https://geocatalogue.co.za/) 
Register > Wait for approval > Sign In
Main Menu > About > People > Find other users 
and yourself
(Edit your profile to include your contact 
information)
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Data Warehouse

Why?

To store and share the data we collectected with geolocation in an open source 
platform.
To manage and catalogue geospatial data and keep track of metadata. Each dataset 
in the system can be shared publicly or restricted to allow access to only specific 
users. 
To manage and share data if the project is occurring over several years such as a 
longitudinal study so that the data can be used for numerous years after the date of 
collection as long as it is labelled and managed correctly.

28

GeoNode

Creating map

1. (Single layer) Go to your Layer > Create a Map 
Or, (Multiple layers) Main menu  > Data  > Layers > Click (+) and select the Layers 
> Create a Map

2. Layers > Edit if needed
3. Options > Save as  > Edit Properties > Fill in > Save
4. Map added
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GeoNode

7. Editing tool > Metadata > Wizard
8. Edit > Fill in Basic Metadata > Fill in Location and Licences > Fill in Optional 

Metadata  > Fill in Dataset attributes 
(Make sure you go through all the mandatory boxes as everything you input here 
is important for documentation accuracy and for other users who will be looking 
for data.)

9. Preview > Check.
10. Settings > Edit if needed, or leave it default.
11. Update > Return to Layer

Uploading documents

1. Main menu  > Data  > Upload Document.
2. Create a Title > Browse the File > Add URL, if needed.
3. Permission > Select Users and Groups in all tabs  

(To control who you want to share the collected data with.)
4. Link to > Choose Layer/ Map > Upload.
5. Edit Metadata (Follow the same steps as Layer.)
6. Document uploaded. 

(Find the Infos. You can Share, Rate, Comment or make it Favourite)
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Geonode

Tips
● Select appropriate file names when renaming Layers, Maps and 

Documents to ensure that data is kept clean.
● Fill out the metadata as best as you can, be as descriptive as 

possible as that will help identify files later. If you are unsure of 
anything you can fix it later.

● Set permissions for each layer, this is important for data security. 
The default is set to 'Anyone', meaning that anyone who can log 
in can edit the data.

● Use all the tagging and legend options to make the data filter 
process convenient for users.

● For linking multiple files as Documents to one Layer or Map, 
upload them as a zip folder rather than uploading separate files.

● To learn more visit the ‘CDL wiki’ page. 
(https://github.com/CamGreen/NRF-S
TINT_Wiki/blob/master/README.md)

(CDL WIKI  QR Code)

Step 3 Completed
33

GeoNode

Tips

• Select appropriate file names when 
renaming Layers, Maps and Documents to 
ensure that data is kept clean.

• Fill out the metadata as best as you can, 
be as descriptive as possible as that will 
help identify files later. If you are unsure of 
anything you can fix it later.

• Set permissions for each layer, this is 
important for data security. The default is 
set to ‘Anyone’, meaning that anyone who 
can log in can edit the data.

• Use all the tagging and legend options to 
make the data filter process convenient for 
users.

• For linking multiple files as Documents to 
one Layer or Map, upload them as a zip 
folder rather than uploading separate files.

To learn more visit the ‘CDL wiki’ page. 
(https://github.com/CamGreen/NRF-STINT_
Wiki/blob/master/README.md)

Step 3 Complete
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GeoNode

Linking documents to layer/map

Downloading layer/ documents

1. Go to your Document > Edit Document > Metadata > Advanced Edit (You can 
use the Wizard)

1. (Layer) Go to your Layer > Download Layer > Select File type/ format.
2. Or, (Document) Go to your Document > Download Document.

2. Link to > Choose Layer/ Map > Update
3. Document Linked. 

(Check in your Layer page if the document is there)
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Preface

The ukuDoba handbook is the outcome of the 
Swedish-South African project “Stitching the City” 
that integrates education and research. The project 
aims at developing a method and digital library of 
geolocated data for knowledge facilitation to support 
data re-use in architectural courses. It also aims at 
establishing a collaboration between the University of 
Pretoria, South Africa, and the Chalmers University of 
Technology in Gothenburg, Sweden. 
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studio in Pretoria (2020). Many thanks Emilio and 
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ukuDoba has been tested in field studies by students 
in two areas: Mamelodi-East in the City of Tshwane 
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has been developed by the six master students in 
an iterative process. Thank you, Robin, Lauren, Purll, 
Mumtaheena, Kelsey and Markus for your invaluable 
work! Without you, no handbook.

A special thank you goes also to Cameron and 
Victoria for development of the GeoNode structure 
to store and share our data. Finally, thank you Marco, 
Monica, Serena for your support and constructive 
input. 

Liane & Chrisna
October 2020
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ukuDoba

Over time, physical maps and folders are 
being stacked in bookshelves. This format 
of data collection is difficult to access 
and build upon. Year, after year, these 
research processes are repeated, by both 
universities,  leaving layers of rich data 
disjointed.

ukuDoba - the methodological framework, 
has been developed for the collection and 
sharing of non-traditional types of spatial 
economic data at a street and precinct 
level in an online platform. These cross-
disciplinary micro-data can be layered and 
easily accessed by researchers from different 
disciplines as well as students and community 
members.
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The ukuDoba  

Methodology

Data
Collection

Maptionnaire

Data
Conversion

QGIS

Data
Warehouse

Geonode

ukuDoba

The methodological framework, ukuDoba, 
and online platform, Geonode, are 
currently being tested in two study areas: 
Mamelodi East in Tshwane, South Africa 
and Hammarkullen in Gothenburg, 
Sweden.

Here, we present a step by step guide 
to follow the ukuDoba methodology of 
how to effectively digitally collect, convert 
and store data in an online platform, 
GeoNode. 

In Zulu the word ukuDoba means ‘fishing’. 
With this booklet, we hope to help users 
‘fish’ for the data they need for their 
project.
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Data Collection

• Maptionnaire is a paid subscription based service that allows you to create 
questionnaires that can be sent out to participants or be filled in out on the field 
by yourselves. It is georeferenced and supports multiple types of media.

• After fieldwork, you can access the data via your computer. This data can then be 
shared with others and they can use it or edit it.

• Other tools used for similar data collection are: Kobo Toolbox, FieldPapers, 
EpiCollect5 etc.

• Let communities to share their knowledge
• To digitally store data in a Digital platform (easier to access and use)
• To geolocate collected data

What?

Why?

1Data Collection

12

Maptionnaire

• Use your computer to start. You can only use 
your smartphone or tablet for collecting data

• Visit the link below to log in 
https://app.maptionnaire.com/en/login/

1.  Questionnaire > Create new 
2.  Edit > Fill in Name and Description  

(This is the first page people would see, so introduction, background and 
purpose should be included in the description)

3.  Pages > (+) > Create at least 3 pages
4. Write Page names for all pages 

(Suggested as ‘Consent’, ‘Name of Survey’, ‘Thanks for Participating’)
5. First page > (+) > Multiple choice question > Question > Choose one > Type 

in your consensual agreement in the question box and create two options “Yes” 
and “No”

6. Next page > (+) > Select the types of questions (see glossary for types of 
questions) > Click the Question to edit

7. Last page > (+) > Paragraph of Text > Type in a note of thanks with the contact 
info of your team for further inquiries > Page settings > Check “This is an 
exit page (Additional questions could be added such as, asking for reasons if 
answered no to the consent)

Getting started

Creating a questionnaire

11

Data Collection

• Always collect data in groups of three 
people. 

• The first person is in charge of taking 
notes and should focus on gathering 
data using the data collections tool.

• The second person is in charge of 
leading the interview and can have the 
questions open on their phone as a 
guide. 

• The third person is in charge of 
documentation of the process and 
takes pictures, video and audio 
recordings.

• It is important to have a dialogue 
between the interviewer and 
interviewee. 

• This could be ensured by sending the 
questionnaire link online for people to 
fill up and discussing / having dialogue 
over the phone or internet with audio 
calls. 

• Filling up the questionnaire together 
and discussing / having dialogue with 
video calls, sharing screens options 
can help.

• If multiple participants need to fill out 
the same form in the same browser, 
they have to use incognito mode

How?

On-site collection

Remote collection
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Maptionnaire

Setting up background maps for forms

1.  Location at the beginning > zoom in to set the viewport > save
2. Under Maps you tick the boxes you want your participants to be able to toggle 

between
• If you wish to set a different map for only one of your pages:  

Click the page > Click settings > follow the steps above

I hereby voluntarily grant permission for participation in this project, as explained to me 
by the researcher. I am aware that the results of the investigation may be used for the 
purposes of publication. I will remain anonymous: my comments may be used without 
giving any geographic or personal references (name, address, ID, occupation, age, income 
etc) that may accidentally imply my identity.

KoBo Toolbox

Glossary: Question Types & Examples

Point: tracks your current location*

Acknowledge: gives consent to the interview*

Text: add in between questions for additional notes

Quantitative Tools examples:
How many children do you have? 
Which ones are applicable to you?

Qualitative Tools examples:
How would you rate this park?
When did the music festival happen?

Media: captures images, sounds and videos

Line and Area: highlights a route or area

* Make these questions mandatory to fill in. 

Note: Some tools present challenges in application due to internet 
access and device compatibility.
_______________________________________________________________________
Calculate tool example: 

“How many girls?” ► Settings ► Data column name ► “girls”

“How many boys?”► Settings ► Data column name ► “boys”

${girls} + ${boys} ► Settings ► Data column name ►”total_children”

“There are ${total_children} in this room.” 
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Drawbutton: mark out points, highlight a route or area, upload a  
 media file 

Multiple choice: choose one, choose many, dropdown, priority  
  assessment

Open question: big answer field, small answer field 

Number questions: integer numbers, string of digits, decimal   
     numbers, range of numbers 

Video & document: link a video from youtube or upload your own  
    to show inbetween questions

Paragraph or text: add in between questions for additional   
   information to participants 

Glossary: question types & examples
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Maptionnaire

Carry-on 
Creating a questionnaire

8.  Branching rules at the top > Triggering question > Select your 
triggering question > Triggering answers > Choose Yes > Choose 
target page > Choose “Name of survey” > Save > Go back to Edit  
(Using branching rules are not recommended to use with individual 
questions, only pages)

9.  Location at the beginning under the pages> Set your site area 
(This is the default background of your questionnaire pages, could be 
changed for each page in the settings tab)

10.  Maps > Select the type of map
11.  General Settings > Edit as per your preferences > Find the link for  the 

questionnaire > Set a Questionnaire Password if you want limited 
access > Go back to Edit

12.  Data and Privacy settings > Edit as per your preferences
13.  Style settings > Edit the style of your questionnaire
14.  Language settings > Select the additional language, if needed> Click 

Translate to add all the questions in selected language > Save 
15.  View > Check the questionnaire

Note:
Make sure to keep your form clean of 
unnecessary datapoints before deploying 
the questionnaire. This will ensure effective 
collection of data, save you time during 
analysis, and keep the participants engaged.

15

Maptionnaire

To use your questionnaire

Simply distribute the link to the web-based 
questionnaire to allow participants to fill it in 
and start collecting your data!

Branching questions

Using skip logic in your survey is a great way of controlling the navigation in the 
form depending on what the answers are.

The most important thing to consider is that the target answer is a page and that 
it is only compatible with multiple choice questions. Be careful with using the 
branching as it can lead to undesireable outcomes in the collected data.

After collection

1. Find your questionnaire > Response Data  
> Analyze > Check and edit if needed

2. Find your questionnaire > Response Data 
> Download > Download ESRI Shape file

Step 1 Complete
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Data Conversion

What?

Why?

A geographic information system (GIS) is a framework which provides a platform for 
users to engage with spatial data, through analysis and editing. There are alternative 
platforms that can perform this function, however we will use QGIS as it is a free 
service, making it more accessible to a wider range of people.   

For the purpose of this framework, QGIS will be used to convert the data  into a 
usable file type that can be imported and stored in the data warehouse GEONODE.

2Data Conversion
If your chosen data collection tool does 
not provide a shapefile or if you for some 
other reason have a csv file that needs to be 
geolocated, follow this portion of the handbook. 
Maptionnaire provides shapefiles in the file-
format .shp

20

QGIS

4. File name > Click (...) to browse > Select your CSV (Legacy) File > Open

5. Drop down tab > File Format > select CSV (comma separated values)
6. Drop Down tab > Geometry definition > Select Geometry CRS = Project CRS: 

EPSG:4326-WGS 84 > Select X field = Longitude and Y field = Latitude > Add > 
Close window 
 
Note:  
Once editing the X and Y fields, if the points appear on a blue screen then delete 
your imported CSV (legacy) layer, re-import it and let X field= Latitude and Y field 
= Longitude. 
If you do not use a CSV legacy file, you will not have the option to select the x   
and y fields.

19

QGIS

Getting started

Importing CSV Legacy files

Download QGIS Standalone Installer Version 3.10 (64 bit)  > Install QGIS > Run QGIS

1. Open QGIS application on your computer > Project tab > New
2. Side Browser Menu > Drop down tab XYZ Tiles  > Right click on Openstreetmap 

> Add Layer to project 

3. Main menu > Layer tab > Add Layer > Add Delimited Text layer 
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QGIS

Exporting ESRI shape files

Notes

Tips

1. Layers Menu > Insure Openstreetmap layer is  below your Layer
2. Right click on your layer > Export > Save feature as
3. Create a new folder on your computer with your project name to export your 

shapefiles to
4. Drop down tab Format > Select ESRI Shapefile > File Name > Click (...) to browse 

> Write your file name > Drop down tab CRS  > Select Project CRS: EPSG:4326 - 
WGS 84 > Ok 
(There should be 6 shapefiles exported)

There is no need to save QGIS files as the only files that 
are required are the ESRI Shapefiles that you export.

To learn more check the Youtube tutorial:  
https://www.youtube.com/watch?v=sQ2z-D8TN2E

Step 2 Complete
24

Data Warehouse

What?

GeoNode is a web-based application and platform that facilitates the creation, 
sharing and collaborative use of geospatial and non-geospatial data.

The Geospatial data can be stored as Layers, formats that GeoNode supports:
Shapefiles & its associated files (.cpg, .dbf, .prj, .qpj, .shp, .shx)
GeoTiffs (.tiff, .tif)
American Standard Code for Information Interchange (ASCII)
The Non-geospatial data can be stored as Documents, formats that GeoNode 
supports:
Microsoft Word (.doc & .docx), Powerpoint (.ppt & .pptx), Excel (.xls & .xlsx)
Image Formats (.gif, .jpg, .jpeg, .png, .tiff, .tif)
OpenDocument File Formats (.ods, .odt,. odp)
Portable Document Format (.pdf)
Compressed Files (.rar, .zip, .gz)
Markup Languages (.sld, .xml, .qml)
Text documents (.txt)

Both of these could be linked with each other. Also documents that are non-
spatial in nature can still be uploaded to GeoNode and then linked to a spatial file 
afterwards.

You are able to take all other files that are not individually supported and create a 
.zip file in order to upload them.
(Cheat file : .zip file)

3Data Warehouse
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Uploading layers

Geonode

Getting started
Please refer to The Stitching the City geonode link and not the genode 
demo when the document refers to geonode.

Open Geonode (https://geocatalogue.co.za/) 
Register ► Wait for approval ► Sign In
Main Menu ► About ► People  ► Find other users and yourself
(Edit your profile to include your contact information)

Geonode (Stitching the City QR Code)

26

GeoNode

Getting started

Please refer to The Stitching the City GeoNode link and not the GeoNode demo 
when the document refers to geonode.

1. Main Menu > Data > Upload Layer
2. Drag the shapefiles and its associated files in 

Drop files here. 
(Exported from previous tool, eg: QGIS/Kobo/
Maptionnaire, .cpg, .dbf, .prj, qpj, shp, shx. and 
avoid duplicates.)

3. Permission > Select Users and Groups in all 
tabs > Upload Files 
(To control who you want to share the collected 
data with.)

4.  Inspect Data > Next  
(Recheck the list of data uploaded and edit if 
needed. Leave Advanced tabs on default.)

5. Layer uploaded. 
(Find the preview window, Infos, Attributes. 
You can Share, Rate, Comment or make it 
Favourite)

6. Editing tools > Styles > Edit > Edit if needed 

(Stitching the City QR Code)

Open GeoNode (https://geocatalogue.co.za/) 
Register > Wait for approval > Sign In
Main Menu > About > People > Find other users 
and yourself
(Edit your profile to include your contact 
information)

25

Data Warehouse

Why?

To store and share the data we collectected with geolocation in an open source 
platform.
To manage and catalogue geospatial data and keep track of metadata. Each dataset 
in the system can be shared publicly or restricted to allow access to only specific 
users. 
To manage and share data if the project is occurring over several years such as a 
longitudinal study so that the data can be used for numerous years after the date of 
collection as long as it is labelled and managed correctly.

28

GeoNode

Creating map

1. (Single layer) Go to your Layer > Create a Map 
Or, (Multiple layers) Main menu  > Data  > Layers > Click (+) and select the Layers 
> Create a Map

2. Layers > Edit if needed
3. Options > Save as  > Edit Properties > Fill in > Save
4. Map added

27

GeoNode

7. Editing tool > Metadata > Wizard
8. Edit > Fill in Basic Metadata > Fill in Location and Licences > Fill in Optional 

Metadata  > Fill in Dataset attributes 
(Make sure you go through all the mandatory boxes as everything you input here 
is important for documentation accuracy and for other users who will be looking 
for data.)

9. Preview > Check.
10. Settings > Edit if needed, or leave it default.
11. Update > Return to Layer

Uploading documents

1. Main menu  > Data  > Upload Document.
2. Create a Title > Browse the File > Add URL, if needed.
3. Permission > Select Users and Groups in all tabs  

(To control who you want to share the collected data with.)
4. Link to > Choose Layer/ Map > Upload.
5. Edit Metadata (Follow the same steps as Layer.)
6. Document uploaded. 

(Find the Infos. You can Share, Rate, Comment or make it Favourite)
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Geonode

Tips
● Select appropriate file names when renaming Layers, Maps and 

Documents to ensure that data is kept clean.
● Fill out the metadata as best as you can, be as descriptive as 

possible as that will help identify files later. If you are unsure of 
anything you can fix it later.

● Set permissions for each layer, this is important for data security. 
The default is set to 'Anyone', meaning that anyone who can log 
in can edit the data.

● Use all the tagging and legend options to make the data filter 
process convenient for users.

● For linking multiple files as Documents to one Layer or Map, 
upload them as a zip folder rather than uploading separate files.

● To learn more visit the ‘CDL wiki’ page. 
(https://github.com/CamGreen/NRF-S
TINT_Wiki/blob/master/README.md)

(CDL WIKI  QR Code)

Step 3 Completed
33

GeoNode

Tips

• Select appropriate file names when 
renaming Layers, Maps and Documents to 
ensure that data is kept clean.

• Fill out the metadata as best as you can, 
be as descriptive as possible as that will 
help identify files later. If you are unsure of 
anything you can fix it later.

• Set permissions for each layer, this is 
important for data security. The default is 
set to ‘Anyone’, meaning that anyone who 
can log in can edit the data.

• Use all the tagging and legend options to 
make the data filter process convenient for 
users.

• For linking multiple files as Documents to 
one Layer or Map, upload them as a zip 
folder rather than uploading separate files.

To learn more visit the ‘CDL wiki’ page. 
(https://github.com/CamGreen/NRF-STINT_
Wiki/blob/master/README.md)

Step 3 Complete
29

GeoNode

Linking documents to layer/map

Downloading layer/ documents

1. Go to your Document > Edit Document > Metadata > Advanced Edit (You can 
use the Wizard)

1. (Layer) Go to your Layer > Download Layer > Select File type/ format.
2. Or, (Document) Go to your Document > Download Document.

2. Link to > Choose Layer/ Map > Update
3. Document Linked. 

(Check in your Layer page if the document is there)
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10/03/2020 

EBIT FACULTY COMMITTEE FOR RESEARCH ETHICS AND INTEGRITY 
Dear Prof Chan, 
 
ETHICS RENEWAL 2020 

In terms of document reference number: EBIT/9/2018 

HONOURS STUDENTS, DEPARTMENT OF ARCHITECTURE: “STITCHING THE CITY: FROM 
MICRO-DATA TO MACRO-VIEWS” 

In terms of the conditions of approval granted for research to be undertaken as part of the RFS and RFP modules 
in the Honours programme, I would like to notify the committee that the research will be ongoing for the 2020 
academic year. I understand that all the conditions and responsibilities as stipulated in the approval will remain 
applicable to the project. 

Kindly note that the method of investigation will apply to two distinct geographic areas, namely Mamelodi 
(specifically centred around the Tsako Thabo Secondary School) and Moreleta East (specifically centred around 
the informal settlements of Plastic View and Cemetery View). Students will be engaging with ad-hoc members 
of the affected community as informants rather than subjects. 

I would like to declare that the following MArch(Prof) students will be involved with the project as a 
continuation of their Honours work undertaken during 2019 and will make use of the data for their 
mini-dissertations: 

 

Yours sincerely, 

 
Dr C Combrinck 
Senior Lecturer: Department of Architecture  
University of Pretoria 
Tel         +27 (0)12 420 6536 
Email      carin.combrinck@up.ac.za 

Student number Surname Name 

15042482 du Bois Morné 
15203329 Khoswe Vitukumbe 
15001700 Konstantinou Lauren 
12148131 Matena Dipuo 
15032371 Mulder Idelette 
15362282 Naidoo Purll 
15209106 Simeon Aimee 
13070330 Smith Kelsey 

APPENDIX C: ETHICS APPROVAL

Reference number: EBIT/119/2020

Miss LM Konstantinou
Department: Architecture
University of Pretoria
Pretoria
0083

Dear Miss LM Konstantinou

FACULTY COMMITTEE FOR RESEARCH ETHICS AND INTEGRITY 

Your recent application to the EBIT Research Ethics Committee refers.

Approval is granted for the application with reference number that appears above. 

1. This means that the research project entitled "THE MUSIC-MAKER: AN ARCHITECTURAL 
NETWORK FOR EXPLORATION OF SELF AND EXPRESSION" has been approved as submitted. It 
is important to note what approval implies. This is expanded on in the points that follow.

2. This approval does not imply that the researcher, student or lecturer is relieved of any accountability in terms of 
the Code of Ethics for Scholarly Activities of the University of Pretoria, or the Policy and Procedures for 
Responsible Research of the University of Pretoria. These documents are available on the website of the EBIT 
Research Ethics Committee. 

3. If action is taken beyond the approved application, approval is withdrawn automatically.

4. According to the regulations, any relevant problem arising from the study or research methodology as well as 
any amendments or changes, must be brought to the attention of the EBIT Research Ethics Office.

5. The Committee must be notified on completion of the project.

The Committee wishes you every success with the research project.

Prof K.-Y. Chan
Chair: Faculty Committee for Research Ethics and Integrity
FACULTY OF ENGINEERING, BUILT ENVIRONMENT AND INFORMATION TECHNOLOGY
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APPENDIX D: DESIGN SUMMARY APPENDIX E: TECH SUMMARY
The Music-Maker 
an architectural Network for
exploration of self & expression

Lauren Konstantinou
           15001700

Primary Programme: Performance Centre
site: Tsako Thabo High School, Mamelodi East

research Field: Unit for Urban Citizenship
study Leader: Dr Carin Combrinck research QuesTiON

How can the decentralization of 
music-making provide a platform 

for positive self-expression for school 
learners, enhancing the collective 

community identity in Mamelodi East?

TechNicaL suMMarY

It is imperative for the building to be dynamic and have 
energy: an explosion of expression. The overall tectonic 
concept provides exciting spaces and platforms for users 
to perform and interact with both the building and other 
users. Acoustics plays a vital role in this aspect. 

05_TechNicaL cONcePT

Primary structure: RHS beams and trusses of the roof fixed 
to a grid, spanning across the proposed hall.
secondary structure: structural rammed earth elements 
that ground the overall design with weight and impact. 
As well as linear & diagonal masonry elements that guide 
users through the spaces in terms of physical and visual 
access.
Tertiary structure: much lighter expressive elements 
filling in the voids between the primary and secondary 
structure; holding spaces, providing platforms for 
performance and influencing the acoustical intentions. 

06_sTrucTure

Acoustics is the main influencer of the form, materiality 
and structure of the project. Not only within the main 
hall where it is vital for music and sport performances, 
but as audible barriers between open and intimate 
programmes. This is achieved through the integration of 
water systems. The large roof of the centre provides the 
opportunity for catchment, maintaining the fields and 
landscaping of the design. Natural daylighting, ground 
cooling, ventilation and reusing materials as much as 
possible all play vital roles.

07_sYsTeMs

“How is it that music can, without words, evoke our 
laughter, our fears [and] our highest aspirations?” (Jane 
Swan)
Within Mamelodi East there are existing music 
establishments that are small and aren’t fully equipped 
to succeed. The proposed Music Network connects these 
establishments and allows for integration with surrounding 
schools that have some association with music. These 
connections allow for the sharing of skills, facilities and 
interests, ultimately forming a greater whole together 
(Castells 2011). Learners from Tsako Thabo School, with a 
“cup of that vision” (Memory 2020) for their future need a 
space for their own expression, identity and discovery as 
they move through their high school journey. This project 
is not a simple music school, but an inclusive celebration 
of expression and performance (music, academics, 
sport, nutrition, daily life...).

01_BackGrOuND

The typical school typology implemented here does 
not allow for freedom of learning and inclusion of many 
different types of learners. It results in rigid education and 
the exclusion of learners that do not fit into the prescribed 
box. 

02_GeNeraL issue

There is a large disconnection between Tsako Thabo 
Secondary School, the music institutions and the 
surrounding community due to lack of integration and 
interaction.

03_urBaN issue

The school’s architecture hinders opportunities for 
positive self expression and development of identity; 
individually and collectively. The school is rigid and 
closed in, excluding any interaction with the surrounding 
community. 

04_archiTecTuraL issue

The Music-Maker 
an architectural Network for
exploration of self & expression

Lauren Konstantinou
           15001700

Primary Programme: Performance Centre
site: Tsako Thabo High School, Mamelodi East

research Field: Unit for Urban Citizenship
study Leader: Dr Carin Combrinck research QuesTiON

How can the decentralization of 
music-making provide a platform 

for positive self-expression for school 
learners, enhancing the collective 

community identity in Mamelodi East?

DesiGN suMMarY

The proposed intervention allows for freedom of 
expression and celebration of academics, music, sport, 
nutrition and everyday activities of a learner’s life. The 
architecture celebrates both the school learners and 
the community, providing a space to belong and 
to celebrate. This project adds to the existing school 
infrastructure and serves as a precedent for future school 
upgrades in Mamelodi. 

05_arGuMeNT

This intervention acts as the flagship for the proposed 
Mamelodi Music Network, feeding into the global project 
of UNESCO’s Creative Cities. This will put Mamelodi 
on the map and bring inspiration and pride to the 
community. The Performance Centre stands out from the 
surrounding community respectfully and inspires its users. 
The architecture is made up of expressive symbolism: 
platforms and acoustics driving the overall language, 
challenging the rigid grid and creating a new identity for 
both the school and the community. 

Each activity of the school is given an opportunity to be 
celebrated without excluding other activities. The project 
links the school with the community through economic 
opportunities, additional learning and celebrating of 
Mamelodi’s rich jazz history.

06_archiTecTuraL cONcePT

“How is it that music can, without words, evoke our 
laughter, our fears [and] our highest aspirations?” (Jane 
Swan)
Within Mamelodi East there are existing music 
establishments that are small and aren’t fully equipped 
to succeed. The proposed Music Network connects these 
establishments and allows for integration with surrounding 
schools that have some association with music. These 
connections allow for the sharing of skills, facilities and 
interests, ultimately forming a greater whole together 
(Castells 2011). Learners from Tsako Thabo School, with a 
“cup of that vision” (Memory 2020) for their future need a 
space for their own expression, identity and discovery as 
they move through their high school journey. This project 
is not a simple music school, but an inclusive celebration 
of expression and performance (music, academics, 
sport, nutrition, daily life...).

01_BackGrOuND

The typical school typology implemented here does 
not allow for freedom of learning and inclusion of many 
different types of learners. It results in rigid education and 
the exclusion of learners that do not fit into the prescribed 
box. 

02_GeNeraL issue

There is a large disconnection between Tsako Thabo 
Secondary School, the music institutions and the 
surrounding community due to lack of integration and 
interaction.

03_urBaN issue

The school’s architecture hinders opportunities for 
positive self expression and development of identity; 
individually and collectively. The school is rigid and 
closed in, excluding any interaction with the surrounding 
community. 

04_archiTecTuraL issue

POUR ME A CUP OF THAT VISION...
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Masters 2020

“It is what it is…”
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